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customer-facing collateral. Our effort also includes internal initiatives to
remove biased language from our engineering and working environment,
including terms that are embedded in our software and IPs. At the same time,
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SYNOPSYS

Silicon to Software

CHAPTER 1

Overview of the Synthesis Commands

This document is part of a set that includes reference and procedural
information for the Synopsys® FPGA tools. This document describes the
commands available for the synthesis tools, which usually includes a
graphical user interface (GUI) as well as command line access. Commands
may vary with the capabilities of the synthesis tool.

The following sections provide an overview of the commands in the tool:
e About Tcl Commands, on page 14

e About the GUI Commands, on page 16

Synplify Pro for Microchip Edition Command Reference © 2021 Synopsys, Inc.
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Overview of the Synthesis Commands About Tcl Commands

About Tcl Commands

Tcl (Tool Command Language) is a popular scripting language for controlling
software applications. Synopsys has extended the Tcl command set with
additional commands that you can use to run the Synopsys FPGA programs.
These commands are not intended for use in controlling interactive debug-
ging, but you can use them to run synthesis multiple times with alternate
options to try different technologies, timing goals, or constraints on a design.

Tcl scripts are text files that have a .tcl file extension and contain a set of Tcl
commands designed to complete a task or set of tasks. You can also run Tcl
scripts through the Tcl window (see Tcl Script Window, on page 41).

The Synopsys FPGA Tcl commands are described here. For information on
the standard Tcl commands, syntax, language, and conventions, refer to the
Tcl online help (Help->TCL).

Tcl Conventions

Here is a list of conventions to respect when entering Tcl commands and/or
creating Tcl scripts.

e Tcl is case sensitive.
e Comments begin with a hash mark or pound sign (#).
« Enclose all path names and filenames in double quotes ().

« Use a forward slash (/) as the separator between directory and path
names (even on the Microsoft® Windows® operating system). For
example:

desi gns/ bi g _design/test.v

Tcl Commands

You can enter the Tcl (Tool Command Language) commands directly in the
Tcl window, or include them in Tcl scripts that you can run in batch mode.
For more information about Tcl commands, see Tcl Synthesis Commands, on
page 21.

© 2021 Synopsys, Inc. Synplify Pro for Microchip Edition Command Reference
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About Tcl Commands Overview of the Synthesis Commands

Tcl Scripts and Batch Mode

For procedures for creating Tcl scripts and using batch mode, see Working
with Tcl Scripts and Commands, on page 512 in the User Guide:

« Running Batch Mode on a Project File, on page 506

e Running Batch Mode with a Tcl Script, on page 507

e Generating a Job Script, on page 513

e Creating a Tcl Synthesis Script, on page 515

e Using Tcl Variables to Try Different Clock Frequencies, on page 516
* Running Bottom-up Synthesis with a Script, on page 519

Synplify Pro for Microchip Edition Command Reference © 2021 Synopsys, Inc.
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Overview of the Synthesis Commands About the GUI Commands

About the GUI Commands

The GUI commands are accessed from the software graphical interface. Most
commands open dialog boxes where you can specify parameters for the
command.

The GUI provides a few ways to access commands:
e Menus, on page 16
« Context-sensitive Popup Menus, on page 17
e Toolbars, on page 17
 Keyboard Shortcuts, on page 17
e Buttons and Options, on page 17

e Tcl Commands, on page 14

Most commands have GUI and command line versions, so you can use either
method to specify commands.

Menus

The set of commands on the pull-down menus in the menu bar varies
depending on the view, design status, task to perform, and selected object(s).
For example, the File menu commands in the Project view differ slightly from
those in the RTL view. Menu commands that are not available for the current
context are dimmed out. The menu bar in the Project view is shown below:

File Edit Yiew Project Import Run Apalysis HDL-Analyst Options Window Tech-Support Web Help
The individual menus, their commands, and the associated dialog boxes are
described in the following sections:

e File Menu, on page 312

e Edit Menu, on page 317

« View Menu, on page 331

e Project Menu, on page 339

e Run Menu, on page 388

© 2021 Synopsys, Inc. Synplify Pro for Microchip Edition Command Reference
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About the GUI Commands Overview of the Synthesis Commands

e Analysis Menu, on page 407

e HDL Analyst Menu, on page 419
e Options Menu, on page 431

e Web Menu, on page 461

e Help Menu, on page 462

Context-sensitive Popup Menus

Popup menus, available by right-clicking, offer access to commonly used
commands that are specific to the current context. See Popup Menus, on
page 466, Project View Popup Menus, on page 472, and RTL and Technology
Views Popup Menus, on page 489 for information on individual popup
menus.

Toolbars

Toolbars contain icons associated with commonly used commands. For more
information about toolbars, see Toolbars, on page 57.

Keyboard Shortcuts

Keyboard shortcuts are available for commonly used commands. The
shortcut appears next to the command in the menu. See Keyboard Shortcuts,
on page 64 for details.

Buttons and Options

The Project view has buttons for quick access to commonly used commands
and options. See Buttons and Options, on page 72 for details.

Synplify Pro for Microchip Edition Command Reference © 2021 Synopsys, Inc.
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About the GUI Commands
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CHAPTER 2

SYNOPSYS

Silicon to Software

Tcl Synthesis Commands

This chapter describes supported Tcl commands. The synthesis commands

are listed in alphabetical order.

add_file

analyst
check_fdc_query
constraint_file
design

encryptlP
get_env
get_option
hdl_define
history

job

log_report
open_design
partdata
program_version

project_data

Synplify Pro for Microchip Edition Command Reference
June 2021

add_folder
cdpl_queue
command_history
create_fdc_template
dump_metrics
encryptP1735
get_env

help

hdl_param

impl

log_filter
message_override
open_file
program_terminate
project

project_file

© 2021 Synopsys, Inc.
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Tcl Synthesis Commands

project_folder query_available_metrics
query_metric query_metric_details
recording report_clocks
report_messages report_message_summary
run_tcl sdc2fdc

select set_option

status_report synplify_pro

See also:

* For specific categories of synthesis commands (for example, log file
commands), see Tcl Command Categories, on page 146.

* For a description of the find, expand, and collection commands, see Tcl
Find, Expand, and Collection Commands, on page 147.

* For the TCL timing and design constraints syntax and their descriptions
in SCOPE, see Constraint Commands, on page 217.

© 2021 Synopsys, Inc. Synplify Pro for Microchip Edition Command Reference
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Tcl Synthesis Commands

add_file

The add_file command adds one or more files to a project.

Syntax

add_file [-filetype] fileName [ fileName [ ...] ]

add_file -verilog [-lib fileName [ fileName [ ...] ]] [-folder folderName]

add_file -vhdl [-lib libName[ libName] ] fileName [ fileName [ ...] ] [-folder folderName]
add_file -include fileName [ fileName [ ...] ]

add_file [-filetype] -job_owner par | simulation [ fileName [ ...] ]

add_file -structver [fileName [ ...]]

add_file -tooltag tooltagName -toolargs [toolArguments] fileName

add_file -vlog_std standard fileName [ fileName [ ...] ]

-filetype Specifies the type of file being added to the project (files are

placed in folders according to their file types; including
this argument overrides automatic filename-extension
placement). See Filename Extensions , on page 25 for a list
of the recognized file types.

fileName Specifies the name of the file being added to the project.

Files are added to the individual project folders according
to their filename extensions (View Project Files in Folders must
be set in the Project View Options dialog box). You can add
multiple files by separating individual filenames with a
space, and you can specify different file types (extensions)
within the same command.

-verilog or -vhd| Adds HDL files with non-standard extensions to the Verilog

or VHDL directory, so that they can be compiled with the
project. For example, the following command adds the file
alu.v.new to the project's verilog directory:

%add _file -verilog /designs/negachi p/al u.v. new
If you do not specify -verilog, the file is added to the Other
directory (new is not a recognized Verilog extension), and
the file would not be compiled with the files in the Verilog
directory.

Synplify Pro for Microchip Edition Command Reference © 2021 Synopsys, Inc.
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Tcl Synthesis Commands

[-lib libName]

[-folder folderName]

-include

-job_owner

-structver fileName

© 2021 Synopsys, Inc.
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Specifies the library associated with Verilog or VHDL files.
The default library is work. The -lib option sets the VHDL
library to libName.

Note: You can also specify multiple libraries for Verilog or
VHDL files.

Verilog Example:

add file -verilog -lib top -vlog_std sysv "top.v"
VHDL Example:

add_file -vhdl -lib {nylib,work} "ff.vhd"

Both the logical and physical libraries must be specified in
the Project file (if you only specify the logical library
associated with the Verilog or VHDL files, the compiler
treats the module as a black box).

Creates logical folders with custom files in various
hierarchy groupings within your Project view. For example:

add file -verilog -folder menory "ram1.v"

add file -verilog -fol der nenory
"C. /exanpl es/veril og/ common_rtl/menory/ram1. v"

Indicates that the specified file is to be added to the project
as an include file (include files are added to the Include
directory regardless of their extension). Include files are
not passed to the compiler, but are assumed to be
referenced from within the HDL source code. Adding an
include file to a project, although not required, allows it to
be accessed in the user interface where it can be viewed,
edited, or cross-probed.

Allows you to determine how files are used; you can
specify these options from the File Options dialog box. For
example, you can automatically decide to pass files to the
back-end place-and-route tool (Use for Place and Route) or
use them for test benches containing HDL constructs for
simulation (Use for Simulation only).

Adds structural Verilog files as input for your design
project. The software performs fast compilation of the
structural Verilog files, providing runtime improvements
for the design. For example:

add file -structver fileName.vm

For more information, see Using the Structural Verilog
Flow , on page 53.

Synplify Pro for Microchip Edition Command Reference
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Tcl Synthesis Commands

-tooltag tooltagName Creates a tool tag name for the application tool you want
to invoke from within the Synopsys FPGA synthesis tool.

-toolargs tool Specifies any argument options to use with the application
tool you want to invoke from within the Synopsys FPGA
synthesis tools. For example:

add file -tooltag {EDK} -tool args {$SynCode}
"ramv"

-vlog_std standard Overrides the global Verilog standard for an individual file.
The accepted values for standard are v95 (Verilog 95),
v2001 (Verilog 2001), and sysv (SystemVerilog). The file
(fileName) is added to the Verilog folder in the project; the
specified standard is listed after the filename in the project
view and is enclosed in angle brackets (for example,
commchip.v <sysv>). Note that when you add a
SystemVerilog file (a file with an sv extension) to a project,
the add_file entry in the project file includes the -vlog_std
standard string.

The default standard for new projects is SystemVerilog.
For Verilog 2005 extensions, use sysv (SystemVerilog).

Filename Extensions

Files with the following extensions are automatically added to their corre-
sponding project directories; files with any other extension are added to the
Other directory. The -filetype argument overrides automatic filename extension

placement.
Extension -Filetype Project Folder
. adc -analysis_constraint Analysis Design Constraint
. edf, . edn -edif EDIF
. fdc -fpga_constraint/-constraint Logic Constraints (FDC)
. sdc -constraint Logic Constraints (SDC)
.svl -verilog Verilog
. tel -tcl Tel Script
.V -verilog Verilog
Synplify Pro for Microchip Edition Command Reference © 2021 Synopsys, Inc.
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Tcl Synthesis Commands

Extension -Filetype Project Folder
.vhd, . vhdl -vhdl VHDL

.vm -structver Structural Verilog File
any -include Include

1. Use the sv format for SystemVerilog keyword support. Both Verilog and SystemVerilog formats
are added to the Verilog folder.

Example: Add Files

Add a series of VHDL files to the VHDL directory and add an include file to the
project:

% add_fil e /designs/sequencer/top.vhd

% add_fil e /designs/sequencer/al u. vhdl

% add _file -vhdl /designs/sequencer/reg.vhd.fast
% add_file -include /designs/std/ decode. vhd

The corresponding directory structure in the Project view is shown in the
following figure:

El- |ﬂ 2 ftonls/temp)sequencer  pri
EJ E/' YHOL
----- [ top.whd [waork]
o [ alovhdl [work]
“ [ reg.vhd fast
El E/' Include
----- [ decode.vhd

.#revl

Example: File Options Designation

Designate some IP core wrappers as well as their associated instantiated
component files that must be passed on to the place-and-route tool, since
they are not written to the final netlist:

add _file -verilog -job_owner par "ny_ip_core.v"
add_file -verilog -job_owner par "ny_ip_core_enc.v"
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add_folder

The add_folder command adds a custom folder to a project.

Syntax
add_folder folderName

Creates logical folders with files in various custom hierarchy groupings
within your Project view. These custom folders can be specified with any
name or hierarchy level.

add_fol der veril og
add_fol der veril og/ comon_rtl
add_fol der veril og/common_rtl/prep

For more information about custom folders, see Managing Project File
Hierarchy, on page 70 in the User Guide.
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analyst

Changes and manipulates the schematic views of the netlist. Note that the
following HDL Analyst commands can be used without the analyst prefix as

well.

analyst clone_view analyst critical_path analyst dissolve
analyst filter analyst flatten analyst get_selected
analyst group analyst pop analyst push

analyst select analyst unfilter analyst view

analyst clone_view
Opens a copy of the current view.

analyst clone_view designiD

designID
The design ID to clone. If not specified, clones the current view.

analyst critical_path

Filters the view to show the instances that are part of the critical path, if
available.

analyst critical_path

analyst dissolve

Removes targeted hierarchies from the design. Contents of the hierarchy are
put into the level that originally contained the hierarchy.

analyst dissolve collection

collection
Collection of instances to dissolve.

analyst filter
Filters the view by selected instances and ports.

analyst filter

© 2021 Synopsys, Inc. Synplify Pro for Microchip Edition Command Reference
28 Synopsys Confidential Information June 2021



Tcl Synthesis Commands

analyst flatten
Flattens the current view.

analyst flatten

analyst get_selected
Returns the names of currently selected objects.
analyst get_selected [-inst] [-net] [-port] [-pin]

-inst
Returns the names of selected instances. If no -type option is set, the
names of all selected objects are returned.

-net
Returns the names of selected nets. If no -type option is set, the names
of all selected objects are returned.

-port
Returns the names of selected ports. If no -type option is set, the names
of all selected objects are returned.

-pin

Returns the names of selected pins. If no -type option is set, the names
of all selected objects are returned.

analyst group
Creates a graphical group of instances.

analyst group [collection] [-name groupName]

collection
Instances to group. All instances must be on the same level of the
hierarchy.

-name groupName
The name of the graphical group to be created.

analyst pop
Pops up the hierarchy.
analyst pop
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analyst push
Pushes down the hierarchy.

analyst push hierarchyName

hierarchyName

The name of the group or instance to push the hierarchy down into.

analyst select
Selects specified objects.

analyst select [collection] [-append] [-clear] [-instances] [-primitives]

collection
The ID of the collection to select.

-append
Appends objects to the selection list.

-clear
Clears the selection list.

-instances
Selects all instances in the current view.

-primitives

Selects all primitives (leaf) instances in the current view.
analyst unfilter
Unfilters the view.

analyst unfilter

analyst view
Opens a schematic view.

analyst view designID

designiD
The design ID to view.
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cdpl_queue

Use the cdpl_queue command to set a CDPL queue, get the configuration
setting of the CDPL queue, or clear the CDPL queue settings. These settings
are valid only for the current session, and not saved in the .ini file or any other
script. Create a Tcl file to save the settings and use it for subsequent
sessions. This command is available only as a Tcl syntax.

Syntax
cdpl_queue -set [queueType][queueConfig] | -get [queueType] | -clear

The following table describes the cdpl_queue command options:

Option Description
-set [queueType] Sets a CDPL queue configuration.
[queueConfig] « queueType is lowmem, highmem, default or vendor. The queue

type vendor is for all place and route jobs.

* queueConfig is the queue host file. See CDPL help
documentation on how to set up a queue host file.

-get [queueType] Returns the configuration setting of the queueType specified. If
queueType is not given, the command returns all the queue
types set in the current session.

-clear Clears all the queue settings.

Examples
To use this command, set up the following string in your project file:
cdpl_queue -set default $PWD/hosts_default

For more information, see the CDPL (Common Distributed Processing
Library) documentation.
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check fdc_query

Runs the constraint checker for constraints using the get * and/or all_* query
commands specified in the timing constraint file for the project.

Syntax

check_fdc_query [-full_check]

Arguments and Options

-full_check
Runs the full constraint checker before checking the query commands.
The default is to run the check fdc_query command without this option.

When the -full_check option is not specified, the command only runs the
constraint syntax checker, which reduces runtime significantly, since most
objects being searched are found in pre-mapping and do not require full
mapping to be run. However, this option does not find bit-blasted registers
and objects using the advanced -filter @property =~ commands, where the
property is created or applied during mapping because it requires optimiza-
tions such as register replication.

For example, if a 4-bit RAM output is targeted with the get_cell command, the
differences in the results are shown below:

Command Run Stage Results
Default (without -full_check) Pre-mapping ram_out [3:0]
With -full_check Mapping ram_out [3]
ram_out [2]
ram_out [1]
ram_out [0]
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Description

The check _fdc_query command reads the .fdc constraint file of the current
project file. It runs the constraint checker for the following object query
commands that are used with FDC constraints:

all_* Commands get_* Commands
all_clocks get_cells

all_fanin get_clocks
all_fanout get_nets

all_inputs get_pins

all_outputs get_ports
all_registers

The report provides feedback on how these query commands are applied and
ensures that the commands are used properly with constraints in the
constraint file.

Collections created with define_scope_collection, find, and expand are not covered
by this Tcl command. You can check these SCOPE collections in the HDL
Analyst and the SCOPE interface. The report does not cover the define_io_stan-
dard constraint either.

Example

Invoke check_fdc_query from the Tcl command line for the project. You can also
invoke it from a shell window.

The command writes out the results of the object query commands to the
projectName_cck_fdc.rpt file that opens in the GUI. You may need to run the
constraint checker (Run->Constraint Check) to find additional issues with
constraints.

Synplify Pro for Microchip Edition Command Reference © 2021 Synopsys, Inc.
June 2021 Synopsys Confidential Information 33



Tcl Synthesis Commands

The following example shows the results of running the constraint checker in
the projectName_cck _fdc.rpt file.

FDC query commands results
khkkhkkhkkhkkhkhhkkhkhkkhkkhkhkk ik kkk*%x
HHHH
# 1019 : set_ multicycle path 2 -from[get _cells -hier {*[4]}]
# line 175 in
C /check_fdc_query/all _clocks/testl basic/top_translated.fdc
Results of query command: get_cells -hier {*[4]}
(none)
HHHHH R
# 1027 : set_multicycle path 3 -to [all _cl ocks]
#1line 196 in
C. /check_fdc_query/all _clocks/testl basic/top_translated.fdc
Results of query conmand: all _cl ocks
cl ka
cl kb
dcmj CLKO_BUF _cl ock_CLKI NL
demj cl kO_i _cl ock_CLKI N1
dcmj CLKO_BUF 1 cl ock_CLKI N1

The syntax checker reports the object query commands and any issues it
found and writes them to the projectName_scck.rpt file.

# Synopsys Constrai nt Checker (syntax only), version map6l0dev,
Bui | d 1085R

# Copyright (C 1994-2016, Synopsys, Inc.

# Witten on Tue Apr 30 15:39: 07 2013

#i#### DESI GN | NFO

HH AR HH AR R R R R R R R

Top Vi ew "top"

Constraint File(s):

"C\check fdc _query\all clocks\testl basic\top translated.fdc"

"C \ buil ds\syn201309 063R\Ii b\ fdc_query. f dc"

# Run constraint checker to find nore i ssues with constraints.
HHHH AR R R
it

No issues found in constraint syntax.
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d ock Summary
Start
Request ed Request ed d ock d ock

d ock Frequency Period Type G oup
cl ka 100. 0 MHz 10. 000 decl are defaul t_cl kgroup
cl kb 50.0 M#z 20.000 declared default_cl kgroup
demj CLKO_BUF _cl ock_CLKI NL
200.0 MHz5.000 derived (fromcl ka) default cl kgroup
demj CLKO_BUF 1 cl ock _CLKINL
50.0 MHz 20.000 derived (fromcl ka) default_cl kgroup

See Also

Constraint Checking, on page 138
Constraint Checking Report, on page 173
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command_history

Displays a list of the Tcl commands executed during the current session.

Syntax

command_history [-save filename]

Arguments and Options

-save
Writes the list of Tcl commands to the specified filename.

Description

The command_history command displays a list of the Tcl commands executed
during the current session. Including the -save option, saves the commands
to the specified file to create Tcl scripts.

Examples
command_hi story -save C /Designsl|/tut/proto/nyTcl Script.tcl

See Also
* recording, on page 104
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constraint_file

The constraint_file command manipulates the constraint files used by the active
implementation.

Syntax

constraint_file
-enable constraintFileName
-disable constraintFileName
-list
-all
-clear

The following table describes the command arguments.

Option Description

-enable Selects the specified constraint file to use for the active
implementation.

-disable Excludes the specified constraint file from being used for the active
implementation

-list Lists the constraint files used by the active implementation

-all Selects (includes) all the project constraint files for the active
implementation.

-clear Clears (excludes) all the constraint files for the active implementation

Examples

List all constraint files added to a project, then disable one of these files for
the next synthesis run.

%constraint file -1ist
attributes.fdc cl ocksl.fdc clocks2.fdc eight_bit_uc.fdc
%constraint_file -disable eight_bit_uc.fdc

Disable all constraint files previously enabled for the project, then enable only
one of them for the next synthesis run.

%constraint file -clear
%constraint_file -enable clocks2. fdc
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create_fdc_template

Lets you create an initial constraint file (.fdc) for your specific design.

Syntax
create_fdc_template [-period float] [-in_delay float] [-out_delay float]

The following table describes the create_fdc_template command options.

Option Description

-period float Specifies the default values for port clocks.

-in_delay float Specifies the default values for the input delay ports.
-out_delay float Specifies the default values for the output delay ports.
Examples

Each port clock includes a set_clock_groups header with details shown below,
which can help you determine whether clocks have been optimized away or if
there are any derived clocks.

T T T
### 1 ndi vi dual "set _cl ock_groups" commands for all "clka" derived cl ocks
### appear at the end of this file. Enabling a given coomand wi |l nake the
### gl ven cl ock asynchronous to all other clocks. |If a given clock (bel ow
### does not appear in the final Performance Summary (in the *.srr

### file after synthesis), the clock may have been optim zed away due to
### Gat ed/ Generated d ock Conver si on.

### See the "CLOK CPTI M ZATI ON REPORT" in the *.srr file.

### Below is a list of any cl ocks derived from"clka":

### cl ka DER VED CLOCKS:

Hit# dcm CLKO_BUF_1_derived_cl ock_CLKIN O ock Object: {t:dcm.inst.CLK BUF1l. G}
Hit# dcnj CLKO_BUF_deri ved_cl ock_CLKI N1 O ock Object: {t:dcm.inst.CLK_BUFO. G}
T R T

set _cl ock_groups -di sabl e -asynchronous -nane {cl ka_gr oup}
-group {clka} -comment {Source cl ock cl ka group}

set _cl ock_groups -di sabl e -asynchronous
-nane {dcm CLKO_BUF_1 derived_cl ock_CLKI N1_gr oup}
-group [get_cl ocks
-of _objects [get_pins {t:dcminst. CLK BUF1l. G]]
-comment {Derived cl ock dcnj CLKO_BUF_1_deri ved_cl ock_CLKI NL
fromsource cl ock cl ka}
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set _cl ock_groups -di sabl e -asynchr onous
-nane {dcn CLKO_BUF _deri ved_cl ock_CLKI N1_gr oup}
-group [get_cl ocks
-of _objects [get_pins {t:dcm.inst. CLK BUF0. G]]
-comment {Derived cl ock dcrmj OLKO_BUF_deri ved_cl ock_CLKI N1
fromsource cl ock cl ka}

set _cl ock_groups -disabl e -asynchronous -nane {cl kb_group}
-group {cl kb} -comment {Source clock cl kb group}
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design

Returns netlist data representing information about the design. Commands
are available in both batch and GUI mode. Note that the following HDL
Analyst find commands can be used without the design prefix as well.

design c_diff design c_filter design c_info
design c_intersect design c_list design c_print
design c_symdiff design c_union design close
design expand design find design get_prop
design get design list design open
design set design top_level

design c_diff

Returns a new find collection containing the differences between two existing
find collections.

Syntax
design c_diff collectionl collection2

collection1
The first collection to compare.

collecton2
The second collection to compare.

design c_filter

Filters a find collection based on set properties.

Syntax
design c_filter collection pattern [-inst] [-net] [-port] [-pin] [-view]

collection
The collection ID to filter.

pattern
Statement used to filter.
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-inst
Returns matching instances. If no -type option (-inst, -net, -port, or -pin) is
set, all types will be returned.

-net
Returns matching nets. If no -type option (-inst, -net, -port, or -pin) is set,
all types will be returned.

-port
Returns matching ports. If no -type option (-inst, -net, -port, or -pin) is set,
all types will be returned.

-pin
Returns matching pins. If no -type option (-inst, -net, -port, or -pin) is set,
all types will be returned.

-view

Returns matching views. If no -type option (-inst, -net, -port, or -pin) is set,
all types will be returned.

design c_info
Returns information about the contents of a find collection.

Syntax

design c_info [collection] [-array value]

collection
Find collection information to display.

-array value
Specify an array to store collection information in.

design c_intersect

Defines common objects that are included in each of the collections being
compared.

Syntax
design c_intersect collectionList

collectionList
List of collections separated by spaces.

Synplify Pro for Microchip Edition Command Reference © 2021 Synopsys, Inc.
June 2021 Synopsys Confidential Information 41



Tcl Synthesis Commands

design c_list

Converts a collection to a Tcl list of objects.
Syntax

design c_list collection

collection
Collection to convert.

design c_print

Displays collections or properties in column format.

Syntax
design c_print collection [-prop propertyName] [-file filename] [-append]

collection
The collection to print as a table.

-prop
Writes a column in the table for properties of type propname.

-file
Writes the collection to filename.

-append
Appends to the file specified in -file rather than overwriting it.
design c_symdiff

Returns a new find collection containing the difference between two existing
find collections.

Syntax
design c_symdiff collectionl collection2

collection1 The first collection.

collection2 The second collection.
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design c_union

Combines multiple collections into a single collection.

Syntax

design c_union collectionList

collectionList
Space-separated list of collections.

design close

Closes the specified design ID. If no design ID is provided, this command
closes the current active design.

Syntax
design close designiD

designID

The design ID to close.

design expand

The design expand command identifies objects based on their connectivity, by
expanding forward from a given starting point. Returns a collection.

Syntax
design expand [-objectType] [-from object] [-thru object] [-to object] [-level integer]
[-hier] [-leaf] [-seq] [-print]

-objectType
Optionally specifies the type of object to be returned by the expansion. If
you do not specify objectType, all objects are returned. The object type is
one of the following:

-inst — returns all instances between the expansion points. This is the
default.

-pin — returns all instance pins between the expansion points.

-net — returns all nets between the expansion points.
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-port — returns all top-level ports between the expansion points.

-from object
Specifies a list or collection of ports, instances, pins, or nets for expan-
sion forward from all listed pins. Instances and input pins are automati-
cally expanded to all output pins of the instances. Nets are expanded to
all output pins connected to the net. If you do not specify this argument,
backward propagation stops at a sequential element.

-thru object
Specifies a list or collection of instances, pins, or nets for expansion
forward or backward from all listed output pins and input pins respec-
tively. Instances are automatically expanded to all input/output pins of
the instances. Nets are expanded to all input/output pins connected to
the net. You can have muiltiple -thru lists for product of sum (POS) opera-
tions.

-to object
Specifies a list or collection of ports, instances, pins, or nets for expan-
sion backward from all the pins listed. Instances and output pins are
automatically expanded to all input pins of the instances. Nets are
expanded to all input pins connected to the net. If you do not specify
this argument, forward propagation stops at a sequential element.

-level integer
Limits the expansion to N logic levels of propagation. You cannot specify
more than one -from, -thru, or -to point when using this option.

-hier
Modifies the range of any expansion to any level below the current view.
The default for the current view is the top level and is defined with the
define_current_design command as in the compile-point flow.

-leaf
Returns only non-hierarchical instances.

-seq
Modifies the range of any expansion to include only sequential elements.
By default, the expand command returns all object types. If you want
just sequential instances, make sure to define the object_type with the
-inst argument, so that you limit the command to just instances.

-print
Evaluates the expand function and prints the first 20 results. If you use
this command from HDL Analyst, results are printed to the Tcl window;
for constraint-file commands, the results are printed to the log file at the
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start of the Mapper section. For a full list of objects found, you must use
c_print or c_list. Reported object names have prefixes that identify the
object type. There are curly braces around each name to allow for spaces
in the names. For example:

{i:regl}
{i:reg2}
{i :\'weird_nane[foo%]}
{i:reg3}
<<found 233 objects. Displaying first 20 objects. Use
c_print or c_list for all. >>
design find

Identifies design objects based on specified criteria.

Syntax

design find
[-objectType] pattern
[-seq]
[-inst instance]
[-net net]
[-port port]
[-pin pin]
[-view view]
[-depth viewNumber]
[-flat]
[-print]
[-filter expression]
-in value
-below value
-nocase

-objectType pattern
Specifies the type of object to be found. Object types are view, inst, port,
pin, or net. The pattern argument is required and specifies the search
pattern to be matched. The pattern can include the * and ? wildcard

characters.
-seq
Finds sequential (clocked) instances (the -inst object type is not required).
This argument is equivalent to -filter @is_sequential.
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-hier
Extends the search downward through each level of the local hierarchy,
instead of limiting the search to the current view. The default hierarchy
separator for the search is the period (.).

-inst instance
Finds instances. If no -type option is set, find defaults to finding
instances, nets, and ports.

-net net
Finds nets. If no -type option is set, find defaults to finding instances,
nets, and ports.

-port port
Finds ports. If no -type option is set, find defaults to finding instances,
nets, and ports.

-pin pin
Finds pins. If no -type option is set, find defaults to finding instances,
nets, and ports.

-view view
Finds views. If no -type option is set, find defaults to finding instances,
nets, and ports.

-depth depth
Sets the start depth for the search. depth may be a single hierarchy depth
or a range. Using -depth with a range will cause -hier and -flat arguments
to be ignored. Setting -depth to 0 will start the search at the top level.

-flat
Extends the search to all levels, but with -flat, the * wildcard character
matches hierarchy separators as well as characters. This means that the
following example finds instance al_fft at the current level as well as the
hierarchical instance al.fft:

find -seq -flat al*fft

-print
Prints the first 20 search results. For a full list of objects found, use
c_print or c_list. If you use find from the shell, the results are printed to the
Tcl window; if you find in the constraint file, the results are printed to the
log file at the beginning of the Mapper section. Reported object names
have prefixes that identify the object type and curly braces around each
name to allow for spaces in the names as shown below:
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{i:regl}

{i:\'weird_nane[foo%]}

{i:reg2}

<<found 233 objects. Dsplaying first 20 objects. Use c_print
or c list for all. >>

-filter expression
Further refines the results of find by filtering the results using the speci-
fied object property. For syntax details, refer to find -filter, on page 156.

-in value
Searches a collection to find a subset of the collection.

-below value
Sets the start point of the search to the specified instance path. Only
search for objects below that point.

-nocase
Ignores the case when matching object names.

design get_prop

Returns a list of property values for an object or collection.

Syntax
design get_prop [objectName | collection] [-prop value] [-all] [-array value]

objectName ] collection
The object or collection to use.

-prop
The property value to return.

-all
Prints all available properties.
-array
Specifies array where properties are stored. Only use with -all and the
find collection must be limited to one object.
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design get

Returns the design ID for the current active design.

Syntax
design get

design list

Returns a list of available design IDs.

Syntax
design list

design open

View schematic of the design in its current state.

Syntax
design open [netlist]

netlist
The netlist to view.

design set

Sets specified design ID as the active design.

Syntax
design set designID

designiD

The design ID to set as active.
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design top_level

Returns a Tcl list of top-level information in the following order:
lib topModule topView.

Syntax
design top_level

For example:

design top_| evel
work eight bit _uc veril og
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dump_metrics

Shows metrics and values available for the current implementation of a

design. By default, only primary metrics are shown.

Syntax
dump_metrics [-show_queries] [-all]

-all

Shows detailed metrics as well as primary metrics for the design.

-show_queries

Shows available metrics in the form of a Tcl command that can be used

to retrieve each metric.

The default output format is

table.[object|global]: metric = value [units] from job [// description]

Examples

% dunp_netrics -all

*cl ock_conversion. gl obal : icg_removed = 0 from prenap
/I Nunber of 1GG|atches renoved
*cl ock_conversion.global: icg_retained = 0 from premap

// Nunber of |GG | atches not renoved

*cl ock_conversion. gl obal : clean_clock_trees = 1 from fpga_napper

// Nunber of non-gated/ non-generated clock trees

*cl ock_conversion. gl obal : cl ean_cl ock_pins = 270 from f pga_mapper

// Nunber of cl ock pins driven by non-gated/ non-generated clock trees

*cl ock_conversion. gl obal : gated_clock_trees = 0 from fpga_napper

// Nunber of gated/generated clock trees

*cl ock_conversion. gl obal : gated_cl ock_pins = 0 from fpga_mapper

// Nunber of clock pins driven by gated/ generated cl ock trees

*cl ock_conversion. gl obal : i nstances_converted = 0 from fpga_mapper

// Nunber of sequential instances converted

*cl ock_conversion. gl obal : instances_notconverted = 0 from f pga_nmapper

// Nunber of sequential instances |eft unconverted

*hdl _conpile.global: nodified files =28 from conpiler
//Total nunber of HDOL input files conpiled

*hdl _conpi |l e. gl obal : nodi fi ed_nodul es = 11 from conpi |l er
//Total nunber of nodul es conpil ed

*hdl _conpile.global: total _nmodules = 11 from conpiler
[/ Total nunber of nodul es

*hdl _conpile.global: total _files = 28 fromconpiler
//Total nunber of HOL input files

*m sc.global: Part = xc7vx485tffgll57-1 from fpga_napper

*runtinme.global: realtine = 3.154000 seconds from conpil er

*runtime. gl obal : cputime = 1.809612 seconds from conpil er
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*runtine.global: realtime = 1.452000 seconds from prenap
*runtine.global: cputime = 1.622410 seconds from prenap
*runtine.global: realtime = 9.881000 seconds from fpga_mapper
*runtine.global: cputime = 9.828063 seconds from f pga_napper
*timng.global: "Wrst Slack" = -0.445800 ns from f pga_napper
utilization.global: LUl = 31 from fpga_nmapper
utilization.global: LUT2 = 64 from fpga_napper
utilization.global: LU3 = 45 from fpga_nmapper
utilization.global: LUT4 = 84 fromfpga_napper
utilization.global: LUS = 57 from fpga_mapper
utilization.global: LUT6 = 160 from fpga_napper
utilization.global: IBUF =1 from fpga_mapper
utilization.global: IBUFG =1 fromfpga_napper
utilization.global: |BU =24 fromfpga_mapper

*utilization.qgl obal: "1/0 primtives" =26 fromfpga_napper
utilization.global: BUFG =1 from fpga_mapper
*utilization.global: "1/O Register bits" = 0 fromfpga_mapper

*utilization.global: "Total Luts" = 411 from fpga_nmapper

Note: The * denotes a primary metric.

% dunp_netrics -show queries

query_rmretric clock_conversion.icg_renoved -jobnanme prenap
query_rmretric clock_conversion.icg_retai ned -jobnane prenap
query_rretric clock_conversion. cl ean_cl ock_trees -jobnane fpga_napper
query_rretric cl ock_conversion. cl ean_cl ock_pi ns -j obnare fpga_mapper
query_rmretric clock_conversion. gated_cl ock_trees -jobnane fpga_napper
query_rretric cl ock_conversion. gat ed_cl ock_pi ns -j obnare fpga_mapper
query_rmetric clock_conversion.instances_converted -jobnane fpga_napper
query_rretric cl ock_conversion. i nstances_not converted -jobname fpga_mapper
query_rretric hdl _conpile.nodified files -jobname conpiler

query_rretric hdl _conpil e. nmodi fi ed_nodul es -j obname conpil er
query_rretric hdl _conpile.total _nodul es -jobnare conpil er

query_retric hdl _conpile.total _files -jobnane conpil er

query_rmetric msc.Part -jobnane fpga_napper

query_rmnetric runtine.realtime -jobnane conpiler

query_rmetric runtinme.cputime -jobnane conpiler

query_metric runtine.realtime -jobname premap

query_rmetric runtine. cputime -jobnanme prenap

query_rmetric runtine.realtime -jobnane fpga_napper

query_rmetric runtine. cputime -jobnanme fpga_napper

query_retric {timng. Wrst S ack} -jobname fpga_mapper
query_retric {utilization.|/Oprimtives} -jobnanme fpga_napper
query _rnetric {utilization.l/O Register bits} -jobnane fpga_napper
query _rnetric {utilization. Total Luts} -jobnane fpga_napper
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Naming Conventions for Metrics
The naming convention used for metrics consists of the following:

* Table — Represents a group of related metrics, such as, timing, runtime,
or clock conversion.

¢ Metric Name - Descriptive string used to query metrics. This name
usually consists of lower case letters with underscores between words.

¢ Units — Values associated with the metric, such as ns or percent are only
shown if details are specified.

* Object — Some metrics are associated with an object, while others are
global. Objects can be a clock net name, view name, or an instance path.

¢ Description — Brief description of the metric.

For example, clock conversion metrics can be specified as follows:

Table Metric Name Description

clock_conversion clean_clock_trees Number of non-gated/non-generated clock
trees

clock_conversion clean_clock_pins Number of clock pins driven by
non-gated/non-generated clock trees

clock_conversion gated_clock_trees Number of gated/generated clock trees

clock_conversion instances_converted  Number of sequential instances converted

clock_conversion instances_notconvert Number of sequential instances left

ed unconverted
See Also

To query metrics for a design, see the following commands:
* query_available_metrics, on page 97
* query_metric, on page 100

* query_metric_details, on page 102
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encryptiP

The encryptlP script lets you encrypt data with the OpenlP scheme.
Download the script from the Synopsys website and run it directly from Perl.
The Perl command line syntax for running the script is as follows:

Perl encryptIP Script Syntax

encryptlP
-in | input inputFile
-out | output outputFileName
-c | cipher "{des-cbc | 3des-cbc |aes128-cbc }"
-k | key symmetricEncryptionKeylnTextFormat
-kx | keyx symmetricEncryptionKeylnHexadecimalFormat
-bd | build_date ddmmmyyyy
-om | outputmethod "{plaintext | blackbox | persistent_key}
-incv | includevendor vendorKeyBlock
-dkn | datakeyname sessionKeyName
-dko | datakeyowner sessionKeyOwner
-a | author dataAuthor
-v | verbose

You must specify all required parameters.

-in | input Names the input HDL file to be encrypted.
-out | output Names the output file generated after encryption.
-c | cipher Specifies the symmetric encryption cipher. The key length must

match the algorithm being used, with each character using 8 bits.

» des-cbhc specifies the Data Encryption Standard (DES); uses a
64-bit key.

« 3des-chc specifies the Triple Data Encryption Standard (Triple
DES); uses a 192-bit key.

e aesl128-chc specifies the Advanced Encryption Standard (AES
Rijndael); uses a 128-bit key.

See Encryption and Decryption , on page 477 in the FPGA
Synthesis User Guide for an overview.

-k | key Specifies the symmetric data decryption key used to encode your
HDL data block. The key is in text format, and can be any string
(e.g. ABCDEFG).The exact length of the key depends on the data
method you use.
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-kx | keyx* Optional parameter. Specifies the symmetric encryption key in
hexadecimal format.

-bd | build_date  Specifies a date (ddmmmyyyy). The IP only works in Synopsys
software released after the specified date. This option lets you
force users to use newer Synopsys FPGA releases that contain
more security features. Contact Synopsys if you need help in
deciding what build date to use.

-om | Determines how the IP is treated in the output after synthesis:
outputmethod - plaintext specifies that the IP is unencrypted in the synthesis
netlist.

= blackbox specifies that the IP is treated as a black box, and only
interface information is in the output.

 persistent_key is the default setting. It re-encrypts the output
after synthesis in accordance with the OpenlP standard.

See Specifying the Script Output Method for OpenlIP Encryption ,

on page 494 for more information.

-incv | Optional parameter that specifies a key block for an EDA vendor,

includevendor so that IP can be read by the vendor tools. C

-dkn | Specifies a string that denotes your session key, that was used to

datakeyname encrypt your IP.

-dko | Optional parameter that names the owner of the session key. The

datakeyowner value can be any string.

-a | author Optional parameter that names the author of the session key. The
value can be any string.

-v | verbose Specifies that the script run in verbose mode.
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Example of encryptIP (OpenlP) Script Output

The following is an example of the script output:

Key block with session key key block header
with ke information

$%% protect protected file [L.0

“opticonal unencrypted HOIx

%$%% protect begin protected
$%% protect key keyvouwner=Svhopsys

%%% protect key:keyname=SYN o5 001
%$%% protect key block
U9nZ a3KwE 7TRWhEGEz7C+ 700t KehgOgTmb 8UdRxI SekIJDfon/

<other key blocksi>

%%% protect data method=assl1-8-chc

%$3% protect data klock
UiThom3CPmGz 27 DEANQZE By 7hes vIwe 31 P5 9HY ZHT £oMIM/
4

%% protect snd protectgd

<optional unencriypted HOL*

Data block Data block header with
encryption method

For brief descriptions of the pragmas used in the output of the encryptlP
script, see Pragmas Used by Encryption Scripts, on page 58.
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encryptP1735

Run the encryptP1735 script directly from Perl.

The script supports different models for encrypting HDL files and accessing
the encrypted information (see IEEE 1735 Encryption Use Models, on

page 59). The use model is determined by how blocks are marked for encryp-
tion in the HDL, combined with the information in the public keys file, which
is described in Public Keys File, on page 57.

Perl encryptP1735 Script Syntax

encryptP1735
-l | list listofFiles
[-pk | public_keys keyFileName]
[-sk | showkey]
[-verbose]
[-verilog]
[-vhdl]
[-log logFileName]
[-h | -help]

The following table describes the command-line arguments.

-l | list Specifies a list of the files to be encrypted; listofFiles is a list of
the non-encrypted HDL input files with each filename entry on
a separate line.

-pk | public_keys  Specifies the public keys repository file. This file contains
public keys for various tools. If the encryption envelope
contains a key block with a particular keyowner and keyname,
the script searches the public keys file to find a corresponding
public key to use during key-block generation. See Public Keys
File , on page 57 for information about this file.

-sk | showkey When used, the encryption script displays the session key in
use. This is useful when random keys are used and you want
to know which key is being used.

-verbose Prints more detailed messages to the screen or log file.
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-verilog Specifies Verilog HDL file format when filename does not
include a .v or .sv extension.

-vhd| Specifies VHDL HDL file format when filename does not include
a .vhd or .vhdl extension.

-log Prints messages to the specified log file.

Public Keys File

The encryptP1735.pl encryption script requires public key information, which is
specified in a designated file (-public_keys or -pk) option). This file includes
public keys for each of the tools that are allowed access to the envelope with
the encrypted data. The default keys file is called keys.txt and is located with
the encryption script in the lib directory of the tool installation.

/1 Use verilog pragma syntax in this file

“pragnma protect version=1
“pragna protect author="default"
“pragna protect author _info="default"

“pragna protect key keyowner="Synopsys", key_ keynane="SYNP15 1",
key net hod="rsa"

“pragma protect key public_key

<publ i c_key_bl ock>

/1 Add additional public keys belowthis |ine
/1 Add additional public keys above this |ine

“pragna protect data keyowner="defaul t-i p-aut hor"
“pragna protect data keynane="defaul t-i p-key"
“pragma protect data_met hod="aes128-cbhc"

/!l End of file

For the partial file with all pragmas use model, the following pragma attribute
values must match the corresponding values in the key-block section of the
encryption envelope:

“pragma protect key_keyowner="Synopsys", key_keyname="SYNP15 1",
key et hod="rsa"

For information on the pragmas supported, see Pragmas Used by Encryption
Scripts, on page 58.
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Pragmas Used by Encryption Scripts

Both the encryptlP1735 and encryptlP (OpenlP) schemes use the pragmas
described in the following tables. Note the following:

*  The %%% protect directive must be placed at the exact beginning of a line.

¢ Exactly one white-space character must separate the %%% sequence
from the command that follows.

The following table lists the pragmas used. In Verilog, the pragma must be
preceded by the word pragma; this is not required in VHDL.

General Pragmas

%%% protect protected_file 1.0 Line 1 of file with encrypted data

%%% protect begin_protected Marks the beginning of data to be encrypted
%%% protect end_protected Marks the end of data to be encrypted

%%% protect comment comment  Single-line plain-text comment

%%% protect begin_comment Marks the beginning of plain-text comment block
%%% protect end_comment Marks the end of plain-text comment block

Data Block Pragmas (IP Author Data Encryption Information)

%%% protect author=string Lists name of IP author

%%% protect version=1 Specifies encryption version; required only for IEEE
1735 Partial File with Standard Pragmas encryption
use model

%%% protect Specifies the DES encryption method used:

data_method=des-cbc | 3des-cbc o5 ope: Data Encryption Standard (DES)

|aes128-cbc

e 3des-cbc: Triple DES

e aesl128-chc: Advanced Encryption Standard (AES)
%%% protect data_block Immediately precedes the encrypted data block

Key Block Pragmas (IP Consumer Public Key Information)

%%% protect Lists the owner of the key
key_keyowner=string
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%%% protect Name recognized by the Synopsys software to select
key_keyname=string the key block

%%% protect key_method=string Encryption algorithm (RSA currently supported)

w %%% protect key_block Immediately precedes encrypted key block

IEEE 1735 Encryption Use Models

Encryption models determine the scope of what gets encrypted and who can
access the files. The encryptP1735 script lets you use these use models to
encrypt HDL files:

Encryption Model Details
Full file Full-File Use Model, on page 59
Partial file with minimal pragmas Partial File with Minimal Pragmas Use

Model, on page 60

Partial file with standard pragmas Partial File with Standard Pragmas Use

(Recommended) Model, on page 61
Partial file with IEEE pragmas Partial File with IEEE Pragmas Use Model,
on page 63

Full-File Use Model

Use this model to encrypt the entire file. The entire HDL file is included in the
decryption envelope. This model uses the keys.txt file to define which
consumers have access to the encrypted data.

HDL e Contains no encryption pragmas (entire file is encrypted)

keys.txt e Contains public key information for multiple downstream tools
« Owners of all public keys listed have access to the entire file

This Verilog example encrypts the whole file (tb_encrypt.v), including the
module named secret that it contains.

nmodul e secret (a, b, clk);
i nput a, clk;

out put b;

reg b=0;
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al ways @ posedge cl k) begin
b = a;

end

endnodul e

Run the script to encrypt the file:
perl encryptP1735.pl -list nylist -1og encryptP1735.10g

This command runs the script on a file (mylist), which lists the single Verilog
file tb_encrypt.v. The command uses the default keys.txt file from the lib direc-
tory, and creates the decryption envelope file th_encrypt.vp. Messages from the
run are written to the encryptP1735.log file.

Partial File with Minimal Pragmas Use Model

With this encryption model, pragma protect begin and pragma protect end pragmas
are used to indicate the start and end points of encryption regions. This
model is best suited for cases where every encryption region must be
encrypted for every key in the key file. When using this model, you must
encrypt the entire module. The encryptP1735.pl script checks all the begin and
end pragmas and generates the decryption envelope for each tool specified in
the keys file.

HDL « Contains individual blocks marked for encryption (partial file)
e Contains no public key information

keys.txt e Contains public key information for multiple downstream tools
« Owners of all public keys listed have access to all encrypted HDL blocks

To illustrate this use model, consider a single, Verilog file (tb_encrypt.v) to be
encrypted with only begin and end pragmas. This file contains a single
module named secret.

“pragma protect begin
nodul e secret (a, b, clk);
i nput a, clk;

out put b;

reg b=0;

al ways @ posedge cl k) begin
b = a;

end

endnodul e

“pragna protect end
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When you run the script with the following command, it uses the begin and
end pragmas specified in the HDL file to encrypt the file:

perl encryptP1735.pl -list nylist -pk keys.txt

Here, the list file (mylist) names the Verilog file tb_encrypt.v. The command
encrypts the data between the begin and end pragmas and creates the
decryption envelope file tb_encrypt.vp for all tools listed in the key file. No log
file (-log option) is specified, so messages are not written to a log file.

Partial File with Standard Pragmas Use Model

This is the recommended encryption use model. It is the most flexible
because you can choose to encrypt individual blocks instead of the entire file
and specify which tools can access each encrypted block on a per-block
basis. When using this model, you must encrypt the entire module. This
model requires a side file (keys.txt) that contains public key information for IP
consumers.

HDL e Marks individual blocks for encryption (partial file)

< Includes public key encryption pragmas for each tool that is allowed
access to an encrypted block, except the key itself (key_public_key)

« Key information must match the information in the keys.txt file
< Can allow different keys access to different blocks

keys.txt e Contains public key information for multiple downstream tools
e Must include all public key encryption pragmas, as well as the public
key itself

* Only those owners of public keys listed in the HDL before the encrypted
block have access to that block; all public keys listed in keys.txt need not
be used in the HDL

If there are conflicting pragmas defined in the HDL and the keys.txt file, the
HDL pragma takes precedence over the corresponding pragma in the keys.txt
file. For example, if data_method in the HDL is defined as des-cbc but the same
pragma in the keys.txt file defines it as aes128-cbc, the HDL definition is used
and copied to the decryption envelope:

dat a_net hod="des- cbc"
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Verilog Example

This example encrypts a single Verilog file (tb_encrypt.v). The file contains a
module named secret and includes all the encryption-related pragmas in the
HDL, with the exception of key public_key.

“pragnma protect version=1

“pragna protect encodi ng=(enctype="base64")

“pragna protect author="author-a", author_info="author-a-details"
“pragna protect encrypt agent ="encrypt P1735.pl",

encrypt _agent _info="Synplify encryption scripts"

“pragma protect key_keyowner =" Synopsys", key_keynane="SYNP15_ 1"
key met hod="rsa", key_ bl ock

" pragnma protect

dat a_keyowner ="i p- vendor - a", dat a_keynanme="f pga-i p"

dat a_net hod="des- chc"

“pragna protect begin

nodul e secret (a, b, clk);

i nput a, clk;

out put b;

reg b=0;

al ways @ posedge cl k) begin
b = a;

end

endnodul e

“pragna protect end

The script is then run with the following command, where the list file (mylist)
names a single file, tb_encrypt.v. The command uses the default keys.txt file
from the installLocation/lib directory as the public keys file to create the decryp-
tion envelope file tb_encrypt.vp. No log file is specified, so messages from the
run are not sent to a log file.

perl encryptP1735.pl -list nylist -pk keys.txt

VHDL Example

This example partially encrypts a VHDL file (tb_encrypt.vhd) where all encryp-
tion pragmas are specified in the file, except for key_public_key. The file
contains a single entity/architecture pair named secret. For VHDL pragmas,
just use the keyword protect.

l'ibrary | EEE
use | EEE. std_| ogi c_1164. al | ;
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entity secret is
port (clk : in std_logic;

a: in std_|ogic;
b : out std logic);
end entity;

“protect version=1

“protect author="author-a", author_info="author-a-details"
“protect encrypt_agent="encrypt P1735. pl ",

encrypt _agent i nfo="Synplify encryption scripts"

“protect encodi ng=(enctype="base64")

“protect key keyowner="Synopsys", key_ keynane="SYNP15 1",

key net hod="rsa", key_bl ock

“protect data_keyowner="ip-vendor-a", data_keynane="fpga-ip",
dat a_net hod="des- cbc"

“protect begin

architecture rtl of secret is
signal b_reg: std_| ogic;

begi n
process (clk) is
begi n
if rising_edge(clk) then
b reg <= a;
end if;
end process;
b <= b_reg;

end architecture;
“protect end

Encrypt the file with the following command, where the list file (mylist) names
a single VHDL file, tb_encrypt.vhd. The command uses the default keys.txt file
from the directory installLocation/lib as the public keys file to create the decryp-
tion envelope file tb_encrypt.vhdp. Messages are not captured in a log file.

perl encryptP1735.pl -list nylist -pk keys.txt

Partial File with IEEE Pragmas Use Model

Like the partial file with standard pragmas model, this use model is flexible,
but it does not require a side file with the key block information. This makes
it the most portable model, because all the information, including the key
block information for each IP consumer, is included in the source code. When
using this model, you must encrypt the entire module.
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HDL

* Marks individual blocks for encryption (partial file)

« Includes public key encryption pragmas for each tool that is allowed
access to an encrypted block, including the key itself (key_public_key)

e Can allow different keys access to different blocks

keys.txt  « Not required

nodul e top (ga, gb, a, b, clk);
input a, b, clk;

out put ga, qgb;

enc_and iand (ga, a, b, clk);
enc_or ior (gb, a, b, clk);
endnodul e

“pragna protect version=1

“pragna protect author="author-a", author_info="author-a-details"

“pragna protect key keyowner="Synplicity", key_ keyname="SYNP15 1",

key net hod="rsa"

“pragna protect key public_key
<publ i c_key bl ock>

“pragnma protect key_keyowner = "XYZ"
“pragna protect key nethod = "rsa"
“pragna protect key keynanme = "XYZ8 001"

“pragna protect key public_key
<publ i c_key bl ock>

“pragna protect data net hod="aes128-chc"
“pragna protect begin

nodul e enc_and (g, a, b, clk);

input a, b, clk;

out put q;

reg q=0;

al ways @ posedge cl k) begin
g=a&b;

end

endnodul e

“pragma protect end
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“pragna protect version=1

“pragnma protect author="author-a", author_info="author-a-details"
“pragna protect key keyowner="Synplicity", key keynane="SYNP15 1",

key_rmet hod="rsa"
“pragma protect key public_key
<publ i c_key_bl ock>

“pragnma protect key keyowner = "XYZ'
“pragna protect key method = "rsa"
“pragma protect key keynanme = "XYZ8 001"
“pragma protect key public_key

<publ i c_key_bl ock>

“pragma protect data_net hod="aes128- chc"
“pragnma protect begin

nmodul e enc_or (g, a, b, clk);
input a, b, clk;

out put g;

reg q=0;

al ways @ posedge cl k) begin
q=al b;

end

endnodul e

“pragnma protect end
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get _env

The get_env command reports the value of a predefined system variable.

Syntax
get_env systemVariable

Use this command to view system variable values. The following example
shows you how to use the get_env command to see the value of the previously
created MY_PROJECT environment variable. The MY_PROJECT variable
contains the path to an HDL file directory, so get_env reports this path.

get _env MY_PRQIECT
d:\project\hdl _files

In the project file or a Tcl script, you can define a Tcl variable that contains
the environment variable. In this example, my_project _dir contains the
MY_PROJECT variable, which points to an HDL file directory.

set ny_project_dir [get_env MY_PRQIECT]

Then, use the $systemVariable syntax to access the variable value. This is
useful for specifying paths in your scripts, as in the following example which
adds the file myfilel.v to the project.

add_file $ny_project_dir/nyfilel.v

get_option

The get_option command reports the settings of predefined project and device
options. The options are the same as those for set_option. See set _option, on
page 113 for details.

Syntax

get_option -optionName
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hdl_define

For Verilog designs, this command specifies values for Verilog text macros.

You can specify text macro values that you would normally enter using the
Verilog "define statement in a Verilog file included at the top of the synthesis
project. The parameter value is valid for the current implementation only.

This command is equivalent to the set _option -hdl_define command.

Syntax

hdl_define
-set "directive=value [directive=value ...]"
-Clear
-list

Examples
hdl _define -set "SI ZE=32"

This statement specifies the value 32 for the SIZE directive; the following
statement is written to the project file:

set _option -hdl _define -set "SI ZE=32"

To define multiple directive values using hdl_define, enclose the directives in
quotes and use a space delimiter. For example:

hdl _define -set "SI ZE=32 W DTH=8"
The software writes the following statement to the prj file:

set _option -hdl _define -set "size=32 w dt h=8"

See Also

Compiler Directives and Design Parameters, on page 376 for information on
specifying compiler directives in the GUI.
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hdl_param

The hdl_param command shows or sets HDL parameter overrides. For the GUI
equivalent of this command, select Project->Implementation Options->Verilog/VHDL.

Syntax

hdl_param
-add {paramName}
-list | -set paramName {paramValue}
-Clear
-overrides

The following table describes the command arguments.

Option Description
-add Adds a parameter override to the project.
-list Shows parameters for the top-level module only and lists

values for parameters if there is a parameter override.

-set Sets a parameter override and its value for the active
implementation. Only the parameter value is enclosed within
curly braces.

-clear Clears all parameter overrides of the active implementation.
-overrides Lists all the parameter override values used in this project.
Examples

In batch mode, to set generic values using the set_option command in a
project file, specify the hdl_param generic with quotes and enclose it within {}.
For example:

set_option -hdl _param-set ramfile {"init.mem'}
set_option -hdl _param-set simulation {"fal se"}
Suppose the following parameter is set for the top-level module.

set_option -hdl _param-set {"wi dth=8"}
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Add a parameter override and its value, then list the parameter override.

hdl _param -add {"si ze=32"}
hdl _param-1list "size=32"

You can specify hdl_param generics with different types, such as, an integer,
std_logic_vector, or string value for VHDL. Here are some examples that show
how to define these generics:

* With an integer value

set_option -hdl _param -set DATA WDTH 4
* With a std_logic_vector value

set _option -hdl _param-set MY_SLV {"0011"}
* Using a string value

set_option -hdl _param-set initialization_file {"table2"}
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help

The help command displays the usage syntax and description for the specified
command in the Tcl window.

Syntax

help commandName | wildcardTerm

Examples
hel p set_option

usage: set_option -<opti onName> <optionVal ue> -- set option
on active inplenmentation

get _option -<optionName> -- return option val ue on
active inplenentation

help c_*

c_diff

c filter
c_info

C_i ntersect
c list
c_rmenber
c_print
c_syndiff
C_uni on
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history

Returns a numbered list of executed Tcl commands.
Syntax

history [event number|clear Jinfo [number] | keep [number] | nextid Jredo [number]]

event number
Returns command number from the history list.

clear
Clears the history list.

info [number]
Returns the last number of commands. If no number is included, returns
all.

keep [number]
Sets the number of commands to save in history. Also returns the
current setting.

nextid
Returns the index number that the next command will be assigned to in
the history list.

redo [number]
Executes the number command. If no number is given, executes the latest
command.

Examples
hi story event 12

history redo 4
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impl
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The impl command adds, removes, or modifies an implementation.

Syntax

impl

-add [impIName] [model]
-name impIName
-remove implName
-active [impIName]

-list

-type implType
-result_file

-dir

The following table describes the command arguments.

Option
-add

-name
-remove

-active

-list

-type

-result_file

-dir

Description

Adds a new device implementation. If:

« impIName is not specified, creates a unique implementation
name by incrementing the name of the active
implementation.

* you want to add a new implementation copied from
implementation model.

Changes the name of the active implementation.
Removes the specified implementation.

Reports the active implementation. If you specify an
implementation name, changes the specified name to the
active implementation.

Lists all the implementations used in this project.

Specifies the type of implementation to add. For example, the:
« -type fpga option creates an FPGA implementation.
» -type identify option creates an Identify implementation.

Displays the implementation results file.

Displays the implementation directory.
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Examples

The following command sequence lists all implementations, reports the active
implementation, and then activates a different implementation.

%inpl -list
desi gn_wor st desi gn_typi cal design_best

%inpl -active
desi gn_best

% npl -active design_typical

%inpl -active
desi gn_t ypi cal

%inpl -add rev_1 identify mxed -type identify
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job
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The job command, for place and route job support, creates, removes, identi-
fies, runs, cancels, and sets/gets options for named P&R jobs.

Syntax

job jobName [-add jobType |-remove |-type |-run [mode] |-cancel |
-option optionName [optionValue] ]

job -list

The following table describes the command options.

Option

-run

-add jobType
-cancel
-remove

-list
-remove
-option

optionName
[optionValue]

-type

Examples

Description

Runs the P&R job, according to the specified options:
Creates a new P&R job for the active implementation.
Cancels a P&R job in progress.

Removes a P&R job from an active implementation

Returns a list of the P&R jobs in the active implementation.
Removes a P&R job from the active implementation

Get/set options for jobName.

Returns the P&R job type.

% job pr_2 -add par
%job pr_2 -run
% job pr_2 -option enable run 1
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log_filter

This command lets you filter errors, notes, and warning messages. The GUI
equivalent of this command is the Warning Filter dialog box, which you access
by selecting the Warnings tab in the Tcl window and then clicking Filter. For
information about using this command, see Filtering Messages in the
Message Viewer, on page 207 in the User Guide.

Syntax

log_filter -field fieldName==value
log_filter -show_matches
log_filter -hide_matches
log_filter -enable

log_filter -disable

log_filter -clear

The following table shows valid fieldName and value values for the -field
option:

Fieldname Value

type Error | Warning | Note
id The message ID number. For example, MF138
message The text of the message. You can use wildcards.

source_loc  The name of the HDL file that generated the message.

log_loc The corresponding srr file (log).
time The time the message was generated.
report The log file section. For example, Compiler or Mapper.
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Example

log_filter -hide_natches

log filter -field type==Wrning -field nmessage==*Una*
-field source_ | oc==sendpacket.v -field | og_| oc==usbHost Sl ave. srr
-field report=="Conpil er Report"

log filter -field type==Note

log_filter -field id==BNL32

log_filter -field id==CL169

log filter -field message=="Input *"

log filter -field report=="Conpiler Report"

© 2021 Synopsys, Inc. Synplify Pro for Microchip Edition Command Reference
76 Synopsys Confidential Information June 2021



Tcl Synthesis Commands

log_report

This command lets you write out the results of the log_filter command to a file.
For information about using this command, see Filtering Messages in the
Message Viewer, on page 207 in the User Guide.

Syntax

You specify this command after the log_filter commands.

log_report -print fileName

Example

log report -print output.txt
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message_override

Allows you to suppress or override the log file message ID specifications with
another type or limit.

Use -limit and -count, to limit the number of occurrences for all messages or
specific messages in each log file. Messages that exceed the limit still show up
in the Report Summary page and can be retrieved later from the message
database. Suppressing messages is the same as -limit ID -count O; errors cannot
be suppressed or limited.

Syntax

message_override [-suppress value] [-read_file value] [-error value]
[-warning value] [-note value] [-remove value] [-global] [-clear]
[-limit value] [-count value]

The following table describes the command arguments and options.

Option Description

-suppress value Lists message IDs to suppress in the log file.
-read_file value Reads the specified message override file.

-error value Lists the message ID type as an error.

-warning value Lists the message ID type as a warning.

-note value Lists the message ID type as a note.

-remove value Removes the override and resets the message type to

its original value.

-global Allows message operations to be applied globally.
Otherwise, the override operation is only applied on
messages for the current project.
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Option Description

-clear Removes all overrides and resets messages to their
original types.

-limit value Lists message IDs for a specific log file to the specified
limit. Use with the -count argument. Also, use

* message_override -limit default -count 1000 7 - Changes
the default limits for all messages

* message_override -limit default -count unlimited - Changes
the default limits for all messages to unlimited

-count value Counts the message IDs specified with the -limit
argument.

Examples

It is recommended that you set the default limit to something other than
unlimited, if possible. To do this, you can specify the following:

nmessage_override -default linit 100
More examples are shown below:
1. Upgrade messages with ID MF446 to be treated as an error.
nmessage_override -error M-446
2. Suppress messages with ID BN101 (cannot be done for errors):
nmessage_override -suppress BNLO1

3. Limit the number of occurrences of messages with IDs MF580 and
MF581 to 1000 each in each log file:

message_override -limt {M580 M581} -count 1000

4. Unlimit the number of occurrences of messages with ID CL118 in logs
and reports:

message_override -limt CL118 -count unlimted
5. Clear existing message overrides:

message_override -cl ear
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open_design

The open_design command specifies a netlist file (.srs or .srm) that can be used
to search the database with the Tcl find command in batch mode. With
open_design, you can use find without having to open an RTL or Technology
view. Use open_design to read in the .srs or .srm file before issuing the find
command. See the example below.

Syntax
open_design filename

Where:

¢ filename is the RTL (.srs) or Technology (.srm) file that can be used to
search the database. The specified netlist is loaded on-demand to
minimize memory resources.

Example

project -load ../exanpl es/vhdl/prep2_2.prj
open_desi gn prep2_2.srs

set a [find -inst *]

c_print $a -file a.txt

open_desi gn prep2_2.srm

set b [find -net *]

c_print $b -file b.txt

In the example above, prep2_2 is loaded and the information from the RTL
view file is read in. Then, the find command searches for all instances in the
design and prints them to file a. Next, the technology view file is read in, then
find searches for all nets in the design and prints them to file b.

See Also
¢ find, on page 149.
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open_file
The open_file command opens views within the tool. The command accepts
two arguments: -rtl_view and -technology_view.
Syntax
open_file -rtl_view [-technology_view

The -rtl_view option displays the RTL view for the current implementation, and
the -technology view option displays the technology view for the current imple-
mentation. Views remain displayed until overwritten and multiple views can
be displayed.

Synplify Pro for Microchip Edition Command Reference © 2021 Synopsys, Inc.
June 2021 Synopsys Confidential Information 81



Tcl Synthesis Commands

partdata

The partdata command loads part files and returns information regarding a
part such as available families, family parts, vendors, attributes, grades,
packages.

Syntax

partdata
-load filename
-family
-part family
-vendor family
-attribute attribute family
-grade [family:]part
-package [family:]part
-oem [family:]part

Option Description

-load filename Loads part file.

-family Lists available technology families.

-part family Lists all parts in specified family.

-vendor family Returns vendor name for the specified family.
-attribute attribute Returns the value of the job attribute for the specified
family family.

-grade [family:]part Lists the speed grades available for the specified part.

-package [family:]Jpart  Lists the packages available for the specified part.

-oem [family:]part Returns true if the part entered is an OEM part.

Example

The following example prints out the available vendors, their supported
families, and the parts for each family.
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% foreach vendor [partdata -vendorli st]

% puts VENDOR $vendor ;

%foreach fanily [partdata -fanily $vendor]
%puts \t FAMLY: $fam | y;

% puts \t\t PARTS: ;

% foreach part [partdata -part $famly]
%puts \t\t$part;

program_terminate

Immediately terminates the tool session without prompting or saving any
data.

Syntax

program_terminate

Arguments and Options

None

Description

The program_terminate command terminates a tool session without prompting
or saving data. Use this command with caution as any unsaved data is lost
and cannot be recovered.

Examples

programterm nate
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program_version

Returns the product and software release version.

Syntax

program_version

Arguments and Options

None

Description

The program_version command returns the software product version number.

Examples

% pr ogr am ver si on
Synplify Pro L-2017.09
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project

The project command runs job flows to create, load, save, and close projects,
to change and examine project status, and to archive projects.

Syntax

project -run [-all] [-bg] implementationList [-impl implementationName]
[-clean] implementationList [-impl implementationName]

[-parallel] implementationList [-impl implementationName]

[-from proccessName] [-to processName]

project {-new [projectPath] |-load projectPath | -close [projectPath]
|-save [projectPath] |-insert projectPath} |

project {-active [projectName] |-dir |-file |-name [-list |-filelist |
-fileorder filepathl filepath2 [... filepathN] |-addfile filepath |
-movefile filepathl [filepath2] |-removefile filepath}

project {-result_file resultFilePath |-log_file [logfileName]
project -propagate_params

project -copy [-project filename] [-implement implementationName]
[-dest_dir pathname] [-copy_type {full | local | customize}]
[-add_srs [fileList] -no_input]

project -unarchive [-archive_file pathname/filename] [-dest_dir pathname]

run option

The run option lets you synthesize selected implementations of a Project file.
You can choose to use the arguments for the run option independently or in
any combination. The arguments available are described in the table below.

You can also use the Batch Run Setup dialog box to set the arguments to use
with the run option. For details, see Run Implementations Setup Command, on
page 392.

Option Description
-run [-all] [-bg] [-clean] Synthesizes the project, according to the specified
[-from] [-parallel] [-to] options:
[processName]
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Option Description

You can use run with any of the following arguments:
« -all - Runs all implementations of the active project.

e -bg - Runs specified implementations in
non-blocking background mode. This is the default.

e -clean - Runs specified implementations, while
ignoring up-to-date checking. This option cleans all
previous results and forces a complete rerun.

» -parallel - Runs specified implementations
concurrently. Additional licenses are required for
each job.

e -from - Runs from and including the specified
process name.

e -t0 - Runs up to and including the specified process
name.

» processName - Specifies the process name.
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Option Description

The mode can be one of the following keywords:

e compile - Compiles the active project, but does not
map it.

constraint_check - Validates the syntax and
applicability of constraints defined in one or more
constraint files.

fsm_explorer - Selects optimum FSM-encoding style
for finite-state machines.

netlist_optimizer - Runs netlist optimization.

syntax_check - Verifies that the HDL is syntactically
correct; errors are reported in the log file.

synthesis - Default mode if no mode is specified.
Compiles (if necessary) and synthesizes the
currently active project. If followed by the -clean
option (project -run synthesis -clean), resynthesizes the
entire project, including the top level and all compile
points, whether or not their constraints,
implementation options or source code changed
since the last synthesis. If not followed by -clean,
only compile points that have been modified are
resynthesized.

< synthesis_check - Verifies that the design is
functionally correct; errors are reported in the log
file.

e timing - Runs the Timing Analyst. This is equivalent
to clicking the Generate Timing button in the Timing
Report Generation dialog box with user-specified
values.

e write_netlist - Writes the mapped output netlist to
structural Verilog (vi) or VHDL (vhn) format. You
can also use this command in an incremental
timing analysis flow. For details, see Run Menu , on
page 388 and Generating Custom Timing Reports
with STA , on page 366.

The following table describes the rest of the Project file command options.

Option Description
-load projectPath Opens and loads the project file specified by
projectPath.
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Option

-close [projectPath]

-save [projectPath]

-insert projectPath

-active [projectName]

-dir

file

-name

-list

filelist

-fileorder filepathl
filepath2 [... filepathN]
-addfile filepath

-movefile filepathl
[filepath2]

-removefile filepath

-result_file resultFilePath

-log_file [logfileName]

Description

Closes the currently active project. If projectPath is
specified, closes the specified project.

Saves the currently active project. If projectPath is
specified, saves the specified project.

Adds the specified project to the workspace project.

Shows the active project. If projectName is specified,
makes the specified project the active project.

Shows the project directory for the active project.
Returns the path to the active project.

Returns the filename (prj) of the active project.
Returns a list of the loaded projects.

Returns the pathnames of the files in the active
project.

Reorders files by adding the specified files to the end
of the project file list.

Adds the specified file to the project.

Moves filepathl to follow filepath2 in project file list. If
filepath2 is not specified, moves filepathl to top of list.

Removes the specified file from the project.

Changes the name of the synthesis result file to the
path specified.

Reports the name of the project log file. If logfileName
is specified, changes the base name of the log file.
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Option Description
-archive e project filename - copies a project other than the
-project filename active project. If you do not use this option, by

default the active project is copied.

-root_dir pathname
[ —air p ] < root_dir pathname - specifies the top-level directory

_afrifr:jvg_ﬁler containing the project files.
ename.sa - archive_file filename - is the name of the archived
-archive_type project file.

{full | local | customize}
-add_srs [fileList]
-no_input

e archive_type - specifies the type of archive:

« full - performs a complete archive; all input and
result files are contained in the archive file.

< customize - performs a partial archive; only the
project files that you select are included in the
archive.

« local - includes only project input files in the
archive; does not include result files.

e add_srs - adds the listed sr s files to the archived
project. Use the -no_input option with this command.
If fileList is omitted, adds all srs files for the
project/implementations. The srs files are the RTL
schematic views that are output when the design is
compiled (Run->Compile Only).

For more information about, and examples of the

project -archive command, see Archive Utility , on

page 91.
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Option Description
-copy
-project filename  project filename - copies a project other than the
-implement active project. If you do not use this option, by
implementationName default the active project is copied.
) . < implement implementation_name - archives all files in
_(ig;ty_twpp:thname the specified implementation.

« dest_dir directory_pathname - specifies the directory
in which to copy the project files.

e copy_type - specifies the type of file/project copy:

« full - performs a complete copy; all input and
result files are contained in the archive file.

e customize - performs a partial copy; only the
project files that you select are included in the
archive.

e local - includes only project input files in the copy;
does not include result files.

e add_srs - adds the listed sr s files to the archived
project. Use the -no_input option with this command.
If fileList is omitted, adds all sr s files for the
project/implementations. The srs files are the RTL
schematic views that are output when the design is
compiled (Run->Compile Only).

For more information about, and examples of the
project -copy command, see Archive Utility , on page 91.

{full | local | customize}

-add_srs [fileList]
-no_input

-unarchive < archive_file pathname/filename - is the name of the
-archive file archived project file.

pathname/filename - dest_dir pathname - specifies the directory in which
to write the project files.

For more information about, and examples of the
project -unarchive command, see Archive Utility , on
page 91.

-dest_dir pathname

project Command Examples

Load the project top.prj and compile the design without mapping it. Compiling
makes it possible to create a constraint file with the SCOPE spreadsheet and
display an RTL schematic representation of the design.

% project -l1oad top.prj
% project -run conpile
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Load a project and synthesize the design.

% project -load top.prj
% project -run synthesis

In the example above, you can also use the command project -run, since the
default is synthesis.

Archive Utility

The archive utility provides a way to archive, extract, or copy your design
projects. An archive file is in Synopsys proprietary format and is saved to a
file name using the .sar extension. You can also use this utility to submit your
design along with a request for technical support.

The archive utility is available through the Project menu in the GUI or through
the project Tcl command. See the following for details:

For information about ... See ...

Archiving, un-archiving, or  Archiving Files and Projects , on page 105 in the
copying projects User Guide

Project Archive Examples

The following example archives all files in the project and stores the files in
the specified .sar file:

project -archive -project c:/projl. prj
-archive file c:/archivel/projl. sar

The next example archives the project file (.prj) and all local input files into the
specified .sar file.

project -archive -project c:/projl.prj -archive_type |ocal
-archive_file c:/archivel/proj1. sar

The following example archives the project file (.prj) only for selected .srs files
into the specified sar file. Any input source files that are in the project are not
included.

project -archive -project c:/projl.prj -archive_type custom ze
-add_srs -no_input -archive file c:/archivel/projl.sar
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Project Unarchive Example

The following example extracts the project files from c:/archive/projl.sar to direc-
tory c:/projl. All directories and sub-directories are created if they do not
already exist.

proj ect -unarchive -archive_file c:/archive/projl.sar
-dest _dir c:/projl

Project Copy Examples
The following example copies only selected .srs files for the project to the desti-
nation project file directory.

project -copy -project d:/test/proj_2.prj -copy_type custom ze
—add_srs -no_input -dest dir d:/test 1

The next example copies all input source files and .srs files selected for the
project to the destination project file directory.

project -copy -project d:/test/proj_ 2.prj -copy_type custom ze
-dest _dir d:/test_1
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project data
The project_data command shows or sets properties of a project.
Syntax

project_data {-active [projectName] | -dir | -file}

The following table describes the command options.

Option Description

-active Set/show active project. With no argument, shows the active
project. If projectName is specified, changes the active project to
projectName.

-dir Show directory of active project.

-file Show the project file for the active project. The full path is included

with the file name.
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project_file

The project_file command manipulates and examines project files.

Syntax

project_file {-lib fileName [libName ] | -name fileName [newPath ] |

-time fileName [format ] | -date fileName | -type fileName |

-savetype fileName [relative | absolute ] -move fileNamel [fileName2] |
-remove fileName | -top topModule |

-tooltag applicationTagName | -toolargs [arguments ] fileName }

The following table describes the command options.

Option Description

-lib Shows the project file library associated with fileName. If libName is
specified, changes the project file library for the specified file to
libName.

-name Shows the project file path for the specified file. If newPath is
specified, changes tlhe location of the specified project file to the
directory path specified by newPath.

-time Shows the file time stamp. If a format is specified, changes the
composition of the time stamp according to the combination of the
following time formatting codes:

%H (hour 00-23)

%M (minute 00-59)

%S (second 00-59)

%d (day 01-31)

%b (abbreviated month)
%Y (year with century)

-date Shows the file date.

-type Shows the file type.

-savetype Sets or shows whether a file is saved relative to the project or its
absolute path.

-move Positions fileNamel after fleName2 in HDL file list. If fleName2 is not
specified, moves fileNamel to the top of the list.

-remove Removes the specified file from the project file list.
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Option Description

-top Sets or shows the top-level module of the specified file for the active
implementation.

-tooltag Sets or shows the third-party tool tag for the specified file.

-toolargs ?Iets or shows the third-party tool tag arguments for the specified
ile.

Examples

List the files added to a project. Remove a file.

%project -filelist path _nanel/cpu.v path_nanmel/cpu cntrl.v
pat h_nane2/ cpu_cntrl . vhd

%project file -remove path_nane2/cpu_cntrl.vhd
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project_folder

The project_folder command manipulates and examines attributes for project
folders.

Syntax

project_folder [folderName] [-folderlist] [-filelist] [-printout] [-add] [-remove] [-r]
[-tooltag] [-toolargs]

The following table describes the command options.

Option Description

folderName Specifies the name of the folder for which attributes are
examined.

-folderlist Lists folders contained in the specified project folder.

filelist Lists files contained in the specified project folder.

-printout Prints the specified project folder hierarchy including its files.

-add Adds a new project folder.

-remove Removes the specified project folder.

-r Removes the specified project folder and all its containing
sub-folders. Files are removed from the project folder, but are
not deleted.

-tooltag Sets or shows the third-party tool tag name.

-toolargs S}ets or shows the additional arguments for the third-party tool

ag.

Examples

Add a folder and list the files added to a project folder.
% proj ect _fol der -add newf ol der

% project_folder -filelist new ol der
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guery_available _metrics

Shows metrics that can be queried for the design. If specified, only metrics
matching the required values are shown. Otherwise, shows all metrics for all
tables. You should use the query_available_metrics command primarily for
scripting, since it returns a Tcl list. For a more readable format, use the
dump_metrics command.

Syntax
guery_available_metrics [[table.Jname]

[table.Jname
Name of the metric to query, optionally preceded by 'table.’.

For details about specifying metrics, see the Naming Conventions for Metrics,
on page 52.

Examples

This command returns values in a list of the form as follows:
{{namel objectl jobnamel} {name2 object2 jobname2}...}

1. Show a Tcl list of metrics that can be queried for the current
implementation:

% query_avai |l abl e_metrics

Format is {{nanel objectl jobnamel} {nanme2 object2 jobnane2}...}:

{cl ock_conversion.icg_renoved {} premap} {cl ock_conversion.icg_retained {}
premap} {cl ock_conversion.clean_clock_trees {} fpga_nmapper}

{cl ock_conversi on. cl ean_cl ock_pi ns {} fpga_mapper}

{cl ock_conversion. gated _clock _trees {} fpga napper}

{cl ock_conversi on. gat ed_cl ock_pi ns {} fpga_mapper}

{cl ock_conversion. instances_converted {} fpga_nmapper}

{cl ock_conversi on. i nst ances_not converted {} fpga_mapper}

{hdl _conpile.nodified files {} conpiler} {hdl _conpile.nodified nodul es {}
conpi l er} {hdl _conpile.total _rodul es {} conpiler} {hdl _conpile.total _files
{} conpiler} {msc.Part {} fpga_napper} {runtine.realtime {} conpiler}
{runtine.cputime {} conpiler} {runtinme.realtine {} premap}
{runtine.cputime {} premap} {runtine.realtinme {} fpga_mapper}
{runtine.cputime {} fpga_mapper} {{tining. Wrst S ack} {} fpga_mapper}
{utilization.LUT1 {} fpga_nmapper} {utilization.LUT2 {} fpga_napper}
{utilization.LUT3 {} fpga mapper} {utilization.LUT4 {} fpga_mapper}
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{utilization.LUT5 {} fpga_napper} {utilization.LUT6 {} fpga_napper}
{utilization.|BUF {} fpga_mapper} {utilization.|BUG {} fpga_napper}

{utilization.| BUF {

} fpga_mapper} {{utilization.1/O primtives}

{}

fpga_napper} {utilization.BUFG {} fpga_napper} {{utilization.|/O Register

bits} {} fpga_mapper} {{utilization. Total

% foreach ant [query_avail able_metrics] {set netric
set object [lindex $anmt 1];
set job [lindex $am 2]; puts "$netric $object:

[lindex $ant 0O];

Luts} {} fpga_napper}
2. Use a simple loop to show the values of all available metrics:

[query_netric $nmetric -object $object -jobnane $job]"}

Format is {{nanel objectl jobnamel} {name2 object2 jobname2} ...

cl ock_conversi on.
cl ock_conver si on.
cl ock_conversi on.
cl ock_conver si on.
cl ock_conversi on.
cl ock_conver si on.
cl ock_conversi on.
cl ock_conver si on.

icg_renoved : O
icg_retained : O
clean_clock trees : 1
clean_clock_pins : 270
gated clock trees : 0O
gated clock_pins : 0

i nstances_converted : 0

i nst ances_not converted : 0

hdl _conpile.nodified files : 28
hdl _conpi | e. modi fi ed_nodul es : 11

hdl _conpil e. total
hdl _conpi | e. tot al

_modules ;11
_files : 28

msc.Part : xc7vx485tffglls7-1

runtine.realtine :
runtime. cputine :

9. 881000
9. 828063

timng. Wrst S ack - 0. 445800

utilization. LUT1

utilization.LUT2 :
utilization. LUT3 :
utilization.LUT4 :
utilization. LUT5 :
utilization.LUT6 :
utilization.|BUF :

31
64
45
84
57
160
1

utilization.IBLFG 1

utilization.l GBUF :

24

utilization. I/Oprinmtives : 26

utilization. BUFG :

1

utilization.l/O Register bits : 0

utilization. Total

3. Show a Tcl list of metrics for the specified metric name:

Luts : 411

% query_avail abl e_netrics cputine

Format is {{nanel objectl jobnamel} {nane2 object2 jobname2} ...

{runtine.cputinme {} conpiler} {runtine.cputinme {} premap} {runtine.cputine

{} fpga_mapper}
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4. Optionally, show a Tcl list of metrics for the specified table value:

% query_avail abl e_metrics runtine.cputime

Format is {{nanel objectl jobnamel} {name2 object2 jobnane2} ...}:

{runtine.cputime {} conpiler} {runtine.cputine {} premap} {runtime.cputine
{} fpga_mapper}

5. Enclose within curly braces { } whenever metrics contain spaces.
% query_avail abl e_metrics {tim ng.worst slack}

Format is {{nanel objectl jobnamel} {nane2 object2 jobname2} ...}:

{{timng. Wrst Sl ack} {} fpga_mapper}

See Also

See the related query commands below:
* dump_metrics, on page 50
* query_metric, on page 100

* query_metric_details, on page 102
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guery_metric

Queries specific QoR metrics for the current implementation of a design.

Syntax
guery_metric table.name [-object value] [-jobname value]

table.name
Name of the metric to query, preceded by ‘'table.’.

-object value
Queries metrics associated with a specific object or global metrics if not
specified.

-jobName value
Queries metrics associated with a specific job name or any job name if
not specified.

For details about specifying metrics, see the Naming Conventions for Metrics,
on page 52.

Examples
Here are examples of how to query metrics for a design:

% query_mnetric cl ock_conversion.icg_renoved
0

% query_mnetric cl ock_conversion.instances_converted -j obnare
f pga_mapper

1

% query_netric runtime.realtine -jobnamre conpiler

3. 15400

% query_netric {timng.worst slack} -jobname fpga_napper
- 0. 445800

% query_netric {utilization.total |uts}

411

Suppose you have a design with compile points.
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dunp_netrics -show queries
dﬁéry_rret ric {timng. Wrst S ack} -object r2p_cordic -jobname fpga_napper

Then you can query worst slack for one of the compile points.

%query_netric {timng.Wrst Sl ack} -object r2p_cordic
-j obnane fpga_napper

-1.339500 ns {Estimated slack during conpile point synthesis}

See Also

See the related query commands below:
* dump_metrics, on page 50
* query_available _metrics, on page 97

* query_metric_details, on page 102
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guery_metric_details

Queries information about a QoR metric from the current implementation.
Exactly one metric must match.

Syntax

guery_metric table.name [-object value] [-jobname value]

table.name
Name of the metric to query, preceded by ‘'table.'.

-object value
Queries metrics associated with a specific object or a global metric if not
specified.

-jobName value
Queries metrics associated with a specific job name or any job name if
not specified.

For details about specifying metrics, see the Naming Conventions for Metrics,
on page 52.

Examples
The Tcl command returns a list of three values: <value> <units> <comment>.

% query_metric_details clock _conversion. cl ean_cl ock_pi ns

270 {} {Nunber of clock pins driven by non-gated/ non-generated cl ock
trees}

% query_netric_details clock conversion.icg_renoved

0 {} {Nunmber of 1GG|atches renoved}

% query _netric_details runtinme.realtine -jobnanme conpiler

3. 154000 seconds {}

% query _netric_details runtime.cputine -jobnanme fpga_ napper

9. 828063 seconds {}

% query _netric_details {timng.worst slack} -jobname fpga_ napper
-0. 445800 ns {}

% query netric_details utilization.lutl
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31 {} {}
Suppose you have a design with compile points.

dunp_netrics -show queries
dﬁéry_mat ric {timng. Wrst Sl ack} -object r2p_cordic -jobnare fpga_mapper

Then you can query worst slack for one of the compile points.

% query netric details {timng. Wrst Sl ack} -object r2p cordic
- j obname f pga_napper

-1. 339500 ns {Estimated sl ack during conpile point synthesis}

See Also

See the related query commands below:
* dump_metrics, on page 50
* query available_metrics, on page 97

* query_metric, on page 100
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recording

Allows you to record and store the Tcl commands generated when you work
on your projects in the GUI. You can use this command for creating job
scripts. The complete syntax for the recording command is:

recording
-on|-off
-file [historyLogFile]
-save [historyLogFile]
-State
-edit [filename]

In the command line:

¢ -on|off- turns Tcl command recording on or off. Recording mode is off by
default.

¢ -ile - if you specify a history log file name, this option uses the specified
file in which to store the recorded Tcl commands for the current session.
If you do not specify a history log name, reports the name of the current
history log file.

¢ -save - if you do not specify a file name, updates the current history log.
If you specify a history log file name, saves Tcl command history to the
specified file.

e -state - returns the Boolean value of recording mode.

¢ -edit - displays the Tcl command log file in a text editor.

Examples

Turn on recording mode and save the Tcl commands in the cpu_tcl log file
created.

% recordi ng -on
%recording -file cpu_tcl _|og
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report_clocks

Reports the clocks in the design database.

Syntax

report_clocks -netlist [srsNetlistFile] [-csv_format] [-out fileName]

Arguments and Options

srsNetlistFile
The name of the srs netlist file. If this optional argument is not specified,
the netlist file is taken from the active project implementation.

-csv_format
Displays the report in spread-sheet format.

-out
Specifies the name of the output report file (default name is design-
Name_clk.rpt).

Description

The report_clocks command generates a report of the clocks found in the
design database. The report includes a listing of the clock domain, parent
clock, and clock type for each clock. If the -csv_format option is included, the
report is output in spread-sheet format.

Examples

report _clocks c:/designs/nemctrl/memctrl.srs -csv_format
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report_messages

Queries messages from jobs based on ID or severity. This can be used to
show duplicate messages that were suppressed in the log files.

Syntax

report_messages logFile [-id value] [-severity value] [-out value] [-outa value]

logFile
Specifies one or more log files to query for message details.

-id value
Restricts report to messages matching this id. Use the * or % wildcard to
match any string.

-severity value
Limits messages to a specific severity. Can specify one or more messages
as an error, warning, note, or advice. Multiple severities can be specified.
If none is specified, all types are shown.

-out value
Name of the output file to be written rather than writing to the Tcl
window.

-outa value
Name of the output file to be appended rather than writing to the Tcl
window.

Output Format

Running the report_ messages command produces a list of messages. Messages
are displayed in the following format with each message beginning on a new
line:

ID {messageText}
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Examples
1. Query BN132 messages from the test.str log file.
report _nessages test.srr -id BNL32
2. Query error and warning messages from the test.srr log file.
report_nessages test.srr -severity error warning

3. Query critical warnings (CW) or downgradable errors (DE). You can
search for these messages using wildcards. For example:

report_nessages test.srr -id DE*

4. Query error and warning messages from the test.srr log file. and writes
output to a file called messages in the current working directory.

report_nessages test.srr -severity not warning -out nessages
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report_message_summary

Retrieves a summary of the messages in the log file. This summary contains a
list of the message IDs and the number of occurrences for each type, along
with their message descriptions.

Syntax
report_message _summary logFile

logFile
Specifies a log file to query for the message summary.

Examples

report_nessage_sunnary test.srr
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run_tcl

The run_tcl command lets you synthesize your project using a Tcl script file
from the Tcl Script window of the synthesis tool.
Syntax
run_tcl [ -fg ] tclFile
You can also use the following command:
source tclFile
These commands are equivalent.

The following table describes the run_tcl command options.

Option Description

-fg Synthesizes the project in foreground mode.
TclFile Specifies the name of the Tcl file used to synthesize the project. To
create a Tcl Script file, see Creating a Tcl Synthesis Script , on
page 515.
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select

Selects specified objects.

Syntax

select collection
-append
-clear
-instances

The following table describes the select command options.

Option Option
-append Appends objects to the existing
selection list.
-clear Clears the selection list.
-instances Selects all instances in the current
view.
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sdc2fdc

Translates legacy FPGA timing constraints to Synopsys FPGA timing
constraints.

Syntax
sdc2fdc

Run it from the Tcl window in the synthesis tool.

See also
* Converting SDC to FDC, on page 164 in the User Guide

¢ sdc2fdc Conversion, on page 133 in the Reference Manual

Examples of sdc2fdc Translation

The following are examples of feedback after running the command. For
information about the translated FDC file and handling the error messages,
see sdc2fdc Conversion, on page 133 in the Reference Manual.

% sdc2f dc

INFQ Transl ation successful.

See: "D/ bugs/timng_88/clk _prior/scratch/ FDC constraints/rev_2
/top_transl ated. fdc"

Repl ace your current *.sdc files with this one.

I NFO Automatically updating your project to reflect the new
constraint file(s)
Do "Qrl+S' to save the new settings.

% sdc2f dc

ERROR Bad -fromlist for define false path: {ny_inst}

Mssing qualifier(s) (i: p: n: ...)

ERRCOR Transl ati on probl ens V\ere found

See: "D/ bugs/timng_88/clk _prior/scratch/ FDC constraints/rev_2
/top_translate.log" for details.

_translate.log

ERROR Bad -fromlist for define false path {ny_inst}
Mssing qualifier(s) (i: p: n: ...)
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"define_false path -from{ny_inst} -to i:abc.def.g_reg
-through {n:bar}"

Synplicity SDC source file: D /bugs/timng 88/clk prior/scratch
[t op. sdc.

Li ne nunber: 79
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set_option

The set_option command sets options for the technology (device) as well as for
the design project.

Syntax
set_option -optionName optionValue

For syntax and descriptions of the options and related values, see one of the
following tables:

* Device Options for set_option/get_option

* Project Options for set_option/get_option

Device Options for set_option/get_option

The following table lists generic device arguments for the technology, part,
and speed grade. These are the options on the Implementation Options-> Device
tab.

Information on all other Implementation Options tabs are listed in the next
section, Project Options for set_option/get_option, on page 114.

Option Name Description

-technology parameter Sets the target technology for the implementation.
parameter is the string for the vendor architecture.
Check the Device panel in the GUI or see Device Panel ,
on page 353, for a list of supported families.

-part part_name Specifies a part for the implementation. Check the
Device panel of the Implementation Options dialog box (see
Device Panel , on page 353) for available choices.

-speed_grade -value Sets the speed grade for the implementation. Check the
Device panel of the Implementation Options dialog box (see
Device Panel , on page 353) for available choices.
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Option Name

-package value

Description

Sets the package for the implementation. This option is

not available for certain vendor families, because it is
set in the place-and-route software. Check the Device
panel of the Implementation Options dialog box (see Device
Panel , on page 353) for available choices.

-grade -value

Same as -speed_grade. Included for backwards

compatibility.

In general, device options are technology-specific, or have technology-specific
defaults or limitations. For vendor-specific details, see synhooks File Syntax,

on page 527.

Project Options for set_option/get_option

Below is a list of options for the set_option and get_option commands. click the
option below for the corresponding description and GUI equivalents. Options
set through the Device tab are listed in Device Options for set_option/get_op-

tion, on page 113.

advanced_uram_features_on
analysis_constraint
area_delay_percent
automatic_compile_point
beta_vfeatures
compiler_compatible
constraint
default_enum_encoding
dup

fanout_limit

frequency auto
globalthreshold
hdl_define
identify_debug_mode

© 2021 Synopsys, Inc.

allow_duplicate_modules
areadelay
auto_constrain_io
autosm

block
compiler_constraint
continue_on_error
disable_io_insertion
enable64bit
force_gsr

frequency
hdl_param

help

ignore_undefined_libs
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include_path

libext

log_file

maxfan
min_cdc_sync_flops
no_sequential_opt
num_startend_points
project_relative_includes
report_path
reporting_reportType
resource_sharing
retiming
rw_check_on_ram
supporttypedflt
synthesis_onoff_pragma
update_models_cp
vlog_std

write_verilog

Synplify Pro for Microchip Edition Command Reference
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job (PR)

library_path

looplimit
max_parallel_jobs
multi_file_compilation_unit
num_critical_paths
opcond
preserve_registers
report_preserve_cdc
resolve_multiple_driver
result_file
run_prop_extract
safe_case
symbolic_fsm_compiler
top_module
use_fsm_explorer
write_apr_constraint

write_vhdl
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Option

-advanced_uram_features_on

-allow_duplicate_modules

-analysis_constraint
path/filename.adc

-areadelay percentValue

-area_delay_percent
percentValue

-automatic_compile_point

1/0

-autosm 1|0

-symbolic_fsm_compiler

1j0

-beta_vfeatures 1|0

© 2021 Synopsys, Inc.
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Description

Enables advanced URAM
packing. By default, this option
is enabled.

For Verilog designs, allows the
use of duplicate module names.
When true, the last definition of
the module is used by the
software and any previous
definitions are ignored.

You should not use duplicate
module names in your Verilog
design, therefore, this option is
disabled by default. However, if
you need to, you can allow for
duplicate modules by setting this
option to 1.

Specifies the analysis design
constraint file (.adc) you can use
to modify constraints for the

stand-alone Timing Analyst only.

Sets the percentage of paths you
want optimized. This option is
available only in certain device
technologies.

Enables/disables the automatic
compile point flow, which can
analyze a design and identify
modules that can automatically
be defined as compile points and
mapped in parallel using
Multiprocessing.

Enables/disables the FSM
compiler.

Enables/disables the use of
Verilog compiler beta features.

GUI Equivalent

Allow Duplicate
Modules

Constraint File
section on the
Timing Report
Generation
Parameters
dialog box

Percent of design to
optimize for timing,
Device Panel

Automatic compile
point check box,
Options Panel

FSM Compiler
check box,
Options Panel

Beta Features for
Verilog, Verilog
Panel
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Option Description GUI Equivalent
-block 1|0 Enables/disables 1/0 insertion  Disable I/O Insertion
in some technologies. cheqk box,
-disable_jo_insertion 1/0 Device Panel
-compiler_compatible Disables pushing of tristates Complement of
1|0 across process/block the Push Tristates
boundaries. Across Process/

Block Boundaries
check box, VHDL
Panel and Verilog

Panel
-compiler_constraint When multiple constraint files Constraints Files,
constraintFile are defined, specify which Constraints

constraint files are to be used Panel
from the Constraints tab of the
Implementation Options panel.

-constraint -option Manipulates constraint files in  Constraint Files,
the project: Constraints

-enable/disable filename - adds or ~ Panel
removes constraint file from

active implementation

-list - lists all enabled constraint

files in active implementation

-all - enables all constraint files in

active implementation

-clear - disables all constraint files

in active implementation

-continue_on_error 1|0 The continue_on_error option Continue on Error,
serves two related, but separate Project View
functions. checkbox or

Mapper - When enabled during ~ Options Panel, or
compile-point synthesis, allows Configure

the mapping operation to Parallel or

continue on error and synthesize Compile Point

the remaining compile points. Process
Command

The default for this option (0) is
to stop on any compilation or
synthesis error.
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Option

-default_enum_encoding
defaultjonehot|gray|
sequential

-disable_io_insertion 1J0

-block 1|0

-dup

-enable64bit 1|0

-fanout_limit value

-maxfan value

-frequency value

© 2021 Synopsys, Inc.
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Description

(VHDL only) Sets the default for
enumerated types.

Enables/disables I/0 insertion
in some technologies.

For more information about the
impact of using this command,
see syn_insert_pad , on

page 107.

For Verilog designs, allows the
use of duplicate module names.
When true, the last definition of
the module is used by the
software and any previous
definitions are ignored.

You should not use duplicate
module names in your Verilog
design, therefore, this option is
disabled by default. However, if
you need to, you can allow for
duplicate modules by setting this
option to 1.

Recommended to use
-allow_duplicate_modules
option instead of -dup option.

Enables/disables the 64-bit
mapping switch. When enabled,
this switch allows you to run
client programs in 64-bit mode, if
available on your system.

Sets the fanout limit guideline for
the current project.

Sets the global frequency.

GUI Equivalent

Default Enum
Encoding, VHDL
panel (see VHDL
Panel and Verilog
Panel)

Disable I/O
Insertion, Device
Panel

Allow Duplicate
Modules, Verilog
Panel

Enable 64-bit
Synthesis, Options
Panel

Fanout Guide,
Device Panel

Frequency,
Constraints
Panel
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Option Description GUI Equivalent
-frequency auto Enables/disables auto Auto Constrain,
constraints. Constraints
Panel
-hdl_define For Verilog designs; used for Compiler
extracting design parameters Directives and
and entering compiler directives. Design
Parameters,

Verilog Panel

-hdl_param Shows or sets HDL parameter Use this
overrides. See hdl_param , on command in the
page 68 for command syntax. Tcl window of the

Ul.

-help This option is useful for getting  Use this

syntax help on the various command in the

implementation options used for Tcl window of the
compiling and mapping a design. Ul.

For examples, see help for

set_option , on page 130.

-identify_debug_mode 1|0 When set option is 1, creates an Select the
Identify implementation in the Identify
Project view. Then, you can implementation,
launch the Identify Instrumentor then launch:
or Debugger from within the « Launch Identify
FPGA synthesis tools. Instrumentor
or
» Launch Identify
Debugger
-ignore_undefined_libs (VHDL only) When enabled Not available in
10 (default), the compiler will ignore the Ul

any declared library files not
included with the source file. In
previous releases, the missing
library file would cause the
synthesis tool to error out.

To set this option to error out
when a library file is missing (as
in previous releases), use 0O for
the command value.
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Option
-include_path path

Jextra_input/

-job PR_job_name

-option enable_run 1|0

-libext
JibextNamel .libextName2 ...

© 2021 Synopsys, Inc.

Description

(Verilog only) Defines the search
path used by the ‘include
commands in Verilog design files.
Argument path is a string that is
a semicolon-delimited list of
directories where the included
design files can be found. The
software searches for include
files in the following order:

e First, the source file directory.

e Then, looks in the included
path directory order and stops
at the first occurrence of the
included file it finds.

e Finally, the project directory.

The include paths are relative.
Use the project_relative_includes
option to update older project
files.

The archive utility allows you to
add the extra_input directory path
for all include files and copies
them to your project. Use the Add
extra input path to project option on
the Un-Archive Utility dialog box.

If enabled, runs the specified
place-and-route job with the
appropriate vendor-specific
place-and-route tool after
synthesis.

Adds library extensions to
Verilog library files included in
your design for the project and
searches the directory paths you
specified that contain these
Verilog library files. To use
library extensions, see Using
Library Extensions for Verilog
Library Files , on page 45 in the
User Guide.

GUI Equivalent

Include Path Order,
Verilog panel (see
Verilog Panel)

Specify the
place-and-route
job you want to
run for the
specified
implementation.
See Place and
Route Panel.

Library Extensions
(space separated)
for each unique
file extension,
Verilog Panel.
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Option Description GUI Equivalent
-library_path For Verilog designs, specifies the Library Directories
directory_pathname paths to the directories which on Verilog Panel.

contain the library files to be
included in your design for the
project. Defines the search path
used by the tool to include all the
Verilog design files for your
project. The argument
directory_pathname is a string that
specifies the directories where
these included library files can
be found. The software searches
for all included Verilog files and
the tool determines the top-level
module. The names of files read
from the library path must
match module names.
Mismatches result in error

messages.
-log_file logFileName Allows you to change the name  Enter command

for the default log file. For from the Tcl

example: window

set _option -log file test

generates the

synl og\t est _f pga_mapper. srr
file in the Implementation
Directory after synthesis is run.

looplimit loopLimitValue Allows you to override the default Loop Limit, Verilog
compiler loop limit value of 2000 Panel and VHDL
in the HDL. You can also apply Panel.
loop limits using the Verilog
loop_limit or the VHDL syn_looplimit
directive.

For details about these
directives, see loop_limit , on
page 47 and syn_looplimit , on
page 121 in the Attribute

Reference.
-maxfan value Sets the fanout limit for the Fanout Guide,
current project. The limit value is Device Panel
-fanout_guide value a guideline for the tool rather

than a hard limit.
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Option Description GUI Equivalent

max_parallel_jobs n Lets you run multiprocessing Maximum number of
with compile points. This allows parallel mapper
the synthesis software to run jobs, on the
multiple, independent compile Configure Compile
point jobs simultaneously, Point Process
providing additional runtime dialog box.

improvements for the compile
point synthesis flow.

For information on setting the
maximum number of parallel
synthesis jobs, see Setting
Number of Parallel Jobs , on
page 513 in the User Guide.

-min_cdc_sync_flops {2} Controls the minimum number
of synchronizer flops to be
detected and reported. By
default, the option is 2. Setting
the value lesser than 2
generates a warning.

See CDC Reporting, on page 377
in the Reference Manual.

-multi_file_compilation_unit When you enable the Multiple File Verilog Panel
10 Compilation Unit switch, the Verilog
compiler uses the compilation
unit for modules defined in
multiple files.

-no_sequential_opt 1|0 Enables or disables the Device Panel
sequential optimizations for the
design. (Note that unused
registers will still be removed
from the design.) The default
value is false (sequential
optimizations are performed).
When true, delay and area size
might increase. Value can be 1 or
true, O or false.

With this option enabled, the

FSM Compiler and FSM Explorer
options are effectively disabled.

-num_critical_paths value Specifies the number of critical  Number of Critical
paths to report in the timing Paths, Timing
report. Report Panel
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Option

-num_startend_points value

-opcond value

-preserve_registers 1|0

-project_relative_includes 1|0

-report_path integer

Description

Specifies the number of start and
end points to include when
reporting paths with the worst
slack in the timing report.

Microchip

Sets the operating condition for
device performance in the areas
of optimization, timing analysis,
and timing reports. Values are
Default, MIL-WC, IND-WC,
COM-WC, and Automotive-WC.
See Operating Condition Device
Option , on page 415 for more
information.

Microchip

When enabled, the software uses
less restrictive register
optimizations during synthesis if
area is not as great a concern for
your device. The default for this
option is disabled (0).

Enables/disables the Verilog
include statement to be relative
to the project, rather than a
verilog file. For projects built with
software after 8.0, the include
statement is no longer relative to
the files but is relative to the
project: project_relative (1). See
Updating Verilog Include Paths

in Older Project Files , on page 68

in the User Guide for information
about updating older project
files.

Microchip

Sets the maximum number of
critical paths in a
forward-annotated SDF
constraint file

Synplify Pro for Microchip Edition Command Reference
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GUI Equivalent

Number of Start/End
Points, Timing
Report Panel.
Number of Start/End
Points, Timing
Report Generation
dialog box.

Device Panel

Conservative
Register
Optimization
switch on the
Device Panel

Include Path Order,
Verilog Panel

Max Number of
Critical Paths in
SDF, Device
Panel
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Option

-report_preserve_cdc 1/0

-reporting_reportType

-resolve_multiple_driver 1|0

-resource_sharing 1|0

-result_file filename

-retiming 1|0

© 2021 Synopsys, Inc.
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Description

Enables or disables CDC
reporting. The option is ON, by
default. See CDC Reporting, on
page 377 in the Reference
Manual.

Sets parameters for the
stand-alone Timing Analyst
report.

See Timing Report Parameters
for set_option , on page 127 for
details.

When a net is driven by a VCC or
GND and active drivers, enable
this option to connect the net to
the VCC or GND driver.

The default for this option is
disabled (0).

See Resolve Mixed Drivers
Option , on page 131 for details.

Enables or disables resource
sharing globally. This is a
compiler-specific optimization,
and does not affect resource
sharing in the mapper.

To enable or disable individual
modules, use the syn_sharing
directive.

Specifies the name of the results
file.

When enabled (1), registers may
be moved into combinational
logic to improve performance.
The default value is O (disabled).

GUI Equivalent

Report and
Preserve CDC
paths,

High Reliability
Panel

Analysis->Timing
Analyst command:
Timing Report
Generation
Parameters

Resolve Multiple
Drivers, Device
Panel

Resource Sharing,
Device Panel

Result File Name
and Result Format,
Implementation
Results Panel

Retiming, Device
Panel
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Option Description GUI Equivalent

-run_prop_extract 1|0 Enables/disables the annotation Options Panel
of certain generated properties
relating to clocks and expansion
onto the RTL view. This enables
the Tcl expand and find commands
to work correctly with clock

properties.

-rw_check_on_ram 1|0 Enabling this option Automatic
automatically inserts bypass Read/Write Check
logic when required to prevent Insertion for RAM,
simulation mismatch in Device Panel

read-during-write scenarios. For
asynchronous clocks, the tool
will not generate bypass logic
which can cause unintended
CDC paths between the clocks.

For more information about
using this option in conjunction
with the syn_ramstyle attribute,
see syn_ramstyle , on page 199.

-safe_case 1|0 When enabled, the high Preserve and
reliability safe case option turns Decode
off sequential optimizations for  Unreachable States
counters, FSM, and sequential (FSM, Counters,

logic to increase the circuit’s Sequential Logic),
reliability. High Reliability
Panel
-supporttypedfit 1|0 When enabled (1), the compiler  Implicit Initial Value
passes init values through a Support, VHDL

syn_init property to the mapper. Panel
For more information, see VHDL
Implicit Data-type Defaults , on

page 338.
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Option Description GUI Equivalent

-symbolic_fsm_compiler 1|0 Enables/disables the FSM FSM Compiler
compiler. Controls the use of check box,

-autosm 1[0 FSM synthesis for state Device Panel

machines. The default is false
(FSM Compiler disabled). Value
can be 1 or true, O or false.

When this option is true, the
FSM Compiler automatically
recognizes and optimizes state
machines in the design. The FSM
Compiler extracts the state
machines as symbolic graphs,
and then optimizes them by
re-encoding the state
representations and generating a
better logic optimization starting
point for the state machines.

However, if you turn off
sequential optimizations for the
design, FSM Compiler and/or
the syn_state_machine directive
and syn_encoding attribute are
effectively disabled.

See -no_sequential_opt 1|0 for
more information on turning off
sequential optimizations.

-synthesis_onoff pragma 1|0  Determines whether code Synthesis on/off
between synthesis on/off directives Implemented as
is ignored. Translate on/Off,
When enabled, the software VHDL Panel

ignores any VHDL code between
synthesis_on and synthesis_off
directives. It treats these
third-party directives like
translate_on/ off directives (see
translate_off/translate_on , on
page 285 for details).
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Option Description GUI Equivalent

-top_module name Specifies the top-level module. Top-level

If the top-level entity does not  Entity/Module,
use the default work library to ~ VHDL Panel or
compile the VHDL/Verilog files, Verilog Panel
you must specify the library file

where the top-level entity can be

found. To do this, the top-level

entity name must be preceded by

the VHDL/Verilog library

followed by the dot (. ).

-update_models_cp 1|0 Determines whether (1) or not (0) Update Compile
changes inside a compile point  Point Timing Data,
can cause the compile point (or Device Panel
top-level) containing it to change

accordingly.
-use_fsm_explorer 1|0 Enables/disables the FSM FSM Explorer,
Explorer. Device Panel
-vlog_std v2001]v95 | sysv The default Verilog standard for Verilog 2001,

new projects is SystemVerilog. SystemVerilog,
Turning off both options in the  Verilog Panel
Verilog panel defaults to v95.

-write_apr_constraint 1|0 Writes vendor-specific constraint Write Vendor
files. Constraint File,
Implementation
Results Panel

-write_verilog 1|0 Writes Verilog or VHDL mapped Write Mapped
netlists. Verilog/VHDL
_write_vhdl 10 Netlist,

Implementation
Results Panel

Timing Report Parameters for set_option

The following lists the parameters for the stand-alone timing report (.ta file).
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async_clock

ctd

filename

filter
gen_output_srm

Reporting Option

-reporting_async_clock

margin

netlist
number_paths
output_srm

Description

Generates a report for paths that cross
between clock groups using the stand-alone
Timing Analyst.

-reporting_ctd slack | end_point| Controls how the desi gn_ct d.t xt

off

(correlation timing dump) file is generated
when the Timing Analyst is run. You can
specify one of the following values:

e slack - The timing information in the ctd
file is sorted by slack. This is the default.

e end_point - The timing information in the
ct d file is sorted by end points.

« off - Turns off generating the ct d file.

The ct d file contains a timing summary of
the design that is used by the Timing Report
View to display and analyze the synthesis
timing for the design and correlate this
synthesis timing with the P&R timing in the
GUI.

-reporting_filename filename.ta Specifies the standard timing report file (t a)

© 2021 Synopsys, Inc.
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generated from the stand-alone Timing
Analyst.
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Reporting Option Description

-reporting_filter filter options Generates the standard timing report based
on the filter options you specify for paths,
such as:

e From points

e Through points

e To points

For more information, see:

* Timing Report Generation Parameters , on
page 408.

e Combining Path Filters for the Timing
Analyzer , on page 412

* Timing Analyzer Through Points , on
page 411.

e Specifying From, To, and Through Points ,
on page 252.

-reporting_gen_output_srm 1|0 Specifies the new name of the output SRM
File when you change the default name. If
this option is set to 1, this new name is used
for the output sr mfile after you run the
stand-alone Timing Analyst.

-reporting_margin slackValue You can specify a slack margin to obtain a
range of paths within the worst slack time
for the design after you run the stand-alone
Timing Analyst.

-reporting_netlist flename.srm Specifies the associated gate-level netlist file
(sr m generated from the stand-alone Timing
Analyst.

-reporting_number_path You can specify the number of critical paths

numberOfPaths to report after you run the stand-alone

Timing Analyst.

-reporting_output_srm 1|0 Allows you to change the name of the output
sr mfile. If you enable the output SRM File
option, you can change this default name.

For GUI equivalent switches for these parameters, see Timing Report Genera-
tion Parameters, on page 408.
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help for set_option

This option is useful for getting syntax help on the various implementation
options used for compiling and mapping a design, especially since this list of
options keeps growing.

Syntax
% set _option -help

Usage:
set_option optionName optionValue [-help [value]]
Where:
¢ optionName—specifies the option name.
¢ optionValue—specifies the option value.

* -help [value]—to get help on options. Use:
— -help * for the list of options
— -help optionName for a description of the option

Examples
To list all option commands in the Tcl window:

set _option -help *
To list all option commands beginning with the letters fi in the Tcl window:
% set _option -help fi*

fixgat edcl ocks
fixgener at edcl ocks
fixsmult

To get help on a specific option in the Tcl window:
% set _option -hel p fixgatedcl ocks

0: Don't fix; 1: fix, no report; 2: fix, report exception
registers; 3: fix, report all registers
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Use the following Tcl commands to print a description of the options:

% set_option -help c*
%set hl [set_option -help c*]

% puts $hl
% foreach option $hl { puts "$option:\t [set_option -help
$option]"; }

This example will print a list of set_option options that begin with the letter c.

Resolve Mixed Drivers Option

Use the Resolve Mixed Drivers option when mapping errors are generated for
input nets with mixed drivers. You might encounter the following messages in
the log file:

@\ BN313 | Found m xed driver on pin pin:data_out inst:dpramlut3
of work.dpram{verilog), use option "Resolve Mxed Drivers" in
"Device" tab of "Inplenmentation ptions" to autonatically resol ve
this

@ BN314 | Net "G\D' in work.test(verilog) has mixed drivers

@\ BN313 | Found nixed driver on pin pin: 0] inst:dff1.q of
PrinLib.sdffr(prin), use option "Resolve Mxed Drivers" in
"Device" tab of "Inplementation ptions" to automatically resolve
this

@ BN314) | Net "VCC' in work.test(rtl) has m xed drivers

Whenever a constant net (GND or VCC) and an active net are driving the
same output net, enable the Resolve Mixed Drivers option so that synthesis can
proceed. To set this switch:

* Check Resolve Mixed Drivers on the Device tab of the Implementation Options
panel.
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Device Mapping Options

‘Dption |Value
Fanout Guide 10000
Disable /O Insertion [l
Update Compile Point Timing Data O
Annotated Properties for Analyst
DOperating Conditions COMTC
Max NMumber of Critical Paths in SOF 4000
Mrneancative Ranictar Ontimizatinn [

* Use the Tcl command, set_option -resol ve_mul tiple_driver 1.
By default this option is disabled and set to:
set_option -resolve multiple driver O.

When you rerun synthesis, you should now see messages like the following in
the log file:

@VBN312 | Resolving mxed driver on net G\D, connecting out put
pi n: data_out inst:dpramlut3 of work.dpran{verilog) to G\D

@ BNL16) | Reroving sequential instance dpram| ut3. dout of
view PrinLib.dffe(prin) because there are no references to its
out put s

@\ BNL16 | Renoving sequential instance dpram | ut 3. nem of

view PrinLib.ranl(prin) because there are no references to its
out put s

@VBN312 | Resolving mxed driver on net VCC, connecting out put
pin:0] inst:dffl.q of PrinLib.sdffr(prim to VCC

@ BNL16 | Renovi ng sequential instance dffl.q of

view PrinLib.sdffr(prin) because there are no references to its
out put s

Example - Active Net and Constant GND Driving Output Net (Verilog)

nodul e test(clk,data_in,data out, radd, wadd, w, rd);

i nput clk,w,rd;

i nput data_in;

i nput [5:0] radd, w add;

out put data_out;

/1 conponent instantiation for shift register nodul e
shrl srl_lut0O (
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.clk(cl k),
.sren(w),
.srin(data_in),
.srout (data_out)
)
// Instantiation for ram
dpramdpram | ut3 (
.clk(cl k),
.data_in(data_in),
.data_out (data out),
.radd(radd),
. wradd(wr add) ,
S (wr),
.rd(rd)
)

endnodul e

nmodul e shrl (clk, sren,srin,srout);
i nput cl k;

i nput sren;

i nput srin;

out put srout;

paraneter wi dth = 32;
reg [width-1:0] sr;

al ways @ posedge cl k)

begi n
if (sren == 1)
begi n
sr <= {sr[width-2:0], srin};
end
end

/1 Constant net driving

/1 the output net
assign srout = 1'b0;
endnodul e

nmodul e dpranfcl k, data_i n, data_out, radd, w add, w, rd);
i nput cl k,w,rd;

i nput data_in;

i nput [5: 0] radd, w add;

out put data_out;
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reg dout;
reg [0:0]meni63 :0];

al ways @ (posedge cl k)
begi n
if(w)
nenfw add] <= data in;
end

al ways @ (posedge cl k)
begi n
if(rd)
dout <= nenjradd];
end

assign data out = dout;

endnodul e

See the following RTL and Technology views; the Technology view shows the
constant net tied to the output.

Technology View

RTL View

OBUF
shil

T
—
&
=

arl_lutd [2etain ===
[ck_—= data_out_obuf

dpram

]

[T racel S

dpram_lut3

Example - Active Net and Constant VCC Driving Output Net (VHDL)

library ieee;
use ieee.std logic 1164. all;
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entity test is

port (clk,rst : in std_|ogic;
sr_en : in std |ogic;
data : in std_|ogic;

data op : out std logic );
end entity test;

architecture rtl of test is

conponent shrl

generic (sr_length : natural);

port (clk : in std_logic;
sr_en : in std_|l ogic;
sr_ip: in std_logic;
sr_op : out std logic);

end conponent shrl

conponent d_ff

port (data, clk, rst : in std_logic;
g : out std logic );

end conponent d_ff;

begi n
-- instantiation of shift register
shift _register : shrl
generic nmap (sr_length => 64)
port map (clk => clKk,
Sr_en => sr_en,
sr_ip => data,
sr_op => data_op );
-- instantiation of flipflop

dff1 : d ff
port nmap (data => data
clk => clk,
rst => rst,
q => data_op );
end rtl;
library ieee;

use ieee.std_| ogic_1164. al | ;
use ieee.nuneric_std. all
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entity shrl is

generic (sr_length : natural);

port (clk : in std_|l ogic;
sr_en : in std_|l ogic;
sr_ip: in std_logic;
sr_op : out std_logic );

end entity shrl;

architecture rtl of shrl is
signal sr_reg : std |logic vector(sr_|length-1 dowto 0);
begi n
shreg |l ut: process (clk)
begi n
if rising_edge(clk) then
if sr_.en ="'1 then
sr_reg <= sr_reg(sr_length-2 dowmto 0) & sr_ip;
end if;
end if;
end process shreg_|lut;
-- Constant net driving output net
sr_op <="'1";
end architecture rtl;

l'ibrary | EEE;
use | EEE std logic_1164. all;

entity d_ff is

port (data, clk, rst : in std_|ogic;
g : out std logic);
end d_ff;

architecture behav of d_ff is
begi n
FF1: process (clk) begin
if (clk'event and clk = '1') then
if (rst ='1") then
q<='0;
el se g <= data
end if;
end if;
end process FF1;
end behav;
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See the following RTL and Technology views; the Technology view shows the
constant net tied to the output.
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RTL Wiew
shri
[k == —e— dt
[=ren "= | —=— ar =1 arop —s——fola op =
gata — a_|
shift_register Technology View
[dats == OBUF
[eren —
A Lrst = I\
L= dat 0
- -:i-:J g —= I = data_op =
a1 data_op_obuf
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status_report

Writes out the results of reports displayed in the Project Status view after
synthesizing a design.

Syntax

status_report -name reportName [-parameter reportSectionName]
[-csv] [-output_file fileName] [-msgtype msgStatus] [-status] [-help]

Examples
status_report -name area_report
status report -nanme timng report -csv -output file reports
status_report -name area_report -parameter io_port
status_report -name run_status -nsgtype warni ngs

status_report -nane timng_report -help

Option Description

-name reportName The type of report to access. Use any of the
following keywords for reportName:
* area_report
* timing_report
* opt_report
 cp_report
* hier_area_report
* run_status

-parameter reportSectionName  Specifies a specific section of the area, timing, or
message reports to access. See Parameters , on
page 139 for details of the appropriate keywords to
use for the section names.

-CSv Generates the report as a comma-separated list.

-output_file fileName Specifies the name of the file that writes out the
report. If you do not specify an output file, the
report is displayed in the Tcl window.
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Option Description

-msgtype msgStatus Generates the number of messages found for the
following types of messages:

e Errors
e Warnings
* Notes

-status Generates the status for a job. The results of the
job can be specified with one of the following
conditions:

e Completed

* Failed

-help Allows you to get help on a parameter list.
Use -help * for a list of parameters.

Parameters

For the area, timing, and message reports you can report results for specific
sections by specifying the appropriate keywords for the -parameter argument.

Area Report section keywords for -parameter io_port
non_io_reg
total_io_reg
v_ram
dsp_used
total_luts

Timing Report section keywords for -parameter  clock_name
req_freq
est_freq slack

Run Status section keywords for -parameter compiler
premap
fpga_mapper
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For example:

% status_report -nane area_report

/O ports(io_port) 26

Non I/ O Register bits(non_io _reg) 242 (0%
I/O Register bits(total _io reqg) 24

Bl ock Ranms(v_ran) 0 (1030)

DSP Bl ocks(dsp_used) 1 (2800)

LUTs(total _luts) 310 (0%

Additional Reporting Commands

There are other commands available from the command line to report
commonly-required information: report_timing_summary, report_area, and
report_opt.

¢ Report Timing Summary

% report _timng_sunmary

Ti m ng Summary

A ock Nane Req Freq Est Freq Sl ack
eight_bit_uc|clock 198.9 Miz 169.1 MHz-0. 887

* Report Area

% report_area

LUTs for conbinational functionsO
Non I/ O Registers 0

/O Pins 66

I/Oregisters O

DSP Bl ocks 0 (256)

Mermory Bits 32768

* Report Optimizations

% report _opt
Conbi ned d ock Conversion 1/ 0

© 2021 Synopsys, Inc. Synplify Pro for Microchip Edition Command Reference

140 Synopsys Confidential Information

June 2021



Tcl Synthesis Commands

Messages Reporting Commands

Here are examples of commands available from the command line to report
message information using the option: run_status.

%t atus_report -name run_status

{compiler {notes "8"}{warnings "0"}{errors "0"}
{job_status "Conpl eted"}}

{fpga_mapper {notes "46"}{warnings "1"}{errors "0"}
{job_status "Conpl eted"}}

{premap {notes "3"}{warnings "2"}{errors "0"}
{job_status "Conpl eted"}}

%status_report - nane run_status -nsgtype warni ngs
{conmpiler {warnings "0"}}

{f pga_mapper {warnings "10"}}

{premap {warnings "0"}}

%status_report - name run_status -paranmeter {conpiler prenap}
- nmsgt ype war ni ngs

{conpiler {warnings "0"}}

{premap {warnings "0"}}

% status_report -name run_status -parameter conpiler -status
{conpiler {job_status "Conpl eted"}}

% status_report -nane run_status -parameter premap -status
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sub_impl

Sub-implementation editing command.

Syntax

sub_impl
impIName -add jobType
impIName -remove
implName -type
impIName -run mode
implIName -cancel
implName -option optionName [optionValue]
-list

Arguments and Options

Option Description

impIName -add jobType Creates a new sub-implementation that belongs to
an active implementation.

impIName -remove Removes an active sub-implementation.

impIName -type Lists a sub-implementation type.

impIName -run mode Runs sub-implementation.

impIName -cancel Cancels a running sub-implementation.

impIName -option optionName Sets option for sub-implementation.
[optionValue]

-list Lists all sub-implementations for an active
implementation.
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synplify_pro

Starts the FPGA synthesis tool and runs synthesis from the command line.
Use the appropriate command for the tool you are using. The command to
start the synthesis tool from the command line includes a number of
command line options.

Syntax

synplify_pro
[options ... ]
[projectFile]

projectFile  Specifies the project (prj ) file to use. If no file is specified, the tool
defaults to the last project file opened.

options Any of the command line options described in the next table. These
options control tool action on startup and, in many cases, can be
combined on the same command line. See the next table for a
description of the options you can specify.

The following table describes the options you can specify:

Option Description

-batch Synplify Pro (except node-locked)

Starts the synthesis tool in batch mode from the specified
project or Tcl file without opening the Project window.

-compile Compiles the project, but does not map it.

-evalhostid Reports host ID for node-locked and floating licenses.
-help Lists available command line options and descriptions.
-history filename Records all Tcl commands and writes them to the specified

history log file when the command exits.

-ldentify_dir dir Specifies the location of the Identify installation directory for
launching the Identify tool set. The installation path
specified appears in the Configure Identify Launch dialog box
(Options->Configure Identify Launch).

-impl impName Runs only the specified implementation. You can use this
option in conjunction with the -batch keyword.

The Synplify tool supports only a single implementation.
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Option Description

-ip_license_wait Specifies how long to wait for a Synopsys DesignWare IP

waitTime license when one is not immediately available. If you do not
specify the -ip_license_wait option, license queuing is not
enabled.

If all requested licenses are checked out or if the specified
wait time elapses, the tool excludes the IP and continues to
process the rest of the design. Any IP block without a license
is treated either as an error or a black box.

License queuing allows you to wait until a license becomes
available or specify a wait time in seconds. You can use this
option in conjunction with the -batch keyword. For details,
see Queuing Licenses , on page 508 in the User Guide.

The waitTime value determines license queuing and sets a
maximum wait time:

e Undefined or 0 = Queuing off
¢ 1 = Queuing enabled, indefinite wait time
e >1 = Queuing enabled for the specified time

-license_release Releases FPGA synthesis licenses for a session after the
place-and-route job is launched. The software allows place
and route to continue running even after exiting the
synthesis tool so that it does not consume an FPGA license.

This command option must be run in batch mode. Specify
the following command:

t ool Name -batch -1icense rel ease

For details, see Releasing the Synthesis License During
Place and Route , on page 554.

-licensetype Specifies a license if you work in an environment with
featureName multiple Synopsys FPGA licenses. You can use this option in
conjunction with the -batch keyword.

If you have licenses for multiple products, separate each
feature license by a colon so that licenses can be searched in
the order they are read until an available license is found.
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Option Description
-license_wait Specifies how long to wait for a Synopsys FPGA license. If
waitTime you do not specify the -license_wait option, license queuing is

not enabled.

License queuing allows you to wait until a license becomes
available or specify a wait time in seconds. You can use this
option in conjunction with the -batch keyword. For details,
see Queuing Licenses , on page 508 in the User Guide.

The waitTime value determines license queuing and sets a
maximum wait time in seconds:

e Undefined or O = Queuing off
e 1 = Queuing enabled, indefinite wait time
e >1 = Queuing enabled for the specified wait time

-log filename Writes all output to the specified log file.

-loga filename Writes all output to be appended to the specified log file.
-max_parallel_jobs Specifies the maximum number of concurrent processes
value used for synthesis.

-nopopup Suppresses popup dialog boxes.

-run implName Runs the specified implementation in the project file.
-runall Runs all the implementations in the project file.

The Synplify tool supports only a single implementation.

-shell Starts synthesis tool in shell mode.

Note: The FPGA synthesis tools only support the -shell option
on UNIX and Linux platforms.

-tcl prjFile | Tclscript Starts the synthesis tool in the graphical user interface
using the specified project or Tcl file.
-tclemd command Specifies Tcl command to be executed on startup.
-verbose_log Writes messages to stdout.log in verbose mode.
-version Reports version of specified synthesis tool.
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Tcl Command Categories

The following tables group Tcl commands together by type or functionality.

Log File Commands, on page 146

Technology-Specific Tcl Commands, on page 146

Technology-Specific Tcl Commands, on page 146

Log File Commands

These Tcl commands let you filter messages in the log file.

log_filter

log_report

message_override

Lets you filter errors, notes, and warning messages.

Lets you write out the results of the log_filter command to a
file.

Allows you to suppress or override the log file message ID
specification.

Technology-Specific Tcl Commands

You can find vendor-specific Tcl commands in the appropriate vendor

chapter.

Vendor/Family
Microchip

© 2021 Synopsys, Inc.
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Tcl Command Lists

Microchip Tcl set_option Command Options , on
page 419
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Silicon to Software

CHAPTER 3

Tcl Find, Expand, and Collection
Commands

The FPGA synthesis software includes powerful search functionality in the
Tcl find and expand commands. Objects located by these commands can be
grouped into collections and manipulated. The following sections describe the
commands and collections in detail:

¢ find, on page 149

¢ find -filter, on page 156

* expand, on page 163

* Collection Commands, on page 166
* Query Commands, on page 176

* Synopsys Standard Collection Commands, on page 206

The find, expand, and collection commands are listed alphabetically in the
following table.

add_to_collection all_clocks
all_fanin all_fanout
all_inputs all_outputs
all_registers append_to_collection
c_diff c_info
C_intersect c_list
Synplify Pro for Microchip Edition Command Reference © 2021 Synopsys, Inc.
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c_print

C_union
define_collection
expand
foreach_in_collection
get_clocks
get_flat_nets
get_nets
get_pins
get_prop
object_list
report_timing

sizeof_collection

© 2021 Synopsys, Inc.
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c_symdiff
copy_collection
define_scope_collection
find (Tcl find)

get_cells

get_flat_cells

get flat_pins
get_object_name
get_ports
index_collection
remove_from_collection

set

Synplify Pro for Microchip Edition Command Reference
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find

The Tcl find command identifies design objects based on specified criteria. Use
this command to locate multiple objects with a common characteristic. If you
want to locate objects that share connectivity, use the expand command
instead of the find command (expand, on page 163).

You can specify the find command from the SCOPE environment or enter it as
a Tcl command. This command operates on the RTL database.

You can define objects identified by find as a group or collection, and operate
on all the objects in the collection at the same time. To do this, you embed the
find command as part of a collection creation or manipulation command to do
this in a single step. The combination of find and collection commands
provides you with very powerful functionality to operate on and manipulate
multiple design objects simultaneously.

The table summarizes where to find detailed information:

Synplify Pro for Microchip Edition Command Reference

For ...
Command syntax

Syntax details: object
types, expressions, case
sensitivity, and special
characters

Examples of find syntax

Filtering find searches by
property

Using find search
patterns and using find
in collections

June 2021

See ...
Tcl Find Syntax , on page 150

Tcl Find Command Object Types , on page 151
Wildcards and Special Characters , on page 152
Tcl Find Command Case Sensitivity , on page 152

Tcl Find Syntax Examples , on page 153

find -filter , on page 156
Find Filter Properties , on page 157

Refining Tcl Find Results with -filter , on page 147 in the
User Guide.

Finding Objects with Tcl find and expand , on page 145
in the User Guide.
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Tcl Find Syntax
Finds design objects based on specified criteria.

Find is available as part of the HDL Analyst tool.

Syntax

find
[-flat]
[Finst]
[-net]
[-port]
[-pin]
[-view]
[-nocase]
[-print]
[-depth value]
[-filter expression]
[-seq]
[pattern]

-flat
Extends the search to all levels. The * wildcard character matches
hierarchy separators as well as characters. See Wildcards and Special
Characters, on page 152 for additional information.

-inst
Finds matching instances. If no -type (-inst, -net, -port, -pin, or -view) option
is set, results include instances, nets, and ports.

-net
Finds matching nets. If no -type (-inst, -net, -port, -pin, or -view) option is set,
results include instances, nets, and ports.

-port
Finds matching ports. If no -type (-inst, -net, -port, -pin, or -view) option is
set, results include instances, nets, and ports.

-pin
Finds matching pins. If no -type (-inst, -net, -port, -pin, or -view) option is set,
results include instances, nets, and ports.

-view
Finds matching views. If no -type (-inst, -net, -port, -pin, or -view) option is
set, results include instances, nets, and ports.

© 2021 Synopsys, Inc. Synplify Pro for Microchip Edition Command Reference
150 Synopsys Confidential Information June 2021



find Tcl Find, Expand, and Collection Commands

-nocase
The -nocase option makes the search case-insensitive.

-print
Prints the first 20 search results. For a full list of objects found, use
c_print or c_list. If you use find from the shell, the results are printed to the
Tcl window; if you find in the constraint file, the results are printed to the
log file at the beginning of the Mapper section. Reported object names
have prefixes that identify the object type and are contained in curly
braces ({}).

-depth value
Sets the starting depth for the search. Value may be a single number or
a range. When -depth with a range is used, for example - dept h 4-7, -hier
and -flat arguments are ignored.

-filter expression
Further refines the results of find by filtering the results using the speci-
fied object property. For syntax details, refer to find -filter, on page 156.

-seq
Finds sequential (clocked) instances (the -inst object type is not required).
This argument is equivalent to -filter @is_sequential.

pattern

The value to search for.

Tcl Find Command Object Types

You can specify the following types of objects:

Object Prefix Example Synopsys
view Vi work.cpu.rtl|p:rst is the hierarchical rst port in lib_cell
(Design) the cpu view which points to all

instances of cpu.

inst i: Default object type. i:core.i_cpu.regl points to the cell
(|nstance) regl instance inside i_Cpu.
port p: p:data_in[3] points to bit 3 of the primary data_in port

port. work.cpu.rtl|p:rst is the hierarchical rst port in
the cpu view which eventually points to all
instances of cpu.
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Object Prefix Example Synopsys
pin t: t:core.i_cpu.rst points to the hierarchical rst pin of  pin

instance i_cpu.
net n: n:core.i_cpu.rst points to the rst net driven in i_cpu. net
seq i; i:core.i_cpu.reg[7:0] cell
(Sequential
instance)

© 2021 Synopsys, Inc.
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Wildcards and Special Characters

The Tcl find command significantly differs from a simple Tcl search. A simple
Tcl search does not treat any character, except for the backslash (\), as a
special character, so * matches everything in a string. The Tcl find command

uses various special characters, as shown in the following table.

Use curly brackets {} or double quotes to prevent the interpretation of special
characters within a pattern, and the backslash to escape a single character.

Syntax Matches ...

* A sequence of O or more matches

If you do not specify -hier, the search is restricted to the current view only.
To traverse downward through the hierarchy, either use the -hier
argument or specify the hierarchical levels to be searched by adding the
hierarchical delimiter to the pattern. For example, *.* matches objects one

level below the current view.

? A sequence of 0 or 1 matches

Tcl Find Command Case Sensitivity

Case sensitivity depends on the rules of the language used to specify the
object. In mixed-language designs, the case-sensitivity rules for the parent
object prevail, even when another language is used to define the lower-level

object.
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Tcl Find Syntax Examples

Synplify Pro for Microchip Edition Command Reference

June 2021 Synopsys Confidential Information

The following are examples of find syntax:

Example

find {a*}

find {a*} -hier -nocase
find -net {*synp*} -hier

find -seq * -filter {@clock==myclk}

find -flat -seq {U1.*}

find -hier -flat -inst {i:A.B.C.*} filter
@view==ram*

find -hier-seq {*} -filter
@clock_enable==ena

find -hier-seq {*} -filter @slack <{-0.0}
find -hier-seq {*} -filter {@clock ==clk1}
find -hier-net {*} -filter {@fanout >20}

find -hier-seq * -in $all_inst_coll

find -net -regexp {[a-b].*}

Description

Finds any object in the current view that
starts with a

Finds any object that starts with a or A
Finds any net the contains synp

Finds any register in the current view that is
clocked by myclk

Finds all sequential elements at any
hierarchical level under Ul (* matches
hierarchy separator)

Finds all RAM instances starting from a
submodule and all lower hierarchical levels
from A downwards

Finds all registers enabled by the ena signal

Finds all sequential elements with negative
slack

Finds all sequential elements within the clkl
clock domain

Finds high fanout nets that drive more than
20 destinations

Finds sequential elements inside the
all_inst_coll collection

Finds all nets in hierarchy a and b. This
means {n:a.*} and {n:b.* ; regular expressions
are only supported in the earlier standard
version of the HDL Analyst and are not

supported in the current version.

Use the {} characters to protect patterns that contain [] from Tcl evaluation.
For example, use the following command to find instance reg[4]:
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find -inst {reg[4]}

Example: Custom Report Showing Paths with Negative Slack
Use the following commands:

open_desi gn i npl enentation_a/top.srm
set find negslack[find -hier -seq -inst {*} -filter @lack <
{-0.0}]
c_print -prop slack -prop view $find_negslack -file negsl ack. txt
The result of running these commands is a report called negslack.txt:

hj ect Nane slack view
{i: CPU_A SCC. CPU. DATAPATH GBR 0]} -3.264 "FDE'
{i: CPU_A SCC. CPU. DATAPATH GBR 1]} -3.158 "FDE'
{i:CPU A SCC CPU. DATAPATH GBR 2]} -3.091 "FDE'

Example: Custom Report for Negative Slack FFs in a Clock Domain

The following procedure steps through the commands used to find all
negative slack flip-flops with a given clock domain:

1. Create a collection that contains all sequential elements with negative
slack:

set negFF [find -tech -hier -seq {*} -filter @lack < {-0.0}]
2. Create a collection of all sequential elements within the clk clock domain
set clklFF find -hier -seq * -filter {@l ock==cl k1}
3. Isolate the common elements in the two collections:
set cl klSlack [c_intersect $negFF $cl k1FF]
4. Generate a report using the c_print command:
c_print [find -hier -net * -filter @anout>=2]
{n: ackl_t np}
{n: ack2_t np}

{n bl k_xfer_cntrl_inst.|fsr_data[20:14]}
{n:blk_xfer_cntrl _inst.lfsr_inst.blk size[6:0]}
{n:bl k_xfer_cntrl _inst.lfsr_inst.clk_c}
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Custom Fanout Report Example
The following command generates a fanout report:

%c_print -prop fanout [find -hier -net * -filter @ anout>=2]

This is an example of the report generated by the command:

hj ect Nane f anout
{n: ackl_t np} 3
{n:ack2_t np} 4

{n:blk _xfer cntrl_inst.Ifsr_data[14]} 3
{n:blk_xfer_cntrl _inst.|fsr_data[15]} 3
{n:blk xfer _cntrl _inst.|fsr_data[16]} 2

You can add additional information to the report, by specifying more proper-
ties. For example:

%c_print -prop fanout [find -hier -net * -filter @anout>=2] -prop
pi ns

Thi s command generates a report |ike the one shown bel ow

hj ect Nane Fanout Pi ns
{n:ackl_t np} 3 "t:word_xfer_cntrl _inst.ackl_tnp
t:word_xfer_inst.ackl_tnp"
{n: ack2_t np} 4 "t:blk_xfer_cntrl_inst.ack2_tnp
t: bl k _xfer_inst.ack2 tnp"
{n:adr_o_axb_1} 2 "t:blk xfer_inst.adr_o axb 1
t:adr o cry 1 0.St:adr_ o s 1.LI"
{n:adr_o_axb_2} 2 "t:bl k_xfer_inst.adr_o_axb_2
t:adr_ o cry 2 0.St:adr_ o s 2.LI"
{n:adr_o_axb 3} 2 "t:bl k_ xfer_inst.adr_o_axb 3
t:adr o cry 3 0.St:adr_ o s 3.LI"
{n:adr_o_axb_4} 2 "t:blk xfer_inst.adr_o_axb 4
t:adr_ o cry 4 0.St:adr_ o s 4.LI"
{n:adr_o_axb_5} 2 "t:bl k_xfer_inst.adr_o_axb_5
t:adr_o cry 50.St:adr_o s 5.LI"
{n:adr_o_axb_6} 2 "t:bl k_xfer_inst.adr_o_axb 6

t:adr_ o cry 6 0.St:adr_o s 6.LI"

To save the report as a file, use a command like this one:
c_print -prop fanout [find -hier -net * -filter @ anout>=2]
-prop pins -file prop.txt
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find -filter

The Tcl find command includes the optional -filter option, which provides a
powerful way to further refine the results of the find command and filter
objects based on properties. See the following for details about the find -filter
command:

* Find -filter Syntax, on page 156
* Find Filter Properties, on page 157
* Find Filter Examples, on page 161

For the Tcl find command syntax, see

Find -filter Syntax

find pattern otherOtions -filter {[']@propertyName operator value}

! Optional character to specify the negative. Include the !
character if you are checking for the absence of a property;
leave it out if you are checking for the presence of a

property.

@propertyName  Property name to use for filtering. The name must be
prefixed with the @ character. For example, if clock is the
property name, specify {@clock==myclk}.

operator Evaluates and determines the property value used for the
filter expression. For the operators you can use in the
expressions, see Filter Operators , on page 157.

value Property value for the property in the filter expression, when
the property has a value. The value can either be an object
name such as myclk in {@clock==myclk}, or a value, such as
60 in {@fanout>=60}.

When specified, the -filter option must be the last option specified for the find
command.
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Filter Operators
You can use the following relational operators with the -filter option:

== Equal

1= Not equal

> Greater than

< Less than

>= Greater than or equal to
<= Less than or equal to

=~ Matches pattern

I~ Does not match pattern

You can use the following logical operators with the -filter option:

&& And
Il Or
! Not

Find Filter Properties

The object properties are based on the design or constraint, and are used to
qualify searches and build collections. To generate these properties, open
Project->Implementation Options->Device and enable the Annotated Properties for
Analyst check box. The properties display in the Tcl window when the RTL or
Technology view is active. Some properties are only available in a certain
view. The tool creates .sap and .tap files (design and timing properties, respec-
tively) in the project folder.

The table below lists the common filter object properties. It does not include
some vendor-specific properties. Use the table as a guide to filter the proper-
ties you want. Here is how to read the columns:
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Property Name  Property Value HDL View  Description

Common Properties

type view | port| net]instance| All Specifies the type of
pin object to be filtered
from the netlist
find * -filter -object -print

View Properties

compile_point locked Tech Filters the view based
on compile point
properties
find * -view -filter
@compile_point==locked
-print

is_black_box 1 All Filters the black box
view
find * -view -filter
@is_black_box==1 -print

is_verilog (0] 8 All Filters the Verilog
based view
find * -view -filter
@is_verilog=={0|1} -print

is_vhdl (0] 8 All Filters the VHDL based
view
find * -view -filter
@is_vhdl=={0|1} -print

orig_inst_of viewName RTL and Filters the view based
Tech on original instance
find * -view -filter
@orig_inst_of==viewName

-print
syn_hier remove | flatten ] soft] firm Tech Filters the view based
| hard on the syn_hier

attribute value

find * -view -filter
@syn_hier=={remove|
flatten|soft|firm|hard} -print
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Property Name Property Value HDL View Description

Port Properties

direction input | output]inout All Filters the port based
on port direction
find * -port -filter
@direction=={input|output|
inout} -print

fanout value All Filters the port based
on fanout value
find * -port -filter
@fanout==value -print

Instance Properties

area areaValue Tech

arrival_time value Tech Corresponds to worst
slack

async_reset n:netName All

async_set n:netName All

clock clockName All Could be a list if there
are multiple clocks

clock_edge rise]fall] All Could be a list if there

high| low are multiple clocks

clock_enable n:netName All Highest branch name in
the hierarchy, and
closest to the driver

compile_point locked Tech Automatically inherited
from its view

hier_rtl_name hierInstanceName All

inout_pin_count value All

input_pin_count  value All

inst_of viewName All

is_black _box 1 (Property added) All Automatically inherited
from its view
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Property Name Property Value HDL View Description
is_hierarchical 1 (Property added) All
is_sequential 1 (Property added) All
is_combinational 1 (Property added) All
is_pad 1 (Property added) All
is_tristate 1 (Property added) All
is_keepbuf 1 (Property added) All
is_clock_gating 1 (Property added) All
is_vhdl (0] 8 All Automatically inherited

from its view
is_verilog (0] 8 All Automatically inherited
from its view
kind primitive All Tech view contains
For example: inv | and [dff | vendor-specific
mux | statemachine | ...) primitives
location (%, y) Tech Format can differ
name instanceName All
orientation N]JSIEIW Tech
output_pin_count value All
pin_count value All
placement_type unplaced | placed All
rtl_name nonhierlnstanceName All
slack value Tech Worst slack of all arcs
slow 1 Tech
sync_reset n:netName All
sync_set n:netName All
syn_hier remove | flatten | Tech Automatically inherited
soft]firm | hard from its view
view viewName All
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Property Name Property Value HDL View Description

Pin Properties

arrival_time timingValue Tech

clock clockName All Could be a list if there
are multiple clocks

clock edge rise]fall] All Could be a list if there

high| low are multiple clocks
direction input]output| All
inout

fanout value All Total fanout (integer)

is_clock o011 All

is_const o11 All

is_gated_clock 011 All Set in addition to
is_clock

slack value Tech

Net Properties

clock clockName All Could be a list if there
are multiple clocks

is_clock 0]1 All

is_gated_clock 0]1 All Set in addition to
is_clock

fanout value All Total fanout (integer)

Find Filter Examples

The following examples show how find filter is used to check for the presence
or absence of a property, with the ! character indicating a negative check:

c_print [find -hier -view {*} -filter Finds all objects that are black
(@s_bl ack_box)] boxes.

c_print [find -hier -view {*} -filter Finds all objects that are not black
(' @s_bl ack_box)] boxes
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Positive Check Examples
Finds all ports, pins, and nets from the top level with a fanout greater than 8:

find * -filter {@anout>8}
Finds all instances other than andv and orv in the design:
find * -hier -filter {!(@1iew=andv|| @iew=orv)}
Finds all instances of statemachine throughout the hierarchy:
find -hier -inst * -filter {@nst_of ==st at enachi ne}
find -hier -inst * -filter {@i nd==statenachi ne}

Finds all instances throughout the hierarchy that include the string reg and
are clocked by CLK:

find -hier -inst {*reg*} -filter {@l ock==CLK}
Finds all nets throughout the hierarchy that have a fanout greater than 4:

find -hier -net {*} -filter {@anout >4}

Negative Check Example

Finds all instances from the top level that have the include string big, that are
not black boxes, and that have more than 10 pins:

find -inst *big* -filter {! @s_bl ack_box&&( @i n_count >10) }

Example of Boolean Expression Specified on Multiple Properties

Finds all instances from the top level that have more than eight pins and
negative slack:

find * -filter {(@in_count>8)&& @l ack<0)}

Example of Pin Property Specified for Constants
Finds pins driven by constant O or constant 1:

find -pin *.* -filter @onst==value -print

Where value of 1 lists all the pins that are tied to a constant.
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expand

The expand command identifies objects based on their connectivity, by
expanding forward from a given starting point. For more information, see
Using the Tcl expand Command to Define Collections, on page 150 of the User
Guide.

Tcl expand Syntax

The syntax for the expand command is as follows:

expand [-objectType] [-from object] [-thru object] [-to object] [-level integer]
[-hier] [-leaf] [-seq] [-print]

Argument Description

-from object Specifies a list or collection of ports, instances, pins, or nets for
expansion forward from all the pins listed. Instances and input
pins are automatically expanded to all output pins of the
instances. Nets are expanded to all output pins connected to the
net.

If you do not specify this argument, backward propagation stops
at all sequential elements.

-hier Searches for the pattern from every level of hierarchy, instead of
just the top level and identifies objects to be expanded based on
their connectivity.

The default for the current view is the top level and is defined
with the define_current_design command as in the compile-point

flow.

-leaf Returns only non-hierarchical instances.

-level integer Limits the expansion to N logic levels of propagation. You cannot
specify more than one -from, -thru, or -to point when using this
option.

-objectType Optionally specifies the type of object to be returned by the

expansion. If you do not specify an objectType, all objects are
returned. The object type is one of the following:

e -instance returns all instances between the expansion points.
This is the default.

e -pin returns all instance pins between the expansion points.
e -net returns all nets between the expansion points.
« -port returns all top-level ports between the expansion points.
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Argument Description

-print Evaluates the expand function and prints the first 20 results. If
you use this command from HDL Analyst, these results are
printed to the Tcl window; for constraint file commands, the
results are printed to the log file at the start of the Mapper
section.

For a full list of objects found, you must use c_print or c_list.
Reported object names have prefixes that identify the object
type. There are double quotes around each name to allow for
spaces in the names. For example:

"i:regl"

"i:reg2"

"i:\weird_name[f oo$]"

"i:reg3"

<<found 233 objects. D splaying first 20 objects. Use
c print or c_ list for all. >>

-seq Modifies the range of any expansion to include only sequential
elements. By default, the expand command returns all object
types. If you want just sequential instances, make sure to define
the object_type with the -inst argument, so that you limit the
command to just instances.

-thru object Specifies a list or collection of instances, pins, or nets for
expansion forward or backward from all listed output pins and
input pins respectively. Instances are automatically expanded to
all input/output pins of the instances. Nets are expanded to all
input/output pins connected to the net. You can have multiple
-thru lists for product of sum (POS) operations.

-to object Specifies a list or collection of ports, instances, pins, or nets for
expansion backward from all the pins listed. Instances and
output pins are automatically expanded to all input pins of the
instances. Nets are expanded to all input pins connected to the
net.

If you do not specify this argument, forward propagation stops at
all sequential elements.
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Tcl expand Syntax Examples

Example Description

expand -hier -from {i:reg1} -to {i:reg2} Expands the cone of logic between two
registers. Includes hierarchical instances
below the current view.

expand -inst -from {i:reg1} Expands the cone of logic from one register.
Does not include instances below the current
view.

expand -inst -hier -to {i:reg1} Expands the cone of logic to one register.

Includes hierarchical instances below the
current view.

expand -pin -from {t:i_and2.z} -level 1 Finds all pins driven by the specified pin.
Does not include pins below the current
view.

expand -hier -to {t:i_and2.a} -level 1 Finds all instances driving an instance.
Includes hierarchical instances below the
current view.

expand -hier -from {n:cen} Finds all elements in the transitive fanout of
a clock enable net, across hierarchy.

expand -hier -from {n:cen} -level 1 Finds all elements directly connected to a
clock enable net, across hierarchy.

expand -hier -thru {n:cen} Finds all elements in the transitive fanout
and transitive fanin of a clock enable net,
across hierarchy.
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Collection Commands

A collection is a group of objects. Grouping objects lets you operate on
multiple group members at once; for example you can apply the same
constraint to all the objects in a collection. You can do this from both the
SCOPE editor (see Collections, on page 227) or in a Tcl file.

The following table lists the commands for creating, copying, evaluating,
traversing, and filtering collections, and subsequent sections describe the
collections, except for find and expand, in alphabetical order. For information
on using collections, see Using Collections, on page 154 in the User Guide.

Command Description

Creation

define_collection Creates a collection from a list
set modules Creates a collection

set modules_copy $modules  Copies a collection

Creation from Objects Identified by Embedded Commands

find Does a targeted search and finds objects.
Embedding the find command in a collection creation
command first finds the objects, and then creates a
collection out of the identified group of objects.

expand Identifies related objects by expanding from a
selected point. Embedding the expand command in a
collection creation command first finds the objects,
and then creates a collection out of the identified
group of objects.

Operators for Comparison and Analysis

c_diff Identifies differences between lists or collections
c_intersect Identifies objects common to a list and a collection
c_symdiff Identifies objects that belong exclusively to only one
list or collection
C_union Concatenates a list to a collection
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Command Description

Operators for Evaluation and Statistics

c_info Prints statistics for a collection
c_list Converts a collection to a Tcl list for evaluation
C_print Displays collections or properties for evaluation

Tel Collection Commands that
manipulate two or more collections

©_union @
c_diH @

Identifies differences by comparing collections, or a list and a collection. For
this command to work, the design must be open in the GUI.
Syntax

c_diff {$collection1 $collection2 | $collection {list}} [-print]

This command also includes a -print option to display the result.
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Examples

The following examples combine the set with the c_diff command to create a
new collection that contains the results of the c_diff command. The first
example compares two collections and puts the results in diffCollection:

set diffCollection [c_diff $collectionl $collection2]

The next example creates collectionl consisting of objects i:regl and iireg2,
compares this collection to a Tcl list containing object iiregl, puts the results
in the collection diffCollection and prints the result (i:reg2).

%et collectionl {i:regl i:reg2}

%et diffCollection [c_diff $collectionl {i:regl}]
% _print $diffCollection

{i:reg2}

c_info
Returns specifics of a collection, including database name, number of objects
per type, and total number of objects. You can save the results to a Tcl
variable (array) using the -array name option.
Syntax

c_info $mycollection [-array name]

C_intersect

&

Defines common objects that are included in each of the collections or lists
being compared.
Syntax

c_intersect $collectionl $collection2 | list [-print]

This command also includes a -print option to display the result.
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Example

The following example uses the set command to create a new collection that
contains the results of the c_intersect command. The example compares a list
to a collection (myCollection) and puts the common elements in a new collec-
tion called commonCollection:

%et nyCollection {i:regl i:reg2}
%et commonCol | ection [c_intersect $nyCollection {i:regl i:reg3}]
% print $commonCol | ection

{i:regl}

c_list

Converts a collection to a Tcl list of objects. You can evaluate any collection
with this command. If you assign the collection to a variable, you can then
manipulate the list using standard Tcl list commands like lappend and Isort.
Optionally, you can specify object properties to add to the resulting list with
the -prop option:

(object prop_value ... prop_value)...
(object prop_value ... prop_val ue)
Syntax

c_list $collection|list [-prop propertyNamel]*

Example

%et nyMdul es [find -view *]
% _list $nyModul es
{v:top}{v: bl ock _a}{v: bl ock b}

% _|ist $nyModul es -prop is_vhdl -prop is_verilog

Name is_vhdl is_verilog
{v:top} 0 1
{v:block_a} 1 0
{v:block_b} 1 0
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C_print

Displays collections or properties in column format. Object properties are
printed using one or more -prop propertyName options.

Syntax

c_print {$collection | {list}} [-prop propertyName]* [-file filename] [-append] [-foot
footer] [-head header]

To print to a file, use the -fi | e option. Use -append to append to the specified
file instead of overwriting it. Use the -head and the -foot options to add the
header and footer respectively, before printing the file. The following
command in a constraint file prints the whole collection to a file:

c_print -file foo.txt $col
The following example adds a header and a footer to the file before printing:

%c print [find -inst *] -head "Search for all..." -foot "Ends
here. "

Total finding took: O seconds
Search for all...

{ilinst1}

{ilinst2}

<<Collection has 2 objects>>
Ends here.

Note that the command prints the file to the current working directory. If you
have multiple projects loaded, check that the file is written to the correct
location. You can use the pwd command in the Tcl window to echo the current
directory and then use cd directoryName to change the directory as needed.

Example

%et nmodules [find -view *]
% _print $nmodul es

{v:top}

{v: bl ock_a}

{v: bl ock_b}
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% print -prop is_vhdl -prop is_verilog $nodul es
Nane is_vhdl is verilog

{v:top}0 1

{v:block_a}1 0O

{v:block_b}1 O

c_symdiff

¢

Compares a collection to another collection or Tcl list and finds the objects
that are unique, not shared between the collections or Tcl lists being
compared. It is the complement of the c_intersect command (c_intersect, on
page 168).

Syntax

c_symdiff {$collection1 $collection2 | $collection {list}} [-print]

This command also includes a-print option to display the result.

Examples

The following example uses the set command together with the c_symdiff
command to compare two collections and create a new collection (symDiffCol-
lection) that contains the results of the ¢c_symdiff command.

set synDiff_collection [c_symdiff $collectionl $collection2]

The next example is more detailed. It compares a list to a collection (collectionl)
and creates a new collection called symDiffCollection from the objects that are
different. In this case, regl is excluded from the new collection because it is
common to both the list and collectionl.

set collectionl {i:regl i:reg2}
set synDiffCollection [c_syndiff $collectionl {i:regl i:reg3}]
c_list $synD ffCollection

{"i:reg2" "i:reg3"}
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You can also use the command to compare two collections:

c_union

GO

Adds a collection, or a list to a collection, and removes any redundant
instances. For this command to work, the design must be open in the GUI.

Syntax
c_union {$collectionl $collection2 | $collection {list}} [-print]

The c_union command automatically removes redundant elements. This
command also includes a -print option to display the result.

Examples

You can concatenate two collections into a new collection using the c_union
and set commands, as shown in the following example where collection1 and
collection2 are concatenated into combined_collection:

set conbi ned_col | ection [c_union $col |l ectionl $col | ecti on2]

The following example creates a new collection called sumCollection, which is
generated by adding a Tcl list with one object (reg3) to collectionl, which
consists of regl and reg2. The new collection created by c_union contains reg 1,
reg2, and reg3.

%et collectionl [find -instance {reg?} -print]
{i:regl}
{i:reg2}
%et suntollection [c_union $collectionl {i:reg3}]
% |ist $suncollection

{i:regl} {i:reg2} {i:reg3}

If instead you added reg2 and reg3 to collectionl with the ¢_union command, the
command removes redundant instances (reg2), so that the new collection still
consists of regl, reg2, and reg3.
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%et collectionl {i:regl i:reg2}
%et sunctollection [c_union $collectionl {i:reg2 i:reg3}]
% _list $suncollection

{i:regl} {i:reg2} {i:reg3}

define_collection

Creates a collection from any combination of single elements, Tcl lists, and
collections. You get a warning message about empty collections if you define
a collection with a leading asterisk and then define an attribute for it, as
shown here:

set noretinesh [define collection [find -hier -seq *uc_al u]]
define_attribute {$noretinesh} {syn_allowretimng} {0}

To avoid the error message, remove the leading asterisk and change *uc_al u
to uc_al u.

Example

set nmodul es [define_collection {v:top} {v:cpu} $nycoll $nylist]

define_scope_collection

The define_scope_collection command combines set and define_collection to create
a collection and assigns it to a variable.

define_scope_collection ny_regs {find -hier -seq *ny*}

get_prop

Returns a single property value for each member of the collection in a Tcl list.

Examples
get _prop -prop clock [find -seq *]
get _prop -array arr [find Al] -all
get _prop $listExpandedl nst -prop rtl_nane LCROMB2X1i nst
get _prop $listExpandedl nst -prop | ocation SLI CE X1y36
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get _prop $li st Expandedl nst -prop bel GSLUT
get _prop $listExpandedl nst -prop slack 0.678

If this command is used in a Tcl script and the results need to be printed, use
a puts command.

foreach cel [c_list $all_hier] {puts [get_prop -prop view $cel];}

set

Copies a collection to create a new collection. This command copies the
collection but not the name, so the two are independent. Changes to the
original collection do not affect the copied collection.

Syntax
set collectionName collectionCriteria

set copyName $collectionName

collectionName The name of the new collection.

collectionCriteria  Criteria for defining the elements to be included in the collection.
Use this argument to embed other commands, like Tcl find and
expand, as shown in the examples below, or other collection
commands like define_collection, c_intersect, ¢_diff, c_union, and
c_symdiff. Refer to these commands for examples.

copyName The name assigned to the copied collection.

$collectionName  Name of an existing collection to copy.

Examples
The following syntax examples illustrate how to use the set command:
* Use the set command to copy a collection:
set ny_nod_copy $ny_nodul e

* Use the set command with a variable name and an embedded find
command to create a collection from the find command results:

set ny_nodul e [find -view *]
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Use the set command with define_collection to create a collection:
set ny_nodul e [define _collection {v:top} {v:cpu} $col | $nylist]

For more examples of the set command used with embedded Tcl collec-
tion commands, see the examples in c_diff, on page 167, c_intersect, on
page 168, c_symdiff, on page 171, c_union, on page 172, and define_col-
lection, on page 173.
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Query Commands

Query Commands

© 2021 Synopsys, Inc.
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The query commands are Synopsys SDC commands from the Design
Compiler® tool for creating collections of specific object types. Functionally,
they are equivalent to the Tcl find and expand commands (find, on page 149
and expand, on page 163).

These query commands are intended to be used in the FDC file or the HDL
Analyst view (see Query Commands in HDL Analyst Tool, on page 177) to
create collections of objects for constraints. This section describes the syntax
for the query commands supported in the FPGA synthesis tools. For complete
documentation on these commands, see the Design Compiler documentation.

all_clocks
all_fanin
all_fanout
all_inputs
all_outputs
all_registers
get_cells
get_clocks
get_nets
get_pins
get_ports

object_list

report_timing

Note: Since all the query commands above are used to create Tcl collections of
objects for constraints, they must be enclosed in [ ] to be applied. For

example:

set _input_delay 0.5 [al | _inputs]

-clock clk
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Query Commands in HDL Analyst Tool

Most of the query commands can be used in both the FDC file and the HDL
Analyst view to create collections of objects for constraints. However, the
all_clocks command cannot be implemented in the HDL Analyst view.

To use the query commands in the HDL Analyst RTL view:

1. Enable the option: Implementation Options->Device->Annotate Properties for
Analyst.

2. If results are not as expected, check that this option is turned on during
compile and before you open the SRS view.

l Annotated Properties for Analyst
Verification Mode
Resolve Mixed Drivers
Read Write Check on RAM

[«

Query Commands and Tcl find and expand Commands

The Synopsys get* commands and all* commands are functionally similar to
the Tcl find and expand commands. The get* commands and al* commands
are better suited to use with constraints and the fdc file, because they handle
properties like @clock better than the Tcl find and expand commands. In
certain cases, the .fdc file does not support the find and expand commands,
although you can still enter them in the Tcl window. See Query Commands
and Tcl find and expand Commands, on page 177 for examples.
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Query and Tcl find/expand Examples

The following table lists parallel examples that compare how to use either the
Tcl find/expand or the get/all commands to query design objects and set
constraints.

Return the output pins of top-level registers clocked by clkb (e.g. instl.inst2.my_reg.Q)

all_registers FDC Constraint:

set_multicycle_path {4} -from [all_registers -no_hierarchy -output_pins -clock
[get_clocks {clkb}]]

set_multicycle_path {4} -from [get_pins -of_objects [get_cells * -filter {@clock
== clkb}] -filter {@name == Q}]

find Tcl Window:
% define_collection [regsub -all {i:(["s]+)} [join [c_list [find -inst * -filter @clock

== clkix]]] {t:\1.Q}]

Return all registers in the design clocked by the rising edge of clock clkfx

all_registers FDC Constraint:
set_multicycle_path {3} -to [all_registers -cells -rise_clock [get_clocks {clkfx}]]
set_multicycle_path {3} -to [get_cells -hier * filter {@clock == clkfx &&
@clock_edge ==rise}]
find Tcl Window:
find -hier -inst * filter {@clock == clkfx && @clock_edge == rise}

Return clock pins of all registers clocked by the falling edge of ckifx

all_registers FDC Constraint:
set_multicycle_path {2} -from [all_registers -clock_pins -fall_clock [get_clocks
{clkfx}]]
set_multicycle_path {2} -from [get_pins -of_objects [get_cells -hier * filter
{@clock == clkfx && @clock_edge == fall}] -filter {@name == C}]
find Tcl Window:
% find -hier -inst * -filter {@clock == clkfx && @clock_edge == fall}

Return the E pins of all instances of dffre cells (e.g. instl.inst2.my_reg.E)
get_pins FDC Constraint:
set_multicycle_path -to [get_pins -filter {@name == E} -of objects [get_cells
-hier * -filter {@inst_of == dffre}]

find Tcl Window and FDC Constraint:
% regsub -all {i:([s]+)} [join [c_list [find -hier -inst * -filter @inst_of == dffre]]]
{t\1.E}]
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all_clocks

Use this command in the .fdc constraint file to return a collection of objects.
This command is not supported in the HDL Analyst view.

Returns a collection of clocks in the current design.

Syntax
This is the supported syntax for the all_clocks command:
all_clocks

This command has no arguments. All clocks must be defined in the design
before using this command. To create clocks, you can use the create_clock
command.

Example
The following constraint sets a multicycle path from all the starting points.

set_ multicycle path 3 -from[all_cl ocks]

all_fanin

Use this command in the .fdc constraint file to return a collection of objects
and/or in the HDL Analyst view to return a Tcl list of objects.

Reports pins, ports, or cells for the fanin of the specified sinks in the to list.

Syntax
This is the supported syntax for the all_fanin command:

all_fanin
[-break_on_bboxes]
[-endpoints_only]
[-exclude_bboxes]
[-flat]
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[-levels integer]
[-only_cells]
[-startpoints_only]

-to listC

[-trace_arcs all | timing]

Arguments

-break_on_bboxes Stops timing fanin from traversing on black boxes.

-endpoints_only Returns only timing end points.

-exclude_bboxes Excludes black boxes from the final result.

-flat The fanin function operates in flat mode.

This function can be specified in hierarchical (default) or
flat mode. For hierarchical mode, only objects in the
same hierarchy level as the current sink are returned.
The pins within a level of hierarchy below the sink are
traversed, but are not reported.

-levels integer Stops traversal when the perimeter of the search integer
hops is reached. For example, a level 2 hop traverses
through two levels of combinational logic and stops,
instead of hopping through all levels and stopping at the
first sequential or port object. Counting is performed for
the layers of cells that are equidistant from the sink.

-only_cells Results include a set of all cells from the timing fanin for
listC.

-startpoints_only Returns only timing start points.

-to listC Required. Reports a list of sink pins, ports, or nets in the

design and the timing fanin of each sink in the listC Tcl
list or collection specified. When you specify a net,
effectively all drivers on the net are listed.

-trace_arcs all [ timing  Specifies the type of combinational arcs to trace while
traversing the fanin. You can specify either:

« all - Permits tracing of all combinational arcs. This is
the default.

« timing - Permits tracing of valid timing arcs only.
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Examples
The following examples show the timing fanin of a port in the design.

all fanin -to [get_ports y*]
{t:y obuf[4].0t:y obuf[3].Ot:y obuf[0].Ot:y obuf[1].0O
t:y obuf[2].0Ot:y obuf[5].O0t:y obuf[6].0t:y obuf[7].0t:G\D. G
t:moduley_inst.y_c[0] t:nmodul ey_inst.y_c[1]
t:rmoduley inst.y c[2]}

all _fanin -to [get_ports y*] -startpoints_only -flat
{t:moduley_inst.q[2].Qt:moduley_inst.q[1].Q
t:moduley inst.q[0]. G

all fanin -to [get_ports y*] -startpoints_only -flat -only cells
{i:noduley inst.q[0] i:noduley inst.q[1] i:moduley_ inst.q[2]}

all_fanout

Use this command in the .fdc constraint file to return a collection of objects
and/or in the HDL Analyst view to return a Tcl list of objects.

Returns a set of pins, ports, or cells for the fanout of the specified sources in
the from list.

Syntax

This is the supported syntax for the all_fanout command:

all_fanout
[-break_on_bboxes]
-clock_tree | -from listC
[-endpoints_only]
[-exclude_bboxes]
[-flat]
[-levels integer]
[-only_cells]
[-trace_arcs all |timing]

Arguments
-break_on_bboxes Stops timing fanout from traversing on black boxes.
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-clock_tree Uses all clock source pins and/or ports in the design as
its list of sources. Clock sources are specified with the
create_clock command. If there are no clocks or clocks
have no sources, then the report is empty. The -clock_tree
option generates a report displaying the clock trees or
networks in the design.

The -clock_tree and -from options are mutually exclusive.

-endpoints_only Returns only timing end points.
-exclude_bboxes Excludes black boxes from the final result.
-flat The fanout function operates in flat mode.

This function can be specified in hierarchical (default) or
flat mode. For hierarchical mode, only objects in the
same hierarchy level as the current source are returned.
The pins within a level of hierarchy below the source are
traversed, but are not reported.

-from listC Specifies a list of source pins, ports, or nets in the
design. The timing fanout for each source of the listC Tcl
list or collection is reported. When you specify a net,
effectively all load pins on the net are listed.

The -clock_tree and -from options are mutually exclusive.

-levels integer Stops traversal when the perimeter of the search integer
hops is reached. For example, a level 2 hop traverses
through two levels of combinational logic and stops,
instead of hopping through all levels and stopping at the
first sequential or port object. Counting is performed for
the layers of cells that are equidistant from the source.

-only_cells Results include a set of all cells from the timing fanout
for the listC.

-trace_arcs all [timing  Specifies the type of combinational arcs to trace while
traversing the fanout. You can specify either:

« all - Permits tracing of all combinational arcs. This is
the default.

e timing - Permits tracing of valid timing arcs only.

Examples

The following examples show the timing fanout of a port in the design.
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all _fanout -from[get ports {a*}]
{t:a_ibuf[0].] t:a_ibuf[1].] t:a ibuf[2].] t:hold a.D
t:modul ex_inst.a_c[0] t:modul ex_inst.a_c[1]
t: modul ex_inst.a_c[ 2]}

all _fanout -from[get_ports {a*}] -level 1
{t:a_ibuf[O].] t:a_ibuf[1].1 t:a_ibuf[2].1}

all _fanout -from[get ports {a*}] -flat -endpoints only

{t:hold_a.D t:modul ex_inst.qa[0].D t: modul ex_inst.qa[1].D
t:modul ex_inst.qga[2].D t:nmodul ex_inst.qga_fast[0].D}

all_inputs

Use this command in the .fdc constraint file to return a collection of objects
and/or in the HDL Analyst view to return a Tcl list of objects.

Returns a collection of input or inout ports in the current design.

Syntax
This is the supported syntax for the all_inputs command:

all_inputs
[-clock clockName]
[-exclude_clock_port]

Arguments

-clock clockName Limits the search to ports that have input delay relative to
clockName.

-exclude_clock_port  Excludes clock ports from the search.

Examples

The following constraints set a default input delay.
set_input_delay 3 [all _inputs]
set_input_delay 3 -clock {clk} [all _inputs]
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all_outputs

Use this command in the .fdc constraint file to return a collection of objects
and/or in the HDL Analyst view to return a Tcl list of objects.

Returns a collection of output or inout ports in the current design.

Syntax
This is the supported syntax for the all_outputs command:

all_outputs
[-clock clockName]

Arguments

-clock clockName Limits the search to ports that have output delay relative to
clockName.

Examples

The following constraints set a default output delay.
set_output_delay 2 [all_outputs]

set _output _delay 2 -clock {clk} [all_outputs]

all_registers

Use this command in the .fdc constraint file to return a collection of objects
and/or in the HDL Analyst view to return a Tcl list of objects.

Returns a collection of sequential cells or pins in the current design.
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Syntax
This is the supported syntax for the all_registers command:

all_registers
[-clock clockName]
[-rise_clock clockName]
[-fall_clock clockName]
[-cells]
[-[data_pins]
[-clock_pins]
[-output_pins]
[-no_hierarchy]

Arguments

-clock clockName Searches only sequential cells that are clocked by the
specified clock.
By default, all sequential cells in the current design are
searched.

-rise_clock Searches only sequential cells triggered by the rising edge of

clockName the specified clock.
By default, all sequential cells in the current design are
searched.

-fall_clock Searches only sequential cells triggered by the falling edge of

clockName the specified clock.
By default, all sequential cells in the current design are
searched.

-cells Returns a collection of sequential cells that meet the search
criteria.
If you do not specify any of the object types, the command
returns a collection of sequential cells.

-data_pins Returns a collection of data pins for the sequential cells that
meet the search criteria.

-clock_pins Returns a collection of clock pins for the sequential cells
that meet the search criteria.

-output_pins Returns a collection of output pins for the sequential cells
that meet the search criteria.
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-no_hierarchy Limits the search to only the current level of hierarchy.
Sub-designs are not searched.

By default, the entire hierarchy is searched.

Examples

The following constraint sets a max delay target for timing paths leading to all
registers.

set_nmax_delay 10.0 -to [all _registers]

The following constraint sets a max delay target for timing paths leading to all
registers clocked by PHI2.

set_max_delay 10.0 -to [all _registers -clock [get clocks PH 2]]

get _cells

Use this command in the .fdc constraint file to return a collection of objects
and/or in the HDL Analyst view to return a Tcl list of objects.

Creates a collection of cells from the current design that is relative to the
current instance.
Syntax

This is the supported syntax for the get_cells command:

get _cells
[-hierarchical]
[-nocase]
[-regexp]
[-filter expression]
[pattern]
Arguments
-hierarchical Searches each level of hierarchy for cells in the design relative to
the current instance. The object name at a particular level must
match the patterns. For the cell bl ockl/ adder, a hierarchical
search uses "adder" to find this cell name.
By default, the search is not hierarchical.
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-nocase Ensures that matches are case-insensitive. This applies for both
the patterns argument and the filter operators (=~ and !~).

-regexp Views the patterns argument as a regular expression rather
than a simple wildcard pattern. The behavior of the filter
operators (=~ and !~)have also been modified to use regular
expression rather than simple wildcard patterns.

When using the - r egexp option, be careful how you quote the
patterns argument and filter expression. Rigidly quoting with
curly braces around regular expressions is recommended.
Regular expressions are always anchored; that is, the
expression assumes matching begins at the beginning of the
object name and ends matching at the end of an object name.
You can expand the search by adding ". *" to the beginning or
end of the expressions, as needed.

-filter expressions Filters the collection with the specified expression.

For each cell in the collection, the expression is evaluated based
on the cell’'s attributes. If the expression evaluates to true, the
cell is included in the result.

pattern Creates a collection of cells whose names match the specified
patterns. Patterns can include the * (asterisk) and ? (question
mark) wildcard characters. Pattern matching is case sensitive
unless you use the -nocase option.

Examples

The following example creates a collection of cells that begin with o and refer-
ence an FD2 library cell.

get _cells "o*" -filter "@ef_nane =~ FD2"

The following example creates a collection of cells connected to a collection of
pins.

set pinsel [get_pins o*/cp]
get _cells -of objects $pinsel

The following example creates a collection of cells connected to a collection of
nets.

set netsel [get _nets tnp]
get _cells -of objects $netsel
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This example creates a collection of cells with the string BSCAN in its name.
Make sure to use the "=~" operator when performing wildcard matching.

get_cells -hier * -filter {@ier_rtl_name =~ *BSCAN‘}

get_clocks

Use this command in the .fdc constraint file and in the HDL Analyst view (on a
limited basis) to return a collection of objects.

Creates a collection of clocks from the current design.

Syntax
This is the supported syntax for the get_clocks command:

get_clocks
[-nocase]
[-regexp]
[-filter expression]
[pattern | -of objects objects]
[-include_generated_clocks]

Arguments

-nocase Ensures that matches are case-insensitive. This applies for
both the patterns argument and the filter operators (=~ and

1-).

-regexp Views the patterns argument as a regular expression rather
than a simple wildcard pattern. The behavior of the filter
operators (=~ and !~) have also been modified to use regular
expression rather than simple wildcard patterns.

When using the - r egexp option, be careful how you quote
the patterns argument and filter expression. Rigidly quoting
with curly braces around regular expressions is
recommended. Regular expressions are always anchored;
that is, the expression assumes matching begins at the
beginning of the object name and ends matching at the end
of an object name. You can expand the search by adding
".*" to the beginning or end of the expressions, as needed.
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-filter expressions Filters the collection with the specified expression.

For each clock in the collection, the expression is evaluated
based on the clock’s attributes. If the expression evaluates
to true, the clock is included in the result. This option is not
supported in the HDL Analyst view.

pattern Creates a collection of clocks whose names match the
specified patterns. Patterns can include the * (asterisk) and
? (question mark) wildcard characters. Pattern matching is
case sensitive unless you use the -nocase option.

-of _objects objects Creates a collection of clocks that are defined for the given
net or pin objects.

-include_generated  Creates a collection of clocks matching the search criteria

clocks and includes any clocks derived or generated from the

source clocks found. This option is not supported in the
HDL Analyst view.

Examples

The following example creates a collection of clocks that match the wildcard
pattern.

get clocks {*BUF_1*derived_cl ock*}

The following example creates a collection of clocks that match the given
regular expression.

get _clocks -regexp {.*derived_cl ock}

The following example creates a collection that includes clka and any gener-
ated or derived clocks of clka.

get _cl ocks -include_generated_cl ocks {cl ka}
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get flat_cells

Creates a collection of leaf cells that match certain criteria in the current

design.

Syntax

get_flat_cells

[-regexp | -exact]

[-nocase]

[-filter exper]

[patterns | -of_objects objects]
[-print]

Arguments

-regexp

-exact

-nocase

Views the patterns argument as a regular expression rather
than a simple wildcard pattern. This option also modifies
the behavior of the =~ and !~ filter operators to use regular
expressions rather than simple wildcard patterns.

When using the -regexp option, be careful how you quote
the patterns argument and filter expression. Using rigid
quoting with curly braces around regular expressions is
recommended. Note that regular expressions are always
anchored; that is, the expression is assumed to begin
matching at the beginning of an object name and end
matching at the end of an object name. You can widen the
search by adding ".*" at the beginning or end of the
expressions, as needed.

The -regexp and -exact options are mutually exclusive; you
can use only one.

Considers wildcards to be plain characters, and does not
interpret their meaning as wildcards.

The -regexp and -exact options are mutually exclusive; you
can use only one.

Makes matches case-insensitive, both for the patterns
argument and for the ==, =~, and !~ filter operators.
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-filter expression Filters the collection with the specified expression. For each
cell in the collection, the expression is evaluated based on
the cell's attributes. If the expression evaluates to true, the
cell is included in the result.

patterns Creates a collection of cells whose full names match the
specified patterns. Patterns can include the * (asterisk) and ?
(question mark) wildcard characters. Pattern matching is
case sensitive unless you use the -nocase option.

When using the patterns argument, the command searches
all leaf cells to match the patterns argument on their full
names regardless of their hierarchical level.

The patterns and -of _objects arguments are mutually
exclusive; you can specify only one. If you do not specify any
of these arguments, the command uses the * (asterisk) as
the default pattern.

-of_objects objects Creates a collection of cells connected to the specified
objects. The patterns and -of objects arguments are
mutually exclusive; you can specify only one. If you do not
specify any of these arguments, the command uses the *
(asterisk) as the default pattern.

-print Prints the contents of the collection.
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get flat nets

Creates a collection of top-level nets of hierarchical net groups in the current
design that match the specified criteria.

Syntax

get_flat_pins

[-regexp | -exact]

[-nocase]

[-filter exper]

[patterns | -of_objects objects]
[-print]

Arguments

-regexp

-exact

-nocase

Views the patterns argument as a regular expression rather
than a simple wildcard pattern. This option also modifies
the behavior of the =~ and !~ filter operators to use regular
expressions rather than simple wildcard patterns.

When using the -regexp option, be careful how you quote
the patterns argument and filter expression. Using rigid
quoting with curly braces around regular expressions is
recommended. Note that regular expressions are always
anchored; that is, the expression is assumed to begin
matching at the beginning of an object name and end
matching at the end of an object name. You can widen the
search by adding ".*" at the beginning or end of the
expressions, as needed.

The -regexp and -exact options are mutually exclusive; you
can use only one.

Considers wildcards to be plain characters, and does not
interpret their meaning as wildcards.
The -regexp and -exact options are mutually exclusive; you

can use only one.

Makes matches case-insensitive, both for the patterns
argument and for the ==, =~, and !~ filter operators.
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-filter expression

patterns

-of_objects objects

Filters the collection with the specified expression. For each
net in the collection, the expression is evaluated based on
the net's attributes. If the expression evaluates to true, the
net is included in the result.

Creates a collection of top-level nets of hierarchical net
groups whose full names match the specified patterns.
Patterns can include the * (asterisk) and ? (question mark)
wildcard characters. Patterns can include the asterisk (*)
and question mark (?) wildcard characters. Pattern
matching is case sensitive unless you use the -nocase
option.

When using the patterns argument, the command searches
all top-level nets of hierarchical net groups to match the
patterns argument on their full name.

The patterns and -of_objects arguments are mutually
exclusive; you can specify only one. If you do not specify any
of these arguments, the command uses the * (asterisk) as
the default pattern.

Creates a collection of top-level nets of hierarchical net
groups that are connected to the specified objects. Each
object is either a named pin, port, net, cell, or a collection
of these objects. The patterns and -of _objects arguments
are mutually exclusive; you can specify only one. If you do
not specify any of these arguments, the command uses
the * (asterisk) as the default pattern.

-print Prints the contents of the collection.
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get flat pins

Creates a collection of leaf-cell pins that match specified criteria in the
current design.

Syntax

get_flat_pins
[-regexp | -exact]
[-nocase]
[-filter exper]
[patterns | -of_objects objects]
[-print]

Arguments

-regexp Views the patterns argument as a regular expression rather
than a simple wildcard pattern. This option also modifies
the behavior of the =~ and !~ filter operators to use regular
expressions rather than simple wildcard patterns.

When using the -regexp option, be careful how you quote
the patterns argument and filter expression. Using rigid
quoting with curly braces around regular expressions is
recommended. Note that regular expressions are always
anchored; that is, the expression is assumed to begin
matching at the beginning of an object name and end
matching at the end of an object name. You can widen the
search by adding ".*" at the beginning or end of the
expressions, as needed.

The -regexp and -exact options are mutually exclusive; you
can use only one.

-exact Considers wildcards to be plain characters, and does not
interpret their meaning as wildcards.

The -regexp and -exact options are mutually exclusive; you
can use only one.

-nocase Makes matches case-insensitive, both for the patterns
argument and for the ==, =~, and !~ filter operators.

-filter expression Filters the collection with the specified expression. For each
pin in the collection, the expression is evaluated based on
the pin's attributes. If the expression evaluates to true, the
pin is included in the result.

© 2021 Synopsys, Inc. Synplify Pro for Microchip Edition Command Reference

194

Synopsys Confidential Information June 2021



Query Commands

Tcl Find, Expand, and Collection Commands

patterns

-of _objects objects

Creates a collection of leaf-cell pins whose full names match
the specified patterns. Patterns can include the asterisk (*)
and question mark (?) wildcard characters. Pattern
matching is case sensitive unless you use the -nocase
option.

When using the patterns argument, the command searches
all pins of leaf cells to match the patterns argument on their
full names regardless of their hierarchical level.

The patterns and -of_objects arguments are mutually
exclusive; you can specify only one. If you do not specify any
of these arguments, the command uses the * (asterisk) as
the default pattern.

Creates a collection of leaf-cell pins connected to the
specified objects. Each object is a named leaf cell, a net, or
a collection of these objects. The patterns and -of_objects
arguments are mutually exclusive; you can specify only
one. If you do not specify any of these arguments, the
command uses the * (asterisk) as the default pattern.

-print Prints the contents of the collection.
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get_nets

Use this command in the .fdc constraint file to return a collection of objects
and/or in the HDL Analyst view to return a Tcl list of objects.

Creates a collection of nets from the current design.

Syntax
This is the supported syntax for the get_nets command:

get_nets
[-hierarchical]
[-nocase]
[-regexp | -exact]
[-filter expression]
[pattern | -of_objects objects]

Arguments

-hierarchical Searches each level of hierarchy for nets in the design relative
to the current instance. The object name at a particular level
must match the patterns. For the net bl ockl/ muxsel a
hierarchical search uses nuxsel to find this net name.

By default, the search is not hierarchical.

-nocase Ensures that matches are case-insensitive. This applies for
both the patterns argument and the filter operators (=~ and

).

-regexp Views the patterns argument as a regular expression rather
than a simple wildcard pattern. The behavior of the filter
operators (=~ and !~) have also been modified to use regular
expression rather than simple wildcard patterns.

When using the - r egexp option, be careful how you quote the
patterns argument and filter expression. Rigidly quoting with
curly braces around regular expressions is recommended.
Regular expressions are always anchored; that is, the
expression assumes matching begins at the beginning of the
object name and ends matching at the end of an object name.
You can expand the search by adding ". *" to the beginning or
end of the expressions, as needed.
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-filter expressions  Filters the collection with the specified expression.

For any nets in the collection, the expression is evaluated
based on the net’s attributes. If the expression evaluates to
true, the net is included in the result.

pattern Creates a collection of nets whose names match the specified
patterns. Patterns can include the * (asterisk) and ? (question
mark) wildcard characters. Pattern matching is case sensitive
unless you use the -nocase option.

The patterns and -of_objects arguments are mutually exclusive;
you can specify only one. If you do not specify any of these
arguments, the command uses * (asterisk) as the default
pattern.

-of_objects objects Creates a collection of nets connected to the specified objects.
Each object can be a pin, port, or cell.

Examples

The following example creates a collection of nets connected to a collection of
pins.

set pinsel [get _pins {o regl.Qo_reg2. Q]
get _nets -of _objects $pinsel

The following example creates a collection of nets connected to the E pin of
any cell in the modulex_inst hierarchy.

get nets {*.*} -filter {@ins =~ nodul ex_inst.*. E}

get_pins

Use this command in the .fdc constraint file to return a collection of objects
and/or in the HDL Analyst view to return a Tcl list of objects. Creates a
collection of pins from the current design that match the specified criteria.

When used without -hierarchical, include a dot (.) as a pin separator between
the name of the instance and the pin name. Not including the hierarchy
separator results in a warning message.
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Syntax
This is the supported syntax for the get_pins command:

get_pins
[-hierarchical]
[-nocase]
[-regexp | -exact]
[-filter expression]
[pattern |-of _objects objects [-leaf]

Arguments
-hierarchical

Searches each level of hierarchy for pins, relative to the current
instance, and reports all instances with that pin name. By default,
searches are not hierarchical.

You can use wildcards with the -hier argument. The object name at a
particular level must match the pattern. For the cell blockl/adder/D|[0], a
hierarchical search uses adder/DI[0] to find pin names.

The pin separator is not required with -hier, although it is required if you
use get_pins without -hier (see Examples of get_pins, on page 199).
However, when narrowing searches by specifying instance names as well
as pin names, make sure to include the hierarchy separator. Otherwise,
you will not get any search results:

% get _pins -hier {*reset_pipe*Q@
{}

%get_pins -hier {*reset_pipe*. Q
{t:sysip_inst.l _haps80 core\.l _unr_clk_gen\.reset_pipe[0].Q

t:sysip_inst.l_haps80_core\.l_unr_clk _gen\.reset_pipe[l].Q
t:sysip_inst.l_haps80 core\.l _unr_clk gen\.reset pipe[2].Q
t:sysip_inst.l_haps80 core\.l _unr_clk gen\.reset pipe[3].Q
t:sysip_inst.l_haps80 core\.l _unr_clk gen\.reset pipe[4].Q
t:sysip_inst.l_haps80_core\.l_unr_cl k_gen\.reset_pipe[5].Q
t:sysip_inst.l_haps80 core\.l _unr_clk _gen\.reset pipe[6].Q
t:sysip_inst.l_haps80 core\.l _unr_clk _gen\.reset _pipe 0[7].C

You cannot use the -hierarchical option with the -of_objects option.
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-nocase
Ensures that matches are case-insensitive. This applies for both the
pattern argument and the filter operators (== and !=).

-regexpl|-exact
Views the patterns argument as a regular expression rather than a
simple wildcard pattern. The behavior of the filter operators (== and !=)
have also been modified to use regular expressions rather than simple
wildcard patterns. When using the -regexp option, be careful how you
quote the patterns argument and filter expression. Rigidly quoting with
curly braces around regular expressions is recommended. Regular
expressions are always anchored; that is, the expression assumes
matching begins at the beginning of the object name and ends matching
at the end of an object name. You can expand the search by adding ".*"
to the beginning or end of the expressions, as needed. he -exact option
treats wildcards as plain characters, so the meanings of these wildcard
are not interpreted.

-filter expressions
Filters the collection with the specified expression. For each pin in the
collection, the expression is evaluated based on the pin’s attributes. If
the expression evaluates to true, the pin is included in the result.

pattern]-of_objects objects [-leaf]
Creates a collection of pins whose names match the specified patterns.
Patterns can include the * (asterisk) and ? (question mark) wildcard
characters. Pattern matching is case sensitive unless you use the -nocase
option. The -of objects option creates a collection of pins connected to the
specified objects. Each object can be a cell or net. By default, the
command considers only pins connected to the specified nets at the
same hierarchical level. To consider only pins connected to leaf cells on
the specified nets, use the -leaf option (the tool can cross hierarchical
boundaries to find pins on leaf cells). You cannot use the -hierarchical
option with the -of_objects option.

Examples of get_pins
This example creates a collection of all pins in the design.
get _pins -hier *. *

This example shows that without a separator, the command returns no
results and generates a warning message:

%get pins {Q
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Warning: No pin separator ('.') specified. Pattern nmust include a
pi n separat or.

The following example creates a collection of pins from the top-level hierarchy
that match the regular expression.

get_pins -regexp {.*\.ena}

The following example creates a collection of pins throughout the hierarchy
that match the regular expression.

get_pins -hier - regexp {.*\.ena}

This example illustrates that you do not need the pin separator when you
specify the -hier argument:

%get _pins -hier {Q

{t: haps_system capi m capi _di[0].Qt: haps_system capi mcapi _di[1].Q
t: haps_systemcapimcapi _di[2].Qt:haps_systemcapimcapi _di[3].Q
: haps_system capi mcapi _di[4].Q t: haps_systemcapimcapi _di[5].Q
: haps_system capi mcapi _di[6].Q t:haps_systemcapimcapi _di[7].Q
:haps_system capi mcapi _di[8].Q t: haps_systemcapimcapi _di[9].Q
: haps_syst em capi m capi _di [ 10]. Q

: haps_system capi m capi _di [11] . Q

— — o~ — —+

The next example creates a collection of hierarchical pin names for the library
cell pin DQSFOUND, and for each instantiation of a library cell named
PHASER_IN_PHY.

get pins -filter {@ame == DQBFOUND} -of objects [get _cells -hier
* -filter {@nst_of == PHASER | N _PHY}]

The following example creates a collection of library cell pins with the string
DRCK in its name, for each instantiation of a library cell with the string
BSCAN in its name. Whenever you use wildcards to match names, make sure
to specify the "=~" operator instead of the "==" operator.

[get_pins -filter {@ane=~*DRCK} -of _objects [get_cells -hier *
-filter {@ier_rtl_name =~ *BSCAN‘}]]
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get_ports

Use this command in the .fdc constraint file to return a collection of objects
and/or in the HDL Analyst view to return a Tcl list of objects.

Creates a collection of top-level ports from that match the specified criteria.

Syntax
This is the supported syntax for the get ports command:
get_ports

[-nocase]

[-regexp]

[-filter expression]

[pattern]
Arguments
-nocase Ensures that matches are case-insensitive. This applies for both

the patterns argument and the filter operators (=~ and !~).

-regexp Views the patterns argument as a regular expression rather

than a simple wildcard pattern. The behavior of the filter
operators (=~ and !~) have also been modified to use regular
expression rather than simple wildcard patterns.

When using the - r egexp option, be careful how you quote the
patterns argument and filter expression. Rigidly quoting with
curly braces around regular expressions is recommended.
Regular expressions are always anchored; that is, the
expression assumes matching begins at the beginning of the
object name and ends matching at the end of an object name.
You can expand the search by adding ". *" to the beginning or
end of the expressions, as needed.

-filter expressions Filters the collection with the specified expression.

For each port in the collection, the expression is evaluated
based on the port’s attributes. If the expression evaluates to
true, the port is included in the result.
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pattern Creates a collection of ports whose names match the specified
patterns. Patterns can include the * (asterisk) and ? (question
mark) wildcard characters. Pattern matching is case sensitive
unless you use the -nocase option.

The patterns and -of_objects arguments are mutually exclusive,
so only specify one of them. If you do not specify either
argument, the command uses * (asterisk) as the default pattern.

Examples
The following example queries all input ports beginning with mode.

get _ports node* -filter {@lirection =~ input}

object_list

Translates object strings returned by query commands in the HDL Analyst
tool to proper Tcl lists. This allows you to process the results using Tcl
commands.

Syntax
This is the supported syntax for the object_list command:

object_list objectString

Arguments

objectString Converts the object string returned by an FDC query command
to proper Tcl lists.

Examples

For example:

% foreach x [object list [get cells -hier {q[*]}]]
{puts "Match: $x"}

Mat ch: i:modul ex_inst.q[7:0]
Match: i:nmoduley inst\[4\].q[7:0]
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report_timing

Alternatively, use this command to generate timing reports for a design from
the Tcl window, which follows the standards set for the Design Compiler or
PrimeTime® commands. One advantage this command has over the Timing
Analyst GUI in the synthesis tool is that the filter options (for example,
-from/-to/-through) support the FDC query commands.

Syntax
This is the supported syntax for the report_timing command:

report_timing
[-delay_type max]
[-fall_from clock]
[-fall_to clock]
[-file string]
[-from list]
[-max_paths int]
[-nworst 1]
[-path_type full]
[-rise_from clock]
[-rise_to clock]
[-slack_margin float]
[-through instance]
[-to list]

Arguments

-delay_type max Specifies the path type for the end points. This default value
can be specified as max; the maximum delay. All other values
are ignored.

-fall_from clock Reports paths from the falling edge of the specified clock. For a
given clock, selects the starting points for paths clocked on the
falling edge of the clock source.

-fall_to clock Reports paths to the falling edge of the specified clock. For a
given clock, selects the ending points for paths clocked on the
falling edge of the clock source.

-file string Allows the report to be re-directed to the specified file.
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-from list Reports paths from the specified port, register, register pin, or
clock.
-max_paths int Reports the number of paths to report for the path group. The

default integer value is 1.

-nworst 1 Reports the maximum number of paths to report for each
timing end point. The default is 1, which reports the single
worst path at a given end point. All other values are ignored.

-path_type full Specifies how to display the timing path. This default value can
be specified as full. A complete timing report is displayed, for
example, containing timing start and end points, required
time, and slack. All other values are ignored.

-rise_from clock Reports paths from the rising edge of the specified clock. For a
given clock, selects the starting points for paths clocked on the
rising edge of the clock source.

-rise_to clock Reports paths to the rising edge of the specified clock. For a
given clock, selects the ending points for paths clocked on the
rising edge of the clock source.

-slack_margin float Reports paths for the specified slack margin, which allows you
to specify a floating point value for the range of worst slack
times.

-through instance Reports paths that pass through the specified pins or nets.

-to list Reports paths to the specified ports, register, register pin, or
clock.

Examples
The following example reports timing to all registers clocked by clkb.
%eport _timng -to [all _registers -clock {cl kb}]

#H##E START OF TI M NG REPCORT ###HH]
# Timng Report witten on Mon Dec 16 10: 35: 02 2013|
#

Top vi ew. top

Request ed Frequency: 50.0 Mt

Wre | oad node: top

Pat hs request ed:

to: nmodul ey_i nst. ga[ 7: 0] nodul ey_i nst. gb[ 7: 0]

Wbrst From To Path | nformation

khkkkhkkhkkhhhkkhhhkhhdxkhdhhdhkddhkddhkxk*x
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Path information for path nunber 1:
Request ed Peri od:

- Setup tine:

10. 000

+ Jock delay at ending point:

Required ti me:

Sl ack

Nurber of logic |evel(s):

Starting point:
Endi ng poi nt:

Propagation tine:

The start point is clocked by
The end point is clocked by

I nst ance/ Net
Narre

c[7:0]
c[0]

c_i buf[0]
c_i buf[0]
c_c[0]

nmodul ey_i nst. ga[ 0]

Type
Port
Net

| BUF
| BUF
Net
FDE

Pin Pin
Narre Dr
c[ 0] I'n
| In
O Qut
D In

-1. 000
0. 909
11. 909

0. 000
11. 909

1

c[7:0] / c[0]
nmodul ey_inst.qga[0] / D
clkb [rising]
clkb [rising] on pin C

Del ay
0. 000
0. 000
0. 000
0. 000

Arrival No. of
Ti me Fan Qut(s)

0.

0.
0.

0.

000 -
1
000 -
000 -
1
000 -

Pat h del ay conpensated for clock skew O ock skewis added to cl ock-to-out
value, and is subtracted fromsetup tine val ue

End cl ock pat h:

I nst ance/ Net
Nane

cl kb
cl kb

cl kb_I| BUFG
cl kb_I| BUFG
cl kb_i

nmodul ey_i nst . ga[ O]

Type

Net

| BUF
| BUF
Net
FDE

Pin Pin
Nane Dr
c[ 0] In
| In
O Qut
D In

#H#E END OF Tl M NG REPORT #####]
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Synopsys Standard Collection Commands

There are a number of Synopsys standard SDC collection commands that can
be included in the .fdc file. These commands are not compatible with the
define_scope_collection command.

The collection commands let you manipulate or operate on multiple design
objects simultaneously by creating, copying, evaluating, iterating, and
filtering collections. This section describes the syntax for the following collec-
tion commands supported in the FPGA synthesis tools; for the complete
syntax for these commands, refer to the Design Compiler documentation.

add_to_collection append_to_collection
copy_collection foreach_in_collection
get_object_name index_collection
remove_from_collection sizeof_collection

Use these commands in the FDC constraint file to facilitate the shared
scripting of constraint specifications between the FPGA synthesis and Design
Compiler tools.

add_to_collection

Adds objects to a collection that results in a new collection. The base collec-
tion remains unchanged. Any duplicate objects in the resulting collection are
automatically removed from the collection.

Syntax

This is the supported syntax for the add_to_collection command:

add_to_collection
[collection1]
[objectSpec]

© 2021 Synopsys, Inc. Synplify Pro for Microchip Edition Command Reference
206 Synopsys Confidential Information June 2021



Synopsys Standard Collection Commands Tcl Find, Expand, and Collection Commands

Arguments

collectionl Specifies the base collection to which objects are to be added. This
collection is copied to a resulting collection, where objects matching
objectSpec are added to this results collection.

objectSpec Specifies a list of named objects or collections to add.

Depending on the base collection type (heterogeneous or
homogeneous), the searches and resulting collection may differ. For
more information, see Heterogeneous Base Collection , on page 207
and Homogeneous Base Collection , on page 207.

Description

The add_to_collection command allows you to add elements to a collection. The
result is a new collection representing the objects added from the objectSpec
list to the base collection. Objects are duplicated in the resulting collection,
unless they are removed using the -unique option. If objectSpec is empty, then
the new collection is a copy of the base collection. Depending on the base
collection type (heterogeneous or homogeneous), the searches and resulting
collection may differ.

Heterogeneous Base Collection

If the base collection is heterogeneous, then only collections are added to the
resulting collection. All implicit elements of the objectSpec list are ignored.

Homogeneous Base Collection

If the base collection is homogeneous and any elements of objectSpec are not
collections, then the command searches the design using the object class of
the base collection.

When collectionl is an empty collection, special rules apply to objectSpec. If
objectSpec is not empty, at least one homogeneous collection must be in the
objectSpec list (can be any position in the list). The first homogeneous collec-
tion in the objectSpec list becomes the base collection and sets the object
class for the function.
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Examples

set result [get_cells{u*}]
get _obj ect nane $result

==> {u:ul} {i:u2} {i:u3}

set result_1 [add to _collection $result {get _cells {i:clkb_ | BUFG]
get _object_nane $result 1

==> {i:ul} {i:u2} {i:u3} {i:clkb_IBUG

See Also

¢ append_to_collection

append_to_collection

Adds objects to the collection specified by a variable, modifying its value.
Objects must be unique, since duplicate objects are not supported.

Syntax
This is the supported syntax for the append_to_collection command:

append_to_collection]
[variableName]
[objectSpec]

Arguments

variableName Specifies a variable name. The objects matching objectSpec
are added to the collection referenced by this variable.

objectSpec Specifies a list of named objects or collections to add to the
resulting collection.

Description

The append_to_collection command allows you to add elements to a collection.
This command treats the variableName option as a collection, and appends
all the elements of objectSpec to that collection. If the variable does not exist,
it creates a collection with elements from the objectSpec as its value. So, a
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collection is created that was referenced initially by variableName or
automatically if the variableName was not provided. However, if the variable
exists but does not contain a collection, then an error is generated.

The append_to_collection command can be more efficient than the add_to_collec-
tion command (add_to_collection, on page 206) when you are building a collec-
tion in a loop.

Examples

set result [get cells{u*}]
get _object _nane $result

==> {u:u1} {i:u2} {i:u3}

append_to_col l ection result {get_cells {i:clkb_|IBUFG]
get _obj ect _nane $result

==> {i:ul} {i:u2} {i:u3} {i:clkb_IBUWFG

See Also

* add_to_collection

copy_collection

Duplicates the contents of a collection that results a new collection. The base
collection remains unchanged.

Syntax
This is the supported syntax for the copy_collection command:

copy_collection

[collectionl]
Arguments
collectionl Specifies the collection to be copied.
Synplify Pro for Microchip Edition Command Reference © 2021 Synopsys, Inc.
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Description

The copy_collection command is an efficient mechanism to create a duplicate of
an existing collection. It is sometimes more efficient and usually sufficient to
simply have more than one variable referencing the same collection. However,
whenever you want to copy the collection instead of reference it, use the
copy_collection command.

Be aware that if an empty string is used for the collectionl argument, the
command returns an empty string. This means that a copy of the empty
collection is an empty collection.

Examples

set insts [define_collection {ul u2 u3 u4}]
set result_copy [copy_collection $insts]
get _obj ect _nanme $resul t_copy

==> {ul} {u2} {u3} {u4}

foreach_in_collection

Iterates on the elements of a collection.

Syntax
This is the supported syntax for the foreach_in_collection command:

foreach_in_collection

[iterationVariable]
[collections]
[body]
Arguments
iterationVariable Specifies the name of the iteration variable. It is set to a

collection of one object. Any argument that accepts
collections as an argument can also accept the
iterationVariable, as they are the same data type.

collections Specifies a list of collections on which to iterate.
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body Specifies a script to execute for the iteration. If the body of
the iteration is modifying the netlist, all or part of the
collection involved in the iteration can be deleted. The
foreach_in_collection command is safe for such operations. A
message is generated that indicates the iteration ended
prematurely.

Description

The foreach_in_collection command is a Design Compiler and PrimeTime
command used to iterate on each element of a collection. This command
requires the following arguments: an iteration variable (do not specify a list),
the collection on which to iterate, and the script to apply for each iteration.

You can nest this command within other control structures, including
another foreach_in_collection command.

You can include the command in an FDC file, but if you are using the Tcl
window and the HDL Analyst tool, you must use the standard Tcl foreach
command instead of foreach_in_collection.

Examples

The following examples show valid methods to reference a collection for this
command:

set seqgs[all _registers]
set port[all_inputs]

foreach_in_collection
foreach_in_collection
foreach_in_col |l ection
foreach_in_col |l ection
foreach_in_col |l ection

[al | _registers] {body}
$ports {body}

[list $seqgs $ports] {body}
{$seqgs} {body}

{$seqs $ports} {body}

X X X X X
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get_object_name

Returns a list of names for objects in a collection.

Syntax
This is the supported syntax for the get_object_name command:

get_object_name
[collection1]

Arguments

collectionl Specifies the name of the collection that contains the
requested objects.

Examples

set cl[define_collection {ul u2}]
get _object nane $cil

==> {ul} {u2}

index_collection
Creates a new collection that contains only the single object for the index
specified in the base collection. You must provide an index to the collection.
Syntax
This is the supported syntax for the index_collection command:

index_collection
[collection1]

[index]
Arguments
collectionl Specifies the collection to be searched.
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index Specifies an index to the collection. Allowed values are
integers from O to sizeof_collection -1.

Description

You can use the index_collection command to extract a single object from a
collection. The result is a new collection that contains only this object. The
range of indices can be from 0 to one less than the size of the collection. If the
specified index is outside that range, an error message is generated.

Commands that create a collection of objects do not impose a specific order
on the collection, but they do generate the objects in the same, predictable
order each time. Applications that support the sorting of collections allow you
to impose a specific order on a collection.

If you use an empty string for the collection1 argument, then any index to the
empty collection is not valid. This results in an empty collection and gener-
ates an error message.

Be aware that all collections cannot be indexed.

Examples

set cl[get_cells {ul u2}]]
get _obj ect _nane [index_col |l ection $cl 0]

==> {ul}

See Also

* sizeof collection
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remove_from_collection

Removes objects from a collection that results in a new collection. The base
collection remains unchanged.

Syntax
This is the supported syntax for the remove_from_collection command:

remove_from_collection
[-intersect]
[collection1]
[objectSpec]

Arguments

-intersect Removes objects from the base collection that are not found
in objectSpec.
By default, when this option is not specified, objects are
removed from the base collection that are found in the
objectSpec.

collection1 Specifies the base collection that is copied to a resulting
collection, where objects matching objectSpec are removed
from this results collection.

objectSpec Specifies a list of named objects or collections to remove.

The object class for each element in this list must be the
same in the base collection. If the name matches an existing
collection, that collection is used. Otherwise, objects are
searched in the design using the object class for the base
collection.

Description

The remove_from_collection command removes elements from a collection and
creates a new collection.

When the -intersect option is not specified and there are no matches for
objectSpec, the resulting collection is just a copy of the base collection. If
everything in the collectionl option matches the objectSpec, this results in an
empty collection. When using the -intersect option, nothing is removed from
the resulting collection.
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Heterogeneous Base Collection

If the base collection is heterogeneous, then any elements of objectSpec that
are not collections are ignored.

Homogeneous Base Collection

If the base collection is homogeneous and any elements of objectSpec are not
collections, then the command searches the design using the object class of
the base collection.

Examples

set cl[define_collection {ul u2 u3}]]
set c2[define_collection {u2 u3 ud}]]
get _object _nane [renove fromcollection $cl $c2]

==> {ul}

get _obj ect_nane [renove _fromcoll ection $c2 $ci]

==> {u4}

get _object_nane [renove fromcollection -intersect $cl $c2]

==> {u2} {us}

See Also

* add to_collection

sizeof collection

Returns the number of objects in a collection.

Syntax

This is the supported syntax for the sizeof collection command:

sizeof collection
[collection1]
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Arguments

collection1 Specifies the name of the collection for which the number of
objects is requested.
If no collection argument is specified, then the command
returns O.

Examples

set cl[define_collection {ul u2 u3}]
si zeof _collection $cl

==> 3
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CHAPTER 4

Constraint Commands

The SCOPE (Synthesis Constraints OPtimization Environment®) editor
automatically generates syntax for synthesis constraints. Enter information
in the SCOPE tabs, panels, columns, and pull-downs to define constraints
and parameter values. You can also drag and drop objects from the HDL
Analyst Ul to populate values in the constraint fields.

This interface creates Tcl-format Synopsys Standard timing constraints and
Synplify-style design constraints and saves the syntax to an FPGA design
constraints (FDC) file that is automatically added to your synthesis project.
See Constraint Types, on page 124 for definitions of synthesis constraints.

Topics in this section include:
* SCOPE Constraints Editor, on page 218
* SCOPE Tabs, on page 219
* Industry I/0 Standards, on page 244
* Delay Path Timing Exceptions, on page 247
¢ Specifying From, To, and Through Points, on page 252
* Conflict Resolution for Timing Exceptions, on page 260

You can also specify Tcl equivalents for the timing and design constraints
that are included in the SCOPE editor or a constraint file. For the constraint
command syntax, see:

¢ Timing Constraints, on page 264.
¢ Design Constraints, on page 307
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SCOPE Constraints Editor

The SCOPE editor contains a number of panels for creating and managing
timing constraints and design attributes. This GUI offers the easiest way to
create constraint files for your project. The syntax is saved to a file using an
FDC extension and can be included in your design project.

consfrait.filc*

Cumrent Desion: | <Top Levels w| [T ched: Corstraints

Enablel hame |Object Period |‘L'\'a'-'e‘orm| Add |Clock Group | Latency | Uncertainty | Comement [il
b L
L |
|
e |
s |
| — x|

Clodis Generated Clocks | Colactions | InpubsQutputs Recishars DCielay Paths Adtribtes IjO Standards Compls Points =

From this editor, you specify timing constraints for clocks, ports, and nets as
well as design constraints such as attributes, collections, and compile points.
However, you cannot set black-box constraints from the SCOPE window.

To bring up the editor, use one of the following methods from the Project view:

* For a new file (the project file is open and the design is compiled):

— Choose File->New-> FPGA Design Constraints; select FPGA Constraint File
(SCOPE).

— Click the SCOPE icon in the toolbar; select FPGA Constraint File (SCOPE).

* You can also open the editor using an existing constraint file.
Double-click the constraint file (FDC), or use File->Open, specifying the
file type as FPGA Design Constraints File (*.fdc).

For more information about using FPGA timing constraints with your project,
see Using the SCOPE Editor, on page 122 in the User Guide.
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SCOPE Tabs

Here is a summary of the constraints created through the SCOPE editor:

SCOPE Panel
Clocks
Generated Clocks
Collections
Inputs/Outputs
Registers

Delay Paths
Attributes

I/O Standards
Compile Points

TCL View

See ...

Clocks, on page 220
Generated Clocks, on page 225
Collections, on page 227
Inputs/Outputs, on page 230
Registers, on page 233

Delay Paths, on page 234
Attributes, on page 237

1/0 Standards, on page 238
Compile Points, on page 239
TCL View, on page 242

If you choose an object from a SCOPE pull-down menu, it has the appropriate
prefix appended automatically. If you drag and drop an object from an RTL
view, for example, make sure to add the prefix appropriate to the language
used for the module. See Naming Rule Syntax Commands, on page 304 for

details.
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Clocks
You use the Clocks panel of the SCOPE spreadsheet to define a signal as a
clock.
|:| Enable | Mame: Chjact | Pericd |'|.'ia'.'efum| Aod | Clodk Group Latency Uncertainty Comment |
2

-

|

The Clocks panel includes the following options:

Field

Name

Period

Waveform

Add Delay
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Description

Specifies the clock object name.

Clocks can be defined on the following objects:
e Pins

* Ports

* Nets

For virtual clocks, the field must contain a unique name not
associated with any port, pin, or net in the design.

Specifies the clock period in nanoseconds. This is the
minimum time over which the clock waveform repeats. The
period must be greater than zero.

Specifies the rise and fall edge times for the clock waveforms of
the clock in nanoseconds, over an entire clock period. The first
time in the list is a rising transition, typically the first rising
transition after time zero. There must be two edges, and they
are assumed to be rise and then fall. The edges must be
monotonically increasing. If you do not specify this option, a
default waveform is assumed, which has a rise edge of 0.0 and
a fall edge of period/2.

Specifies whether to add this delay to the existing clock or to
overwrite it. Use this option when multiple clocks must be
specified on the same source for simultaneous analysis with
different clock waveforms. When you use this option, you
must also specify the clock, and clocks with the same source
must have different names.

Synplify Pro for Microchip Edition Command Reference
Synopsys Confidential Information June 2021



SCOPE Tabs Constraint Commands

Field Description

Clock Group Assigns clocks to asynchronous clock groups. The clock
grouping is inclusionary (for example, clk2 and clk3 can each be
related to clkl without being related to each other). For details,
see Clock Groups , on page 221.

Latency Specifies the clock latency applied to clock ports and clock
aliases. Applying the latency constraint on a port can be used
to model the off-chip clock delays in a multichip environment.
Clock latency can only:

e Apply to clocks defined on input ports.
* Be used for source latency.
« Apply to port clock objects.

Uncertainty Specifies the clock uncertainty (skew characteristics) of the
specified clock networks. You can only apply latency to clock
objects.

Clock Groups

Clock grouping is associative; two clocks can be asynchronous to each other
but both can be synchronous with a third clock.

The SCOPE GUI prompts you for a clock group for each clock that you define.
By default, the tool assigns all clocks to the default clock group. When you
add a name that differs from the default clock group name, the clock is
assigned its own clock group and is asynchronous to the default clock group
as well as all other named clock groups.

This section presents scenarios for defining clocks and includes the following
examples:

¢ Example 1 - SCOPE Definition

¢ Example 2 - Equivalent Tcl Syntax

* Example 3 - Establish Clock Relationships
* Example 4 - Using a Single Group Option
¢ Example 5 - Legacy Clock Grouping
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Example 1 - SCOPE Definition

A design has three clocks, clkl, clk2, clk3. You want clkl and clk2 to be in the
same clock group—synchronous to each other but asynchronous to clk3. You
can apply this clock definition by adding a name in the Clock Group column, as
shown below:

arent Desigr: | <Top Level=> - |f Chedk Corstranis
_l Enshil | Hanie Ohyject Period \avafoam add dockGoup | Lstency | U
¥l il i 7 d groupl
| <lkZ rzlkd 10 [ araupl
~ clid did 1 ] <defauft>

|r».|u. ulu.pln..l.-

This definition assigns clk1l and clk2 to clock group groupl, synchronous to
each other and asynchronous to clk3. The equivalent Tcl command for this
appears in the text editor window as follows:

set _cl ock_groups -derive -asynchronous -name {groupl}
-group {{c:clkl} {c:clk2}}

Example 2 - Equivalent Tcl Syntax

A design has three clocks: clkl, clk2, clk3. Use the following commands to set
clk2 synchronous to clk3, but asynchronous to clkl:

set _cl ock_groups -asynchronous -group [get_clocks {cl k3 cl k2}]

set _cl ock_groups -asynchronous -group [get_clocks {cl kl1}]
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Example 3 - Establish Clock Relationships
A design has the following clocks defined:

create_clock -name {cl ka} {p:clka} -period 10 -waveform {0 5.0}
create_clock -name {cl kb} {p:clkb} -period 20 -waveform {0 10. 0}
create _clock -name {ny_sys} {p:sys_clk} -period 200 -waveform{0
100. 0}

You want to define clka and clkb as asynchronous to each other and clka and
clkb as synchronous to my_sys.

For the tool to establish these relationships, multiple -group options are
needed in a single set_clock groups command. Clocks defined by the first
—group option are asynchronous to clocks in the subsequent -group option.
Therefore, you can use the following syntax to establish the relationships
described above:

set _cl ock_groups -asynchronous -group [get_clocks {cl ka}]
-group [get _cl ocks {cl kb}]

Example 4 - Using a Single Group Option
set_clock_groups has a unique behavior when a single -group option is specified

in the command. For this example, the following constraint specifications are
applied:

set _cl ock_groups -asynchronous -name {default_cl kgroup_0} -group
[get cl ocks {clka ny_sys}]

set _cl ock_groups -asynchronous -name {default_cl kgroup_1} -group
[get cl ocks {cl kb ny_sys}]

The first statement assigns clka AND my_sys as asynchronous to clkb, and the
second statement assigns clkb AND my_sys as asynchronous to clka. Therefore,
with this specification, all three clocks are established as asynchronous to
each other.

Example 5 - Legacy Clock Grouping

This section shows how the legacy clock group definitions (Synplify-style
timing constraints) are converted to the Synopsys standard timing syntax
(FDC). Legacy clock grouping can be represented through Synopsys standard
constraints, but the multi-grouping in the Synopsys standard constraints
cannot be represented in legacy constraints.
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For example, the following table shows legacy clock definitions and their
translated FDC equivalents:

Legacy define_clock -name{clka}{p:clka}-period 10 -clockgroup default_clkgroup_0
Definition  define_clock -name {clkb}p:clkb} -freq 150 -clockgroup default_clkgroup_1
define_clock -name {clkc} {p:clkc} -freq 200 -clockgroup default_clkgroup_1

FDC ###==== BEGIN Clocks - (Populated from SCOPE tab, do not edit)

Definition  create_clock -name {clka} {p:clka} -period 10 -waveform {0 5.0}
create_clock -name {clkb} {p:clkb} -period 6.667 -waveform {0 3.3335}
create_clock -name {clkc} {p:clkc} -period 5.0 -waveform {0 2.5}

set_clock_groups -derive -name default_clkgroup_0 -asynchronous
-group {c:clka}

set_clock_groups -derive -name default_clkgroup_1 -asynchronous
-group {c:clkb c:clkc}

###==== END Clocks

The create_generated_clock constraints used in legacy SDC are preserved in
FDC. The -derive option directs the create_generated clock command to inherit
the -source clock group. This behavior is unique to FDC and is an extension of
the Synopsys SDC standard functionality.

See Also

For equivalent Tcl syntax, see the following sections:
e create_clock, on page 265
* create_generated_clock, on page 267
e set clock_latency, on page 279

¢ set clock uncertainty, on page 281

For information about other SCOPE panels, see SCOPE Tabs, on page 219.
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Generated Clocks

Use the Generated Clocks panel of the SCOPE spreadsheet to define a signal as
a generated clock. The equivalent Tcl constraint is create_generated_clock; its
syntax is described in create_generated_clock, on page 267.

Generated Clocks

Source |li‘b:|bct |r‘1ubcr Clowk: | Generate Type |G:ﬂ=rub=Parum|:|: “ﬂmr1uddm|ﬁadﬂmPamL:rs| Invert | e | Comment

The Generated Clocks panel includes the following options:

Field

Name

Source

Object

Master Clock

Description

Specifies the name of the generated clock.

If this option is not used, the clock gets the name of the first
clock source specified in the source.

Specifies the master clock pin, which is either a master
clock source pin or a fanout pin of the master clock driving
the generated clock definition pin. The clock waveform at
the master pin is used for deriving the generated clock
waveform.

Generated clocks can be defined on the following objects:
e Pins

Ports

* Nets

* Instances

Specifies the master clock to be used for this generated
clock, when multiple clocks fan into the master pin.
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Field Description

Generate Type Specifies any of the following:

edges - Specifies a list of integers that represents edges from
the source clock that are to form the edges of the generated
clock. The edges are interpreted as alternating rising and
falling edges and each edge must not be less than its
previous edge. The number of edges must be an odd number
and not less than 3 to make one full clock cycle of the
generated clock waveform. For example, 1 represents the
first source edge, 2 represents the second source edge, and
so on.

divide_by - Specifies the frequency division factor. If the
divide factor value is 2, the generated clock period is twice
as long as the master clock period.

multiply_by - Specifies the frequency multiplication factor. If
the multiply factor value is 3, the generated clock period is
one-third as long as the master clock period.

Generate Parameters  Specifies integers that define the type of generated clock.

Generate Modifier Defines the secondary characteristics of the generated
clock.

Modify Parameters Defines modifier values of the generated clock.

Invert Specifies whether to use invert - Inverts the generated clock

signal (in the case of frequency multiplication and division).

Add Either add this clock to the existing clock or overwrite it.
Use this option when multiple generated clocks must be
specified on the same source, because multiple clocks fan
into the master pin. Ideally, one generated clock must be
specified for each clock that fans into the master pin. If you
specify this option, you must also specify the clock and
master clock. The clocks with the same source must have
different names.

Examples

In the following example, the generated clock genclkl is created with the same
frequency as the source clock clkin, but its phase is shifted by 180. Each of
the edges of the generated clock shifts by 5 ns, which is specified by the
-edges and -edge_shift options.
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Example 1
Master Clock Clock Mame

create_generaled_clock -master_clock[ost :w

Source GenerateType  Modify Parameters Object

-add-sourcelget_ports {clkin}-edoes {12 3} -edaz_shift/5 5 5} [oet_pins {i_clkoendelk_aiCQuol

Generate Modifier

Generate Parameters

For this example, a generated clock is created with half the frequency of the

source clock.

Example 2

Generate Type

creale_generated_clock-name divelk-source [oet_ports {clkini]-divide _by 2 [oet_pins furn_divc k. SUTIOT

For more information about other SCOPE options, see SCOPE Tabs, on

page 219.

Collections

The Collections tab allows you to set constraints for a group of objects you
have defined as a collection with the Tcl command. For details, see Creating

and Using SCOPE Collections, on page 155 of the User Guide.
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Enable | Name | Command Comment
|
Collections
Field Description
Enable Enables the row.
Name Enter the collection name.
Command Select a collection creation command from the drop-down

menu. See Collection Commands , on page 228 for
descriptions of the commands.

Comment Enter comments that are included in the constraints file.

You can crossprobe the collection results to an HDL Analyst view. To do this,
right-click in the SCOPE cell and select the option Select in Analyst.

Collection Commands

You can use the collection commands on collections or Tcl lists. Tcl lists can
be just a single element long.
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To ...

Use this command ...

Create a collection

Copy a collection

Evaluate a collection

Concatenate a list to a
collection

Identify differences
between lists or
collections

Identify objects
common to a list and a
collection

Identify objects
common to two or more
collections

Identify objects that
belong exclusively to
only one list or
collection

set modules

To create and save a collection, assign it to a variable.
You can also use this command to create a collection
from any combination of single elements, TCL lists and
collections:

set modules [define_collection {v:top} {v:cpu} $mycoll $mylist]

Once you have created a collection, you can assign
constraints to it in the SCOPE interface.

set modules_copy $modules
This copies the collection, so that any change to $modules
does not affect $modules_copy.

c_print

This command returns all objects in a column format.
Use this for visual inspection.

c_list

This command returns a Tcl list of objects. Use this to
convert a collection to a list. You can manipulate a Tcl
list with standard Tcl list commands.

C_union

c_diff
Identifies differences between a list and a collection or
between two or more collections. Use the -print option to
display the results.

C_intersect
Use the -print option to display the results.

c_sub
Use the -print option to display the results.

c_symdiff

Use this to identify unique objects in a list and a
collection, or two or more collections. Use the -print
option to display the results.

For information about all SCOPE panels, see SCOPE Tabs, on page 219.
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Inputs/Outputs

The Inputs/Outputs panel models the interface of the FPGA with the outside
environment. You use it to specify delays outside the device.

|Enable | Delavape| Fort | Rise | Fall | Max | Min | Clock | Clock Fall |ﬁ|:||:| Delav| Value | Comment

Il

u_.lu

Inputs/Outputs

The Inputs/Outputs panel includes the following options:

Field Description

Delay Type Specifies whether the delay is an input or output delay.
Port Specifies the name of the port.

Rise Specifies that the delay is relative to the rising transition on

specified port.

Currently, the synthesis tool does not differentiate between
the rising and falling edges for the data transition arcs on the
specified ports. The worst case path delay is used instead.
However, the -rise option is preserved and forward annotated to
the place-and-route tool.

Fall Specifies that the delay is relative to the falling transition on
specified port
Currently, the synthesis tool does not differentiate between
the rising and falling edges for the data transition arcs on the
specified ports. The worst case path delay is used instead.
However, the -fall option is preserved and forward annotated to
the place-and-route tool.

Max Specifies that the delay value is relative to the longest path.

Note: The -max delay values are reported in the top-level log file
and are forward annotated to the place-and-route tool.

Min Specifies that the delay value is relative to the shortest path.

Note: The synthesis tool does not optimize for hold time
violations and only reports -min delay values in the

synl og/ t opLevel _f pga_mapper. srr_M n timing report
section of the log file. The -min delay values are forward

annotated to the place-and-route tool.
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Field Description

Clock Specifies the name of a clock for which the specified delay is
applied. If you specify the clock fall, you must also specify the
name of the clock.

Clock Fall Specifies that the delay relative to the falling edge of the clock.
For examples, see Input Delays , on page 231 and Output
Delays , on page 232.

Add Delay Specifies whether to add delay information to the existing
input delay or overwrite the input delay. For examples, see
Input Delays , on page 231 and Output Delays , on page 232.

Value Specifies the delay path value.

Input Delays
Here is how this constraint applies for input delays:

¢ Clock Fall - The default is the rising edge or rising transition of a reference
pin. If you specify clock fall, you must also specify the name of the clock.

* Add Delay - Use this option to capture information about multiple paths
leading to an input port relative to different clocks or clock edges.

For example, set_input_delay 5.0 -max -rise -clock phil {A} removes all
maximum rise input delay from A, because the -add_delay option is not
specified. Other input delays with different clocks or with -clock_fall are
removed.

In this example, the -add_delay option is specified as set_input_delay 5.0
-max -rise -clock phil -add_delay {A}. If there is an input maximum rise delay
for A relative to clock phil rising edge, the larger value is used. The
smaller value does not result in critical timing for maximum delay. For
minimum delay, the smaller value is used. If there is maximum rise
input delay relative to a different clock or different edge of the same
clock, it remains with the new delay.
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Output Delays
Here is how this constraint applies for output delays:

¢ Clock Fall - If you specify clock fall, you must also specify the name of the
clock.

¢ Add Delay - By using this option, you can capture information about
multiple paths leading from an output port relative to different clocks or
clock edges.

For example, the set_output_delay 5.0 -max -rise -clock phil {OUT1} command
removes all maximum rise output delays from OUT1, because the
-add_delay option is not specified. Other output delays with a different
clock or with the -clock_fall option are removed.

In this example, the -add_delay option is specified: set output delay 5.0 -max
-rise -clock phil -add_delay {Z}. If there is an output maximum rise delay for
Z relative to the clock phil rising edge, the larger value is used. The
smaller value does not result in critical timing for maximum delay. For
minimum delay, the smaller value is used. If there is a maximum rise
output delay relative to a different clock or different edge of the same
clock, it remains with the new delay.

Priority of Multiple I/O Constraints

You can specify multiple input and output delays constraints for the same
170 port. This is useful for cases where a port is driven by or feeds multiple
clocks. The priority of a constraint and its use in your design is determined
by a few factors:

* The software applies the tightest constraint for a given clock edge, and
ignores all others. All applicable constraints are reported in the timing
report.

* You can apply I/0 constraints on three levels, with the most specific
overriding the more global:

— Global (top-level netlist), for all inputs and outputs
— Port-level, for the whole bus
— Bit-level, for single bits
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If there are two bit constraints and two port constraints, the two bit
constraints override the two port constraints for that bit. The other bits
get the two port constraints. For example, take the following constraints:

a[3:0]3 clkl:r
a[3:0]3 clk2:r
a[0]2 clkl:r

In this case, port a[0] only gets one constraint of 2 ns. Ports a[1], a[2], and
a[3] get two constraints of 3 ns each.

* If at any given level (bit, port, global) there is a constraint with a refer-
ence clock specified, then any constraint without a reference clock is
ignored. In this example, the 1 ns constraint on port a0] is ignored.

a[0]2 clkl:r
a[0] 1
See Also
For equivalent Tcl syntax, see:
* set input_delay, on page 286
* set output_delay, on page 300

For information about all SCOPE panels, see SCOPE Tabs, on page 219.

Registers

This panel lets the advanced user add delays to paths feeding into/out of
registers, in order to further constrain critical paths. You use this constraint
to speed up the paths feeding a register. See set_reg_input_delay, on

page 303, and set_reg output delay, on page 304 for the equivalent Tcl
commands.

CurrentDesign: | <Top Level - ~| |l check Constraints |

=

Enable Il:lelav‘nrpe| Reqister | Rioute I camment
[+]

HEegistars
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The Registers SCOPE panel includes the following fields:

Field Description

Enabled (Required) Turn this on to enable the constraint.

Delay Type (Required) Specifies whether the delay is an input or output
delay.

Register (Required) Specifies the name of the register. If you have

initialized a compiled design, you can choose from the
pull-down list.

Route (Required) Improves the speed of the paths to or from the
register by the given number of nanoseconds. The value shrinks
the effective period for the constrained registers without
affecting the clock period that is forward-annotated to the
place-and-route tool.

Comment Lets you enter comments that are included in the constraints
file.

Delay Paths

Use the Delay Paths panel to define the timing exceptions.

ok | DcloyTvee | From | Thouh | ® | MaxDday | Setw | St | ordes | conment |
O & []

‘Multicyde

False

Pdax Delay

Aeset Path

Dratzpath Only |

Dwday Paths
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The Path Delay panel includes the following options:

Field Description

Delay Type Specifies the type of delay path you want the synthesis tool to
analyze. Choose one of the following types:

e Multicycle
False

Max Delay
Reset Path
Datapath Only

From Starting point for the path. From points define timing start
points and can be defined for clocks (c:), registers (i:), top-level
input or bi-directional ports (p:), black box output pins (i:) or
sequential cell clock pins. For details, see the following:

e Defining From/To/Through Points for Timing Exceptions

 Naming Rule Syntax Commands, on page 304

Through Specifies the intermediate points for the timing exception.
Intermediate points can be combinational nets (n:),
hierarchical ports (t:), or instantiated cell pins (t:). If you click
the arrow in a column cell, you open the Product of Sums (POS)
interface where you can set through constraints. For details, see
the following:

e Product of Sums Interface
e Defining From/To/Through Points for Timing Exceptions
 Naming Rule Syntax Commands, on page 304

To Ending point of the path. To points must be timing end points
and can be defined for clocks (c:), registers (i:), top-level output
or bi-directional ports (p:), or black box input pins (i:). For
details, see the following:

e Defining From/To/Through Points for Timing Exceptions

 Naming Rule Syntax Commands, on page 304

Max Delay Specifies the maximum delay value for the specified path in
nanoseconds.
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Field Description

Setup Specifies the setup (maximum delay) calculations used for
specified path.

Start/End Used for multicycle paths with different start and end clocks.
This option determines the clock period to use for the
multiplicand in the calculation for clock distance. If you do not
specify a start or end clock, the end clock is the default.

Cycles Specifies the number of cycles required for the multicycle
path.

See Also

* For equivalent Tcl syntax, see:

set_multicycle_path, on page 295
set_false_path, on page 283
set_max_delay, on page 289
reset_path, on page 271

* For more information on timing exception constraints and how the tool
resolves conflicts, see:

Delay Path Timing Exceptions, on page 247
Conflict Resolution for Timing Exceptions, on page 260

* For information about all SCOPE panels, see SCOPE Tabs, on page 219.
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Attributes

You can assign attributes directly in the editor.

|:|Enabled Ohject Type Chject Aktribute Yalue | val Tvpe
1 oukput_port | <global= syn_noclockbuf -
syn_clean_reset E]
z syn_dspstyle
syn_edif_bit_format
3 syn_edif_scalar_format
syn_forwar. onstrainks ——
4 syn_milstyle
syn_netlist_hierarchy
5 SYN_NOarrayporks

synnoclockbuf

| swn_ramstyle = —
Here are descriptions for the Attributes columns:
Column Description
Enabled (Required) Turn this on to enable the constraint.
Object Type Specifies the type of object to which the attribute is assigned.

Choose from the pull-down list, to filter the available choices
in the Object field.

Object (Required) Specifies the object to which the attribute is
attached. This field is synchronized with the Attribute field, so
selecting an object here filters the available choices in the
Attribute field.

Attribute (Required) Specifies the attribute name. You can choose from
a pull-down list that includes all available attributes for the
specified technology. This field is synchronized with the Object
field. If you select an object first, the attribute list is filtered. If
you select an attribute first, the Synopsys FPGA synthesis
tool filters the available choices in the Object field. You must
select an attribute before entering a value.

If a valid attribute does not appear in the pull-down list,
simply type it in this field and then apply appropriate values.

Value (Required) Specifies the attribute value. You must specify the
attribute first. Clicking in the column displays the default
value; a drop-down arrow lists available values where
appropriate.
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Val Type

Description

Comment

Specifies the kind of value for the attribute. For example, string
or boolean.

Contains a one-line description of the attribute.

Lets you enter comments about the attributes.

Enter the appropriate attributes and their values, by clicking in a cell and
choosing from the pull-down menu.

To specify an object to which you want to assign an attribute, you may also
drag-and-drop it from the RTL or Technology view into a cell in the Object
column. After you have entered the attributes, save the constraint file and
add it to your project.

See Also

I/O Standards

For information about all SCOPE panels, see SCOPE Tabs, on page 219.

You can specify a standard 1/0 pad type to use in the design. Define an 1/0
standard for any port appearing in the I/O Standards panel.

| Endbled Port Tyoe 1/ Sterdsrd 01 | vz | SlewRate | Crive Srenath | Termingtion | cescrintion |
1|+ <ingeat dafoudks inpus |LWCMDE_1G Fast 0 pulup 1.6 rolk- €.,
z |~ Zoutput defauk = autput
3 | <hidr default = bidir
L8 | IESEEn inpue :
< | K1
1 Sharderds
Field Description
Enabled (Required) Turn this on to enable the constraint, or off to
disable a previous constraint.
Port (Required) Specifies the name of the port. If you have
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initialized a compiled design, you can select a port name from
the pull-down list. The first two entries let you specify global
input and output delays, which you can then override with
additional constraints on individual ports.
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Type (Required) Specifies whether the delay is an input or output
delay.

I/O Standard Supported I/0 standards by Synopsys FPGA products. See
Industry 1/0 Standards , on page 244 for a description of the
standards.

Slew Rate The values for these parameters are based on the selected

Drive Strength 170 standard.

Termination

Power

Schmitt

Description Describes the selected 170 Standard.

Comment Enter comments about an 1/0 standard.

See Also

* The Tcl equivalent of this constraint is define_io_standard.

* For information about all SCOPE panels, see SCOPE Tabs, on page 219.

Compile Points

Use the Compile Points panel to specify compile points in your design, and to
enable/disable them. This panel, available only if the device technology
supports compile points, is used to define a top-level constraint file.

‘:I Enabled Madule Type Comment ﬂ
1 -
2 ilocked |
locked ,partition
soft
3 hard
bladk_box -
: 8
Compile Points
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Here are the descriptions of the fields in the Compile Points panel.

Field Description
Enabled (Required) Turn this on to enable the constraint.
Module (Required) Specifies the name of the compile-point module.

You must specify a view module, with a v: prefix to identify
the module as a view. For example: v:alu.

Type (Required) Specifies the type of compile point:

 locked (default) - no timing reoptimization is done on the
compile point. The hierarchical interface is unchanged
and an interface logic model is constructed for the
compile point.

« locked, partition - locked compile point, for which compile
point information is forward annotated to the place and
route tool. This mode provides place and route runtime
advantages and allows for obtaining stable results for a
completed design.

« soft - compile point is included in the top-level synthesis,
boundary optimizations can occur.

e hard - compile point is included in the top-level synthesis,
boundary optimizations can occur, however, the
boundary remains unchanged. Although, the boundary is
not modified, instances on both sides of the boundary
can be modified using top-level constraints.

For details, see Compile Point Types , on page 440 in the
User Guide.

Comment Lets you enter a comment about the compile point.

Constraints for Compile Points

You can set constraints at the top-level or for modules to be used as the
compile points from the Current Design pull-down menu shown below. Use the
Compile Points tab to select compile points and specify their types.
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CurrentDesign: | =Top Lavel> [»]| |ficneck Canstrants
A
| |Enabl:| work INS_ROM | | Type Comment
wark. sy
IZ work.data_rmux
work.ing_decods
3 waork.in
weork.mult |
weor k. prepd —
2 sk orgm iy e |
E workurea_fle =
5
E
7
i |
i |
Compde Foints
See Also

The Tcl equivalent is define_compile_point.

For more information on compile points and using the Compile Points
panel, see Synthesizing Compile Points, on page 455 in the User Guide.

For information about all SCOPE panels, see SCOPE Tabs, on page 219.
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TCL View

The TCL View is an advanced text file editor for defining FPGA timing and

design constraints.

Current Desan: | <Too Level> -] ['glichedk Constraints

146 |4|
147 s=t_rol_fr_nzmes {2} |Nam'z_ i
148 set qfrs [deflne ecollectlon [Tingd -seq ~hier [gnl*] Er FDC Constraints
49 ==t £ max 150 bus_dimension_separat...
150 crest=_clock {clka} [get_ports [clkal] L0 -—ws bus_naming_style
151 crezte clock {clkb} [get_porta [=lkbl] E.GEEE create_clock
152 ==t _input_delay [g=t_clocks [clka}t] —add creste_generated_clock
155 act output dalay (gat_clocks {elkz]] 0.04 define_attribute
154 aot input dolay [g=t_elocka [olkall Z.00 d&ﬁne_compile_pcint
155 ast_input_dalay [g=t_eslonka [oLEa}] o [g= define_global_attiibute
::f_ “"1" mep S S ) . define_ie_standard
153 R "'f\ B_pEEh smen h define_scope_collection

o d_sdc
159 [get_pocts & [E? =
&0 [a* % reset path
16l B4l set_clock_groups
.62 1 sek clock latency
53 —tn I T A
164 [find -sag -hier [g7[*]] 1 Consiraint Symiax:
o . set_rtl_ff_names
166 get_multicyele _path 3 welue «-.sl:rng\'dueﬁ
167 -TEOm
168 [find -=eq {*y*.g[*1} ]
169
1M) s=t_clock groups defauls_clkgroup D \ —
171 -group [get_clocka {clkas dem|elkl derived clock dom|elk |-

1 [1]¢
Hde syntax Help | Ln| 1 l:ol| i lb‘lzll 173
I Click on Hide Syntax Help
to close this browser
Syntax Hep

a0

This text editor provides the following capabilities:

¢ Uses dynamic keyword expansion and tool tips for commands that

— Automatically completes the command from a popup list

Displays complete command syntax as a tool tip

— Displays parameter options for the command from a popup list

Includes a keyword command syntax help

* Checks command syntax and uses color indicators that

— Validate commands and command syntax

— ldentifies FPGA design constraints and SCOPE legacy constraints
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¢ Allows for standard editor commands, such as copy, paste,
comment/un-comment a group of lines, and highlighting of keywords

For information on how to use this Tcl text editor, see Using the TCL View of
SCOPE GUI, on page 134.

See Also
* For Tcl timing constraint syntax, see Timing Constraints, on page 264.

¢ For Tcl design constraint syntax, see Design Constraints, on page 307.
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Industry 1/O Standards

The synthesis tool lets you specify a standard 1/0 pad type to use in your
design. You can define an 1I/0 standard for any port supported from the
industry standard and proprietary 1/0 standards.

For industry 1/0 standards, see Industry 1/0 Standards, on page 244.

Industry I/O Standards

The following table lists industry 1/0 standards.

I/O Standard

BLVDS_25
CTT

DIFF_HSTL_15 Class |
DIFF_HSTL_15 Class_lI
DIFF_HSTL_18_Class |

DIFF_HSTL_18_Class_lI
DIFF_SSTL_18_Class_lI
DIFF_SSTL_2 Class |

DIFF_SSTL_2_Class_lI

GTL

GTL+
GTL25

GTL+25
GTL33

GTL+33

© 2021 Synopsys, Inc.
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Description

Bus Differential Transceiver
Center Tap Terminated - EIA/JEDEC Standard JESD8-4

1.5 volt - Differential High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6

1.5 volt - Differential High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6

1.8 volt - Differential High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-9A

1.8 volt - Differential High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-9A

1.8 volt - Differential Stub Series Terminated Logic
- EIA/JEDEC Standard JESD8-6

2.5 volt - Pseudo Differential Stub Series
Terminated Logic - EIA/JEDEC Standard JESD8-9A

2.5 volt - Pseudo Differential Stub Series
Terminated Logic - EIA/JEDEC Standard JESD8-9A

Gunning Transceiver Logic
- EIA/JEDEC Standard JESD8-3

Gunning Transceiver Logic Plus

Gunning Transceiver Logic
- EIA/JEDEC Standard JESDS8-3

Gunning Transceiver Logic Plus

Gunning Transceiver Logic
- EIA/JEDEC Standard JESDS8-3

Gunning Transceiver Logic Plus
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Industry I/O Standards

Constraint Commands

I/0 Standard
HSTL_12

HSTL_15 Class_lI
HSTL_18 Class_|
HSTL_18 Class_lI
HSTL_18_Class_lII
HSTL_18 Class_IV
HSTL_Class_|
HSTL_Class_II
HSTL_Class_llI
HSTL_Class_IV

HyperTransport

Description

1.2 volt - High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6
1.5 volt - High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6
1.8 volt - High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6
1.8 volt - High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6
1.8 volt - High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6
1.8 volt - High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6
1.5 volt - High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6
1.5 volt - High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6
1.5 volt - High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6
1.5 volt - High Speed Transceiver Logic
- EIA/JEDEC Standard JESD8-6

2.5 volt - Hypertransport - HyperTransport Consortium
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Constraint Commands

Industry I/O Standards

I/O Standard

LVCMOS_12
LVCMOS_15
LVCMOS_18
LVCMOS_25
LVCMOS_33
LVCMOS_5
LVDS
LVDSEXT 25
LVPECL
LVTTL
MINI_LVDS

PCI33
PCI66
PCI-X_133

PCML
PCML_12
PCML_14
PCML_15
PCML_25
RSDS

SSTL_18 Class_I
SSTL_18 Class_II
SSTL_2 Class_|
SSTL_2 Class_II

SSTL_3 Class_|

SSTL_3 _Class_lI

ULVDS_25

© 2021 Synopsys, Inc.

Description

1.2 volt - EIA/JEDEC Standard JESD8-16

1.5 volt - EIA/JEDEC Standard JESD8-7

1.8 volt - EIA/JEDEC Standard JESD8-7

2.5 volt - EIA/JEDEC Standard JESD8-5

3.3 volt CMOS - EIA/JEDEC Standard JESD8-B
5.0 volt CMOS

Differential Transceiver - ANSI/TIA/EIA-644-95
Differential Transceiver

Differential Transceiver - EIA/JEDEC Standard JESD8-2
3.3 volt TTL - EIA/JEDEC Standard JESD8-B
Mini Differential Transceiver

3.3 volt PCI 33MHz - PCI Local Bus Spec. Rev. 3.0
(PCI Special Interest Group)

3.3 volt PCI 66MHz - PCI Local Bus Spec. Rev. 3.0
(PCI Special Interest Group)

3.3 volt PCI-X - PCI Local Bus Spec. Rev. 3.0
(PCI Special Interest Group)

3.3 volt - PCML
1.2 volt - PCML
1.4 volt - PCML
1.5 volt - PCML
2.5 volt - PCML
Reduced Swing Differential Signalling

1.8 volt - Stub Series Terminated Logic
- EIA/JEDEC Standard JESDS8-15

1.8 volt - Stub Series Terminated Logic
- EIA/JEDEC Standard JESDS8-15

2.5 volt - Stub Series Terminated Logic
- EIA/JEDEC Standard JESD8-9B

2.5 volt - Stub Series Terminated Logic
- EIA/JEDEC Standard JESD8-9B

3.3 volt - Stub Series Terminated Logic
- EIA/JEDEC Standard JESD8-8

3.3 volt - Stub Series Terminated Logic
- EIA/JEDEC Standard JESD8-8

Differential Transceiver
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Delay Path Timing Exceptions Constraint Commands

Delay Path Timing Exceptions

For details about the following path types, see:
* Multicycle Paths, on page 247
* False Paths, on page 250

Multicycle Paths

Multicycle paths lets you specify paths with multiple clock cycles. The
following table defines the parameters for this constraint. For the equivalent
Tcl constraints, see set_multicycle _path, on page 295. This section describes
the following:

* Multi-cycle Path with Different Start and End Clocks, on page 247
* Multicycle Path Examples, on page 248

Multi-cycle Path with Different Start and End Clocks

The start/end option determines the clock period to use for the multiplicand in
the calculation for required time. The following table describes the behavior of
the multi-cycle path constraint using different start and end clocks. In all
equations, n is number of clock cycles, and clock distance is the default,
single-cycle relationship between clocks that is calculated by the tool.

Basic required time for a multi-cycle path clock_distance + [(n-1) * end_clock_period]
Required time with no end clock defined  clock_distance + [(n-1) * global_period]
Required time with -start option defined clock_distance + [(n-1) * start_clock_period]

Required time with no start clock defined clock_distance + [(n-1) * global_period]

Synplify Pro for Microchip Edition Command Reference © 2021 Synopsys, Inc.
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Constraint Commands

Delay Path Timing Exceptions

If you do not specify a start or end option, by default the end clock is used for

the constraint. Here is an example:
| [enatied | oeiay rvpe From o Thiough | Start/end | Cydss | MaxDelayins) | Conment [<)
|] [v] Multizyele Erad - _I
& Start

oo

'_ Dielay Paths I

Multicycle Path Examples

Multicycle Path Example 1

If you apply a multicycle path constraint from D1 to D2, the allowed time is
#cycles x normal time between D1 and D2. In the following figure, CLK1 has a
period of 10 ns. The data in this path has only one clock cycle before it must
reach D2. To allow more time for the signal to complete this path, add a
multiple-cycle constraint that specifies two clock cycles (10 x 2 or 20 ns) for

the data to reach D2.

required time required lima

—10 NS —pq 20 N5 —ps
L] L]
L]
L]

{._. =~ D2 Q2 O, 1 ¢ SNog az
__J k. j
CLEK1 l_

| W

without constrant with mulliple-cycle path=2
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Delay Path Timing Exceptions Constraint Commands

Multicycle Path Example 2

The design has a multiplier that multiplies signal_a with signal_b and puts the
result into signal_c. Assume that signal_a and signal_b are outputs of registers
register_a and register_b, respectively. The RTL view for this example is shown
below. On clock cycle 1, a state machine enables an input enable signal to
load signal_a into register_a and signal_b into register_b. At the beginning of clock
cycle 2, the multiply begins. After two clock cycles, the state machine enables
an output_enable signal on clock cycle 3 to load the result of the multiplication
(signal_c) into an output register (register_c).

_“I_; [va] Qv -_mt/[.—‘_--. N
L : f # 151 \ e 150
register_a[7-0] - -
register_c_7[15:0] register_c]15:0]

m—lﬂ_-.l' J[70] ot

register_b[7.0]

The design frequency goal is 50 MHz (20 ns) and the multiply function takes
35 ns, but it is given 2 clock cycles. After optimization, this 35 ns path is
normally reported as a timing violation because it is more than the 20 ns
clock-cycle timing goal. To avoid reporting the paths as timing violations, use
the SCOPE window to set 2-cycle constraints (From column) on register_a and
register_b, or include the following in the timing constraint file:

# Paths fromregister_a use 2 clock cycles
set multicycle path -fromregister_a 2

# Paths fromregister_b use 2 clock cycles
set_ multicycle path -fromregister b 2

Alternatively, you can specify a 2-cycle SCOPE constraint (To column) on
register_c, or add the following to the constraint file:

# Paths to register_c use 2 clock cycles
set_multicycle path -to register_c 2
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Constraint Commands Delay Path Timing Exceptions

False Paths

You use the Delay Paths constraint to specify clock paths that you want the
synthesis tool to ignore during timing analysis and assign low (or no) priority
during optimization. The equivalent Tcl constraint is described in set_false -
path, on page 283.

This section describes the following:
* Types of False Paths, on page 250

* False Path Constraint Examples, on page 251

Types of False Paths

A false path is a path that is not important for timing analysis. There are two
types of false paths:

¢ Architectural false paths

These are false paths that the designer is aware of, like an external reset
signal that feeds internal registers but which is synchronized with the
clock. The following example shows an architectural false path where
the primary input x is always 1, but which is not optimized because the
software does not optimize away primary inputs.

£

¢ Code-introduced false paths

These are false paths that you identify after analyzing the schematic.

© 2021 Synopsys, Inc. Synplify Pro for Microchip Edition Command Reference
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Delay Path Timing Exceptions Constraint Commands

False Path Constraint Examples

In this example, the design frequency goal is 50 MHz (20ns) and the path
from register_a to register_c is a false path with a large delay of 35 ns. After
optimization, this 35 ns path is normally reported as a timing violation
because it is more than the 20 ns clock-cycle timing goal. To lower the
priority of this path during optimization, define it as a false path. You can do
this in many ways:

If all paths from register_a to any register or output pins are not
timing-critical, then add a false path constraint to register_a in the
SCOPE interface (From), or put the following line in the timing constraint
file:

#Paths fromregister_a are ignored
set false path -from{i:register_a}

If all paths to register_c are not timing-critical, then add a false path
constraint to register_c in the SCOPE interface (To), or include the
following line in the timing constraint file:

#Paths to register_c are ignored
set false_path -to {i:register_c}

If only the paths between register_a and register_c are not timing-critical,
add a From/To constraint to the registers in the SCOPE interface (From
and To), or include the following line in the timing constraint file:

#Paths to register _c are ignored
set false path -from{i:register_a} -to {i:register_c}

Synplify Pro for Microchip Edition Command Reference © 2021 Synopsys, Inc.
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Specifying From, To, and Through Points

The following section describes from, to, and through points for timing excep-
tions specified by the multicycle paths, false paths, and max delay paths
constraints.

* Timing Exceptions Object Types, on page 252
* From/To Points, on page 252

* Through Points, on page 254

* Product of Sums Interface, on page 255

¢ Clocks as From/To Points, on page 258

Timing Exceptions Object Types
Note the following timing exceptions for object types:

* Timing exceptions must contain the type of object in the constraint
specification. You must explicitly specify an object type, n: for a net, or i:
for an instance, in the instance name parameter of all timing exceptions.
For example:

set_nmulticycle_path -from{i:inst2.]1oweg_output[7]}
-to {i:instl. DATAO[ 7]} 2

If you use the SCOPE GUI to specify timing exceptions, it automatically
attaches the object type qualifier to the object name.

* When defining constraints for the fdc file from the Tcl View window in
SCOPE, it is recommended you use get * as the object type qualifier.

For example, use get_ports, get_nets, get_pins, or get cells instead of p;, n;, t;,
or i.

From/To Points

From specifies the starting point for the timing exception. To specifies the
ending point for the timing exception. When you specify an object, use the
appropriate prefix (see syn_black _box, on page 63) to avoid confusion. The
following table lists the objects that can serve as starting and ending points:

© 2021 Synopsys, Inc. Synplify Pro for Microchip Edition Command Reference
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Specifying From, To, and Through Points Constraint Commands

From Points To Points

Clocks. See Clocks as From/To Points,  Clocks. See Clocks as From/To Points ,
on page 258 for more information. on page 258 for more information.
Registers Registers

Top-level input or bi-directional ports Top-level output or bi-directional ports
Instantiated library primitive cells (gate  Instantiated library primitive cells (gate
cells) cells)

Black box outputs Black box inputs

You can specify multiple from points in a single exception. This is most
common when specifying exceptions that apply to all the bits of a bus. For
example, you can specify constraints From A[0:15] to B - in this case, there is an
exception, starting at any of the bits of A and ending on B.

Similarly, you can specify multiple to points in a single exception. If you
specify both multiple starting points and multiple ending points such as From
AJ0:15] to B[0:15], there is actually an exception from any start point to any end
point. In this case, the exception applies to all 16 * 16 = 256 combinations of
start/end points.
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Constraint Commands Specifying From, To, and Through Points

Through Points

Through points are limited to nets, hierarchical ports, and pins of instanti-
ated cells. There are many ways to specify these constraints.

¢ Single Point

* Single List of Points

e Multiple Through Points
e Multiple Through Lists

You define these constraints in the appropriate SCOPE panels, or in the POS
GUI (see Product of Sums Interface, on page 255). When a port and net have
the same name, preface the name of the through point with n: for nets or t: for
hierarchical ports. For example, you can specify n:regs_mem[2] or t:dmux.bdpol.
The n: prefix must be specified to identify nets; otherwise, the associated
timing constraint will not be applied for valid nets.

Single Point

You can specify a single through point. In this case, the constraint is applied to
any path that passes through net regs_mem][2] as follows:

set _fal se_path -through n:regs_nenj 2]
set_false_path -through [get_nets {regs_meni2]}]

Single List of Points

If you specify a list of through points, the through option behaves as an OR
function and applies to any path that passes through any of the points in the
list. In the following example, the constraint is applied to any path through
regs_mem[2] OR prgcntr.pc[7] OR dmux.alub[0] with a maximum delay value of 5
ns (-max 5):

set _max_del ay
-through {t:regs_menj2] t:prgcntr.pc[7] t:dmux.alub[0]} 5
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Specifying From, To, and Through Points Constraint Commands

Multiple Through Points

You can specify multiple points for the same constraint by preceding each
point with the -through option. In the following example, the constraint
operates as an AND function and applies to paths through regs_mem[2] AND
prgentr.pc[7] AND dmux.alub[0]:

set _nmax_del ay

-through t:regs_nenj 2]
-through t:prgcntr. pc[ 7]
-through t:dnux.al ub[0] 5

Multiple Through Lists

If you specify multiple -through lists, the constraint is applied as an AND/OR
function and is applied to the paths through all points in the lists. The
following constraint applies to all paths that pass through nets {A; or A,
or...An} AND nets {B; or B, or B3}:

set _false_path -through {n:A; n:A,...n: A} -through {n:B; n: B, n: Bg}
In this example,

set _multicycle_path
-through {n:netl n:net2}
-through {n:net3 n:net4} 2

all paths that pass through the following nets are constrained at 2 clock
cycles:

netl AND net3

CR netl AND net 4
CR net2 AND net 3
CR net2 AND net 4

Product of Sums Interface

You can use the SCOPE GUI to format -through points for nets with multicycle
path, false path, and max delay path constraints in the Product of Sums (POS)
interface of the SCOPE editor. You can also manually specify constraints that
use the -through option. For more information, see Defining From/To/Through
Points for Timing Exceptions, on page 139 in the User Guide.
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The POS interface is accessible by clicking the arrow in a Through column cell
in the following SCOPE panels:

* Multi-Cycle Paths
* False Paths

* Delay Paths

Editing POS throughs for row 1 e |

| Surn 1 Sum 2 Sum 3 | Sum 4 Surm 5 Sum & Surm 7 !;
Prod 1 |\
Prod 2
Prod 3
Prod 4
Prod 5 :
11 | o]

Drag and Drop: Drag and Drop goes:
@ Inserts hew Cells @ Along Row
Overwrites Cells Diovan Calurnn

Field Description

Prod 1, 2, etc. Type the first net name in a cell in a Prod row, or drag the
net from a HDL Analyst view into the cell. Repeat this
step along the same row, adding other nets in the Sum
columns. The nets in each row form an OR list.

Sum 1, 2, etc. Type the first net name in the first cell in a Sum column,
or drag the net from a HDL Analyst view into the cell.
Repeat this step down the same Sum column. The nets in
each column form an AND list.

© 2021 Synopsys, Inc. Synplify Pro for Microchip Edition Command Reference
256 Synopsys Confidential Information June 2021



Specifying From, To, and Through Points Constraint Commands

Drag and Drop Goes

Drag and Drop

Along Row - places objects in multiple Sum columns,
utilizing only one Prod row.

Down Column - places objects in multiple Prod rows, utilizing
only one Sumcolumn.

Inserts New Cells - New cells are created when dragging and
dropping nets.

Overwrites Cells - Existing cells are overwritten when
dragging and dropping nets.

Save/Cancel Saves or cancels your session.
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Clocks as From/To Points

You can specify clocks as from/to points in your timing exception constraints.
Here is the syntax:

set_timing_exception -from | -to {c:clock_name [:edge]}
where

* timing_exception is one of the following constraint types: multicycle path,
false path, or max delay

¢ c:clock_name:edge is the name of the clock and clock edge (r or f). If you do
not specify a clock edge, by default both edges are used.

See the following sections for details and examples on each timing exception.

Multicycle Path Clock Points

When you specify a clock as a from or to point, the multicycle path constraint
applies to all registers clocked by the specified clock.

The following constraint allows two clock periods for all paths from the rising
edge of the flip-flops clocked by clk1:

set_multicycle_path -from{c:clkl:r} 2

You cannot specify a clock as a through point. However, you can set a
constraint from or to a clock and through an object (net, pin, or hierarchical
port). The following constraint allows two clock periods for all paths to the
falling edge of the flip-flops clocked by clkl and through bit 9 of the hierar-
chical net:

set_multicycle path -to {c:clkl:f} -through (n: Ml NST. nybus2[9]} 2
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False Path Clock Points

When you specify a clock as a from or to point, the false path constraint is set
on all registers clocked by the specified clock. False paths are ignored by the
timing analyzer. The following constraint disables all paths from the rising
edge of the flip-flops clocked by clk1:

set false path -from{c:clkl:r}

You cannot specify a clock as a through point. However, you can set a
constraint from or to a clock and through an object (net, pin, or hierarchical
port). The following constraint disables all paths to the falling edge of the
flip-flops clocked by clkl and through bit 9 of the hierarchical net.

set false path -to {c:clkl:f} -through (n: MYl NST. nybus2[ 9]}

Path Delay Clock Points

When you specify a clock as a from or to point for the path delay constraint,
the constraint is set on all paths of the registers clocked by the specified
clock. This constraint sets a max delay of 2 ns on all paths to the falling edge
of the flip-flops clocked by clk1:

set _max_delay -to {c:clkl:f} 2

You cannot specify a clock as a through point, but you can set a constraint
from or to a clock and through an object (net, pin, or hierarchical port). The
next constraint sets a max delay of 0.2 ns on all paths from the rising edge of
the flip-flops clocked by clkl and through bit 9 of the hierarchical net:

set_nmax_delay -from{c:clkl:r} -through (n: MM NST. nybus2[9]}. 2
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Conflict Resolution for Timing Exceptions

The term timing exceptions refers to the false path, max path delay, and
multicycle path timing constraints. When the tool encounters conflicts in the
way timing exceptions are specified through the constraint file, the software
uses a set priority to resolve these conflicts. Conflict resolution is categorized
into four levels, meaning that there are four different tiers at which conflicting
constraints can occur, with one being the highest. The table below summa-
rizes conflict resolution for constraints. The sections following the table
provide more details on how conflicts can occur and examples of how they are

resolved.
Conflict Constraint Conflict Priority For Details, see ...
Level

1 Different timing 1 - False Path Conflicting Timing
exceptions set on the 2 - Path Delay Exceptions , on
same object. 3 - Multi-cycle Path page 261.

2 Timing exceptions of 1 - From Same Constraint
the same constraint 2 -To Type with Different
type, using different Semantics , on
semantics 3 - Through page 262.
(from/to/through).

3 Timing exceptions of 1 - Ports/Instances/Pins Same Constraint
the same constraint 2 - Clocks and Semantics with
type using the same Different Objects ,
semantic, but set on on page 263.
different objects.

4 Identical timing Tightest, or most Identical
constraints, except constricting constraint. Constraints with
constraint values differ. Different Values , on

page 263.

In addition to the four levels of conflict resolution for timing exceptions, there
are priorities for the way the tool handles multiple 1/0 delays set on the same
port and implicit and explicit false path constraints. For information on
resolving these types of conflicts, see Priority of Multiple 1/0 Constraints, on
page 232.
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Conflicting Timing Exceptions

The first (and highest) level of resolution occurs when timing exceptions—
false paths, max path delay, or multicycle path constraints—conflict with
each other. The tool follows this priority for applying timing exceptions:

1. False Path
2. Path Delay
3. Multicycle Path

For example:

X {}7 g C1=3 ns

oo | I

set false path -from{c:Cl:r}
set_max_delay -from{i:A -to {i:B} 10
set_multicycle_path -from{i:A -to {i:B} 2

These constraints are conflicting because the path from A to B has three
different constraints set on it. When the tool encounters this type of conflict,
the false path constraint is honored. Because it has the highest priority of all
timing exceptions, set_false path is applied and the other timing exceptions are
ignored.
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Same Constraint Type with Different Semantics

The second level of resolution occurs when conflicts between timing excep-
tions that are of the same constraint type, use different semantics
(from/to/through). The priority for these constraints is as follows:

1. From
2. To

3. Through

If there are two multicycle constraints set on the same path, one specifying a
from point and the other specifying a to point, the constraint using -from takes
precedence, as in the following example.

I %7 5 C1-3 ns

set_multicycle path -from{i:A} 3
set_nmulticycle_path -to {i:B} 2

In this case, the tool uses:
set_mlticycle_path -from{i:A} 3

The other constraint is ignored even though it sets a tighter constraint.
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Same Constraint and Semantics with Different Objects

The third level resolves timing exceptions of the same constraint type that use
the same semantic, but are set on different objects. The priority for design
objects is as follows:

1. Ports/Instances/Pins
2. Clocks

If the same constraints are set on different objects, the tool ignores the
constraint set on the clock for that path.

set_multicycle_path -from{i:nmacl.datax[0]} -start 4
set_multicycle_path -from{c:clkl:r} 2

In the example above, the tool uses the first constraint set on the instance
and ignores the constraint set on the clock from i:macl.datax[0], even though
the clock constraint is tighter.

For details on how the tool prioritizes multiple 1/0 delays set on the same
port or implicit and explicit false path constraints, see Priority of Multiple 170
Constraints, on page 232.

Identical Constraints with Different Values

Where timing constraints are identical except for the constraint value, the
tightest or most constricting constraint takes precedence. In the following
example, the tool uses the constraint specifying two clock cycles:

set_multicycle path -from{i:special regs.trisa[7:0]} 2
set_ multicycle path -from{i:special regs.trisa[7:0]} 3

Synplify Pro for Microchip Edition Command Reference © 2021 Synopsys, Inc.
June 2021 Synopsys Confidential Information 263



Constraint Commands Timing Constraints

Timing Constraints

The FPGA synthesis tools support FPGA timing constraints for a subset of the
clock definition, 1/0 delay, and timing exception constraints.

The remainder of this section describes the constraint file syntax for the
following FPGA timing constraints in the FPGA synthesis tools.

create_clock
create_generated_clock
reset_path
set_clock_groups
set_clock_latency
set_clock_uncertainty
set_false_path
set_input_delay
set_max_delay
set_multicycle_path
set_output_delay
set_reg_input_delay

set_reg_output_delay

Note: When adding comments for constraints, use standard Tcl syntax
conventions. Otherwise, invalid specifications can cause the constraint to be
ignored. The (#) comment must begin on a new line or needs to be preceded
by a (;), if the comment is on the same line as the constraint. For example:

create _clock -period 10 [get _ports CLK]; # comment text

# comrent text
set _cl ock_groups -asynchronous -group
MVCM nodul e| ¢l k10090 MMOM deri ved_cl ock_CLKI NL
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create_clock

Creates a clock object and defines its waveform in the current design.

Syntax

The supported syntax for the create_clock constraint is:

create_clock

-name clockName [-add] {objectList} |
-name clockName [-add] [{objectList}] |
[-name clockName [-add]] {objectList}

-period value

[-waveform {riseValue fallValue}]

[-disable]

[-comment commentString]

Arguments

-name
clockName

-add

-period value

Synplify Pro for Microchip Edition Command Reference
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Specifies the name for the clock being created, enclosed in quotation
marks or curly braces. If this option is not used, the clock gets the
name of the first clock source specified in the objectList option. If you
do not specify the objectList option, you must use the -name option,
which creates a virtual clock not associated with a port, pin, or net.
You can use both the -name and objectList options to give the clock a
more descriptive name than the first source pin, port, or net. If you
specify the -add option, you must use the -name option and the clocks
with the same source must have different names.

Specifies whether to add this clock to the existing clock or to
overwrite it. Use this option when multiple clocks must be specified
on the same source for simultaneous analysis with different clock
waveforms. When you specify this option, you must also use the
-name option.

Specifies the clock period in nanoseconds. This is the minimum time
over which the clock waveform repeats. The value type must be
greater than zero.

© 2021 Synopsys, Inc.
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-waveform Specifies the rise and fall edge times for the clock waveforms of the
riseValue clock in nanoseconds, over an entire clock period. The first time is a
fallvalue rising transition, typically the first rising transition after time zero.

There must be two edges, and they are assumed to be rise followed
by fall. The edges must be monotonically increasing. If you do not
specify this option, a default waveform is assumed, which has a rise
edge of 0.0 and a fall edge of periodValue/2.

objectList Clocks can be defined on the following objects: pins, ports, and nets

The FPGA synthesis tools support nets and instances, where
instances have only one output (for example, BUFGS).

-disable Disables the constraint.
-comment Allows the command to accept a comment string. The tool honors
textString the annotation and preserves it with the object so that the exact

string is written out when the constraint is written out. The
comment remains intact through the synthesis, place-and-route,
and timing-analysis flows.

Examples

Refer to the following examples.

Example 1

A clock named clk_inl is created for port clk_inl that uses a period of 10 with
rising edge of O and falling edge of 5.

create_cl ock -name {clk_inl} -period 10 [get_ports {cl k_inl}]

Example 2

A clock named clk is created for port clk_in that uses a period of 10.0 with
rising edge of 5.0 and falling edge of 9.5.

create_clock -name {clk} -period 10 -waveform {5.0 9.5}
[get _ports {clk_in}]

Example 3

A virtual clock named CLK is created that uses a period of 12 with a rising
edge of 0.0 and falling edge of 6.0.

create_cl ock -name {CLK} -period 12
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create_generated clock

Creates a generated clock object.

Syntax

The supported syntax for the create_generated_clock constraint is:

create_generated_clock
-name clockName [-add]] | {clockObject}
-source masterPinName
[-master_clock clockName]
[-divide_by integer | -multiply_by integer [-duty_cycle value]]

[-invert]

[-edges {edgeList}]
[-edge_shift {edgeShiftList}]
[-combinational]

[-disable]

[-comment commentString]

Arguments

-name
clockName

-add

clockObiject

Specifies the name of the generated clock. If this option is not
used, the clock gets the name of the first clock source specified
in the -source option (clockObject). If you specify the -add option,
you must use the -name option and the clocks with the same
source must have different names.

Specifies whether to add this clock to the existing clock or to
overwrite it. Use this option when multiple generated clocks
must be specified on the same source, because multiple clocks
fan into the master pin. Ideally, one generated clock must be
specified for each clock that fans into the master pin. If you
specify this option, you must also use the -name and
-master_clock options.

The first clock source specified in the -source option in the
absence of clockName. Clocks can be defined on pins, ports, and
nets. The FPGA synthesis tools support nets and instances,
where instances have only one output (for example, BUFGSs).

Synplify Pro for Microchip Edition Command Reference © 2021 Synopsys, Inc.
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-source
masterPinName

-master_clock
clockName

-divide_by
integer

-multiply_by
integer

-duty_cycle

percent

-invert

-edges edgelList

-edge_shift
edgeShiftList

-combinational

-disable

© 2021 Synopsys, Inc.

Specifies the master clock pin, which is either a master clock
source pin or a fanout pin of the master clock driving the
generated clock definition pin. The clock waveform at the master
pin is used for deriving the generated clock waveform.

Specifies the master clock to be used for this generated clock,
when multiple clocks fan into the master pin.

Specifies the frequency division factor. If the divideFactor value
is 2, the generated clock period is twice as long as the master
clock period.

Specifies the frequency multiplication factor. If the
multiplyFactor value is 3, the generated clock period is one-third
as long as the master clock period.

Specifies the duty cycle, as a percentage, if frequency
multiplication is used. Duty cycle is the high pulse width.

Note: This option is valid only when used with the -multiply_by
option.

Inverts the generated clock signal (in the case of frequency
multiplication and division).

Specifies a list of integers that represents edges from the source
clock that are to form the edges of the generated clock. The
edges are interpreted as alternating rising and falling edges and
each edge must not be less than its previous edge. The number
of edges must be set to 3 to make one full clock cycle of the
generated clock waveform. For example, 1 represents the first
source edge, 2 represents the second source edge, and so on.

Specifies a list of floating point numbers that represents the
amount of shift, in nanoseconds, that the specified edges are to
undergo to yield the final generated clock waveform. The
number of edge shifts specified must be equal to the number of
edges specified. The values can be positive or negative; positive
indicating a shift later in time, while negative indicates a shift
earlier in time. For example, 1 indicates that the corresponding
edge is to be shifted by one library time unit.

The source latency paths for this type of generated clock only
includes the logic where the master clock propagates. The
source latency paths do not flow through sequential element
clock pins, transparent latch data pins, or source pins of other
generated clocks.

Disables the constraint.

Synplify Pro for Microchip Edition Command Reference
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-comment Allows the command to accept a comment string. The tool

textString honors the annotation and preserves it with the object so that
the exact string is written out when the constraint is written
out. The comment remains intact through the synthesis,
place-and-route, and timing-analysis flows.

Examples

Refer to the following examples.

Example 1
A frequency of -divide_by 2 is used for the generated clock.

create_generated_cl ock -nanme {gen_cl k} -source
[get pins {DCOWD. CLKO}] [get pins {BUFGMUX inst.CG] -divide by 2

Example 2

A generated clock is created whose edges are 1, 3, and 5 of the master clock
source. If the master clock period is 30 and the master waveform is {24 30},
then the generated clock period becomes 60 with waveform {24 54}.

create generated_cl ock -name {gencl k} -source
[get _ports {clk inl}] [get_nets {dut.clk out2}] -edges {1 3 5}

Example 3

This example shows the generated clock from the previous example with each
derived edge shifted by 1 time unit. If the master clock period is 30 and the
master waveform is {24 36}, then the generated clock period becomes 60 with
waveform {25 55}.

create_generated_cl ock -nane {gencl k}
-source [get_ports {clk_inl}] [get_nets {dut.clk_out?2}]
-edges {1 3 5} -edge shift {1 1 1}

Synplify Pro for Microchip Edition Command Reference © 2021 Synopsys, Inc.
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Example 4

This example shows the generated clock with the same edges as the master
clock, where edge 2 is shifted by 0.8 time unit and edge 3 is shifted by -0.4
time unit. If the master clock period is 4 and the master waveform is {O 2},
then the generated clock period becomes 3.6 and the waveform is {O 2.8}.

creat e_gener at ed_cl ock -nane {gencl k}
-source [get_ports {clk inl}] [get _nets {dut.clk out?2}]
-edges {1 2 3} -edge shift {0 0.8 -0.4}

© 2021 Synopsys, Inc. Synplify Pro for Microchip Edition Command Reference
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reset_path

Resets the specified paths to single-cycle timing.

Syntax
The supported syntax for the reset_path constraint is:

reset_path [-setup]
[-from {objectList} |-rise_from riseFromClock | -fall_from fallFromClock]
[-through {objectList} [-through {objectList} ...] ]
[to {objectList} |-rise_to riseToClock | -fall_to fallToClock]
[-disable]
[-comment commentString]

Arguments

-setup Specifies that setup checking (maximum delay) is reset to
single-cycle behavior.

-from Specifies the names of objects to use to find path start points.
The -from objectList includes:
* Clocks
* Registers
e Top-level input or bi-directional ports
* Black box outputs
« Sequential cell clock pins
When the specified object is a clock, all flip-flops, latches, and
primary inputs related to that clock are used as path start
points

-rise_from Specifies to use the rising edge of the source clock to find

riseFromClock path start points. Use only one of the -from, -rise_from, and
-fall_from options and specify a destination clock with one of
the -to, -rise_to, and -fall_to options.

-fall_from Specifies to use the falling edge of the source clock to find

fallFromClock path start points. Use only one of the -from, -rise_from, and
-fall_from options and specify a destination clock with one of
the -to, -rise_to, and -fall_to options.
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-through Specifies the intermediate points for the timing exception. The
-through objectList includes:

« Combinational nets
e Hierarchical ports
* Pins on instantiated cells

By default, the through points are treated as an OR list. The
constraint is applied if the path crosses any points in objectList.
If more than one object is included, the objects must be
enclosed either in quotation marks (") or in braces ({}). If you
specify the -through option multiple times, reset_path applies to
the paths that pass through a member of each objectList. If you
use the -through option in combination with the -from or -to
options, reset_path applies only if the -from or -to and the -through
conditions are satisfied.

-to Specifies the names of objects to use to find path end points.
The -to objectList includes:

e Clocks

* Registers

e Top-level output or bi-directional ports
e Black box inputs

e Sequential cell data input pins

If a specified object is a clock, all flip-flops, latches, and primary
outputs related to that clock are used as path end points.

-rise_to Specifies to use the rising edge of the source clock to find

riseToClock path end points. Use only one of the -to, -rise_to, and -fall_to
options and specify a source clock with one of the -from,
-rise_from, and -fall_from options.

-fall_to fallToClock Specifies to use the falling edge of the source clock to find
path end points. Use only one of the -to, -rise_to, and -fall_to
options and specify a source clock with one of the -from,
-rise_from, and -fall_from options.

-disable Disables the constraint.
-comment Allows the command to accept a comment string. The tool
textString honors the annotation and preserves it with the object so that

the exact string is written out when the constraint is written
out. The comment remains intact through the synthesis,
place-and-route, and timing-analysis flows.
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set_clock _groups

Specifies clock groups that are mutually exclusive or asynchronous with each
other in a design. Clocks created with create_clock are considered synchro-
nous as long as no set_clock_groups constraints specify otherwise. Paths
between asynchronous clocks are not considered for timing analysis.

Clock grouping in the FPGA synthesis environment is inclusionary or exclu-
sionary. For example, clk2 and clk3 can each be related to clkl without being
related to each other.

Syntax

set_clock_groups
-asynchronous | -physically_exclusive | -logically_exclusive
[-name clockGroupname]
-group {clockList} [-group {clockList} ... ]
-derive
[-disable]
[-comment commentString]

Arguments

-asynchronous Specifies that the clock groups are asynchronous to each
other (the default assumes all clock groups are
synchronous). Two clocks are asynchronous with respect
to each other if they have no phase relationship at all.

-physically_exclusive  Specifies that the clock groups are physically exclusive to
each other. An example is multiple clocks that are defined
on the same source pin.

Synthesis accepts this option, but treats it as -asynchronous.

-logically_exclusive Specifies that the clock groups are logically exclusive to
each other. An example is multiple clocks that are selected
by a multiplexer, but might have coupling with each other
in the design.

Synthesis accepts this option, but treats it as -asynchronous.

-name Specifies a uniqgue name for a clock grouping. This option
{clockGroupName} allows you to easily identify specified clock groups, which
are exclusive or asynchronous with all other clock groups
in the design.
Synplify Pro for Microchip Edition Command Reference © 2021 Synopsys, Inc.
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-group {clockList} Specifies a space-separated list of clocks in {clockList} that
are asynchronous to all other clocks in the design, or
asynchronous to the clocks specified in other -group
arguments in the same command.

If you specify only one group, the clocks in that group are
exclusive or asynchronous with all other clocks in the
design. Whenever a new clock is created, it is automatically
included in the default “other” group that includes all the
other clocks in the design.

If you specify -group multiple times in a single command
execution, the listed clocks are only asynchronous with the
clocks in the other groups specified in the same command.
You can include a clock in only one group in a single
command execution. To include a clock in multiple groups,
use multiple set_clock_groups commands.

Do not use commas between clock names in the list. See
-group Option , on page 274.

-disable Disables the constraint.

-comment textString Allows the command to accept a comment string. The tool
honors the annotation and preserves it with the object so
that the exact string is written out when the constraint is
written out. The comment remains intact through the
synthesis, place-and-route, and timing-analysis flows.

Restrictions

Be aware of the restrictions for the following set_clock_groups options:

-group Option

Do not insert commas between clock names when you use the -group option,
because the tool treats the comma as part of the clock name. This is true for
all constraints that contain lists. This means that if you specify the following
constraint, the tool generates a warning that it cannot find clkl,:

set _cl ock_groups -asynchronous -group {cl ki, clk2}

Examples

The following examples illustrate how to use this constraint.
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Example 1
This set_clock groups constraint specifies that clk4 is asynchronous to all other
clocks in the design.

set cl ock_groups -asynchronous -group {cl k4}

Example 2

This set_clock _groups constraint specifies that clock clkl, clk2, and clk3 are
asynchronous to all other clocks in the design. If a new clock called clkx is
added to the design, clkl, clk2, and clk3 are asynchronous to it too.

set _cl ock_groups -asynchronous -group {cl k1l cl k2 cl k3}

Example 3
The following set_clock _groups constraint has multiple -group arguments, and
specifies that clkl and clk2 are asynchronous to clk3 and clk4.

set _cl ock_groups -asynchronous -group {cl k1l cl k2}
-group {cl k3 cl k4}

Example 4

The following set_clock_groups constraint specifies that clkl and clk2 which were
synchronous when defined with the create_clock command, are now asynchro-
nous.

create_clock [get_ports {cl1l}] -nane clkl -period 10

create clock [get ports {c2}] -nane cl k2 -period 16

create clock [get ports {c3}] -nane cl k3 -period 5

set _cl ock_groups -asynchronous -group [get_clocks {cl kl}]
-group [get_cl ocks {cl k2}]

The following constructs are equivalent:
set _cl ock_groups -asynchronous -group [get_clocks {cl kl}]

set cl ock_groups -asynchronous -group {cl ki1}

Example 5

The following constraint specifies that test|clkoutO_derived_clock_CLKIN1 and
test|clkoutl derived clock CLKIN1 are asynchronous to all other clocks in the
design:
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set _cl ock_groups -asynchronous -group [get clocks {*cl kout*}]

Example 6

This example defines the clock on the ul.clkoutO net is asynchronous to all
other clocks in the design:

set _cl ock_groups -asynchronous -group [get_clocks -of objects
{n:ul. cl kout 0}]

Examples of Asynchronous Clocks

Example 1: Multiple -group Arguments for Asynchronous Clock Definition
This method uses multiple -group arguments in one constraint:

set _cl ock_groups -asynchronous -group {clkl cl k2} -group {cl k3
bcl k4} -group {cl k5 ccl k6}

With this constraint, members of the same group are synchronous, but
relationships between clocks from different groups defined in this constraint
are asynchronous. This has the following implications:

¢ clkl and clk2 are synchronous to each other, but asynchronous to clocks
in all other groups defined in this constraint

¢ clk3 and clk4 are synchronous to each other, but asynchronous to clocks
in all other groups defined in this constraint

¢ clk5 and clk6 are synchronous to each other, but asynchronous to clocks
in all other groups defined in this constraint

Example 2: Single -group Argument for Asynchronous Clock Definition

Asynchronous clocks defined with a single -group argument in a constraint
are asynchronous to all other clocks in the design. You can specify multiple
such constraints. In this example, all six clocks are asynchronous, because
each individual constraint makes that clock asynchronous to all others.

set _cl ock_groups -asynchronous -group {cl kl}
set _cl ock _groups -asynchronous -group {cl k2}
set _cl ock_groups -asynchronous -group {cl k3}
set _cl ock_groups -asynchronous -group {cl k4}
set _cl ock_groups -asynchronous -group {cl k5}
set _cl ock_groups -asynchronous -group {cl k6}
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Examples of Defining Clocks for Clock Muxes

The definition of clocks that are to be muxed together varies slightly,
depending on whether the clocks have the same frequency or not. The
following procedures use this example as an illustration:

[

ey

. -,
CKZ —0 —_—

ki = ._'1/, Clo] 0] e D0 Q0] e———oull _—
clk tmp outl

[

Defining Muxed Clocks with Different Frequencies
If the clocks are asynchronous, separate clock paths must be defined, as
described below.

1. Define the clocks with create_clock constraints.

For the example, two clocks are defined:

create_clock -name {clk1} [get_nets {clk1}] -period 10.0
-waveform {0 5.0}
create_clock -name {clk2} [get_nets {clk2}] -period 10.0 -waveform {0 5.0}

2. Use multiple set_clock groups constraints to mark them as asynchronous
to each other:

set_clock_groups -derive -asynchronous -name {default_clkgroup_0} -group
[get_clocks {clk1}]

set_clock_groups -derive -asynchronous -name {default_clkgroup_1} -group
[get_clocks {clk2}]

3. Check the timing report.

For the example, the tool reports two separate clock paths, one for each
clock.

Defining Muxed Clocks with the Same Frequency

If the clocks have the same phase and frequency, follow this procedure to
define the clocks.
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1. Define the clock at the net connected to the output pin of the mux.
For example:

create_clock -name {clk} [get_nets {clk}] -period 10.0
-waveform {0 5.0}

2. Define the mux output clock as asynchronous to all other clocks, using
a set_clock_groups constraint:

set_clock_groups -derive -asynchronous -name {default_clkgroup_2} -group
[get_clocks {clk}]

3. Check the timing report.

In this case, there should be a single clock path, instead of separate
paths.
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set_clock_latency

Specifies clock network latency.

Syntax
The supported syntax for the set _clock latency constraint is:

set_clock_latency

-source

[-clock {clockList}]
delayValue
{objectList}
[-disable]

Arguments

-source Indicates that the specified delay is applied to the clock source
latency.

-clock clockList Indicates that the specified delay is applied with respect to the
specified clocks. By default, the specified delay is applied to all
specified objects.

delayValue Specifies the clock latency value.

objectList Specifies the input ports for which clock latency is to be set

Description

In the FPGA synthesis tools, the set_clock_latency constraint accepts both clock
objects and clock aliases. Applying a set_clock_latency constraint on a port can
be used to model the off-chip clock delays in a multi-chip environment.

In the above syntax, objectList references either input ports with defined
clocks or clock aliases defined on the input ports. When more than one clock
is defined for an input port, the -clock option can be used to apply different
latency values to each alias.

Restrictions

The following limitations are present in the FPGA synthesis environment:
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* Clock latency can only be applied to clocks defined on input ports.
* The set_clock latency constraint is only used for source latency.
* The constraint only applies to port clock objects.

¢ Latency on clocks defined with create_generated_clock is not supported.
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set_clock _uncertainty

Specifies the uncertainty (skew) of the specified clock networks.

Syntax

The supported syntax for the set _clock uncertainty constraint is:

set_clock_uncertainty

{objectList}

-from fromClock |-rise_from riseFromClock | -fall_from fallFromClock
-to toClock |-rise_to riseToClock | -fall_to fallToClock

value

Arguments

objectList

-from fromClock

-rise_from
riseFromClock

-fall_from
fallFromClock

-to toClock

-rise_to
riseToClock

Synplify Pro for Microchip Edition Command Reference
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Specifies the clocks for simple uncertainty. The uncertainty is
applied to the capturing latches clocked by one of the specified
clocks. You must specify either this argument or a clock pair
with the -from/-rise_from/-fall_from and -to/-rise_to/-fall_to options;
you cannot specify both an object list and a clock pair.

Specifies the source clocks for interclock uncertainty. You can
use only one of the -from, -rise_from, and -fall_from options and you
must specify a destination clock with one of the -to, -rise_to, and
-fall_to options.

Specifies that the uncertainty applies only to the rising edge of
the source clock. You can use only one of the -from, -rise_from,
and -fall_from options and you must specify a destination clock
with one of the -to, -rise_to, and -fall_to options.

Specifies that the uncertainty applies only to the falling edge of
the source clock. You can use only one of the -from, -rise_from,
and -fall_from options and you must specify a destination clock
with one of the -to, -rise_to, and -fall_to options.

Specifies the destination clocks for interclock uncertainty. You
can use only one of the -to, -rise_to, and -fall_to options and you

must specify a source clock with one of the -from, -rise_from, and
-fall_from options.

Specifies that the uncertainty applies only to the rising edge of
the destination clock. You can use only one of the -to, -rise_to,
and -fall_to options and you must specify a source clock with one
of the -from, -rise_from, and -fall_from options.

© 2021 Synopsys, Inc.
Synopsys Confidential Information 281



Constraint Commands Timing Constraints

-fall_to fallToClock Specifies that the uncertainty applies only to the falling edge of
the destination clock. You can use only one of the -to, -rise_to,
and -fall_to options and you must specify a source clock with one
of the -from, -rise_from, and -fall_from options.

value Specifies a floating-point number that indicates the uncertainty
value. Only positive uncertainty numbers are acceptable.

Examples

Refer to the following examples.

Example 1
All paths to registers clocked by clk are specified with setup uncertainty of 0.4
in the following example:

set _clock uncertainty 0.4 -setup [get_cl ocks clK]

Example 2
For this example, interclock uncertainties are specified between clock clk and
clk2:

set _clock uncertainty -from[get clocks clk] -to
[get _clocks cl k2] 0.2

set _clock uncertainty -from[get clocks clk2] -to
[get _clocks clk] 0.1

Example 3
For this example, interclock uncertainties are specified between clock clk and
clk2 with specific edges:

set _clock uncertainty -rise from[get _clocks clk2] -to
[get _clocks clk] 0.5

set _clock uncertainty -rise from[get _clocks clk2] -rise_to
[get _clocks clk] 0.1

set _clock uncertainty -from[get clocks clk2] -fall to
[get _clocks clk] 0.1
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set_false path

Removes timing constraints from particular paths.

Syntax
The supported syntax for the set false_path constraint is:

set_false_path
[-setup]
[-from {objectList} |-rise_from riseFromClock | -fall_from fallFromClock]
[-through {objectList} [-through {objectList} ...] ]
[to {objectList} |-rise_to riseToClock | -fall_to fallToClock]
[-disable]
[-comment commentString]

Arguments

-setup Specifies that setup checking (maximum delay) is reset to
single-cycle behavior.

-from Specifies the names of objects to use to find path start points.
The -from objectList includes:
* Clocks
* Registers
e Top-level input or bi-directional ports
* Black box outputs
« Sequential cell clock pins
* When the specified object is a clock, all flip-flops, latches, and

primary inputs related to that clock are used as path start
points.

-rise_from Specifies to use the rising edge of the source clock to find

riseFromClock path start points. Use only one of the -from, -rise_from, and
-fall_from options and specify a destination clock with one of
the -to, -rise_to, and -fall_to options.

-fall_from Specifies to use the falling edge of the source clock to find

fallFromClock path start points. Use only one of the -from, -rise_from, and
-fall_from options and specify a destination clock with one of
the -to, -rise_to, and -fall_to options.
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-through Specifies the intermediate points for the timing exception. The
-through objectList includes:

e Combinational nets

e Hierarchical ports

e Pins on instantiated cells
e Cell instances

By default, the through points are treated as an OR list. The
constraint is applied if the path crosses any points in objectList.
If more than one object is included, the objects must be
enclosed either in quotation marks (") or in braces ({}). If you
specify the -through option multiple times, set_path applies to the
paths that pass through a member of each objectList. If you use
the -through option in combination with the -from or -to options,
set_false_path applies only if the -from or -to and the -through
conditions are satisfied.

-to Specifies the names of objects to use to find path end points.
The -to objectList includes:

Clocks

Registers

Top-level output or bi-directional ports
Black box inputs

» Sequential cell data input pins

If a specified object is a clock, all flip-flops, latches, and primary
outputs related to that clock are used as path end points.

-rise_to Specifies to use the rising edge of the source clock to find

riseToClock path end points. Use only one of the -to, -rise_to, and -fall_to
options and specify a source clock with one of the -from,
-rise_from, and -fall_from options.

-fall_to fallToClock Specifies to use the falling edge of the source clock to find
path end points. Use only one of the -to, -rise_to, and -fall_to
options and specify a source clock with one of the -from,
-rise_from, and -fall_from options.

-disable Disables the constraint.
-comment Allows the command to accept a comment string. The tool
textString honors the annotation and preserves it with the object so that

the exact string is written out when the constraint is written
out. The comment remains intact through the synthesis,
place-and-route, and timing-analysis flows.
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Examples

Refer to the following examples.

Example 1

All the paths from the sequential cell output pins and clock pins in module
gen_sub\[*\].u_sub with names matching out* (i.e. registers outl and out2 in
modules gen_sub\[0\].u_sub, gen_sub\[1\].u_sub, and gen_sub\[2\].u_sub) are set as
false paths.

set false path -from[get _pins {gen_sub\[*\]\.u_sub.out*.*}]

Note: Only sequential clock pins are valid pins that can be used as
start points for a timing path. Note that hierarchical module pins
are not valid as starting points for a timing path.

Example 2

All the paths from the sequential cells in module gen_sub\[*\].u_sub with names
matching out* (i.e. registers outl and out2 in modules gen_sub\[0\].u_sub,
gen_sub\[1\].u_sub, and gen_sub\[2\].u_sub) are set as false paths.

set false path -from[get cells {gen sub\[*\]\.u_sub. out*}]

Example 3
All paths from top-level input ports with names in* are set as false paths.

set false path -from[get ports {in*}]

Note: Only top-level ports are valid port based start points for timing
paths. Do not use the get_ports command to reference hierarchical
module pins.

Example 4
All paths with end points clocked by clock clka are set as false paths.

set false path -to [get _clocks {cl ka}]
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set_input_delay

Sets input delay on pins or input ports relative to a clock signal.

Syntax

The supported syntax for the set input_delay constraint is:

set_input_delay
[-clock clockName [-clock_fall]]

[-rise|-fall]

[-min]-max]
[-add_delay]

delayValue

{portPinList}

[-disable]

[-comment commentString]

Argument

-clock clockName

-clock_fall

-rise

© 2021 Synopsys, Inc.
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Specifies the clock to which the specified delay is related. If
-clock_fall is used, -clock clockName must be specified. If -clock is
not specified, the delay is relative to time zero for combinational
designs. For sequential designs, the delay is considered relative
to a new clock with the period determined by considering the
sequential cells in the transitive fanout of each port.

Specifies that the delay is relative to the falling edge of the clock.
The default is the rising edge.

Specifies that delayValue refers to a rising transition on the
specified ports of the current design. If neither -rise nor -fall is
specified, rising and falling delays are assumed to be equal.

Currently, the synthesis tool does not differentiate between the
rising and falling edges for the data transition arcs on the
specified ports. The worst case path delay is used instead.
However, the -rise option is preserved and forward annotated to
the place-and-route tool.

Synplify Pro for Microchip Edition Command Reference
Synopsys Confidential Information June 2021



Timing Constraints

Constraint Commands

-fall

-min

-max

-add_delay

-disable

-comment
textString

delayValue

portPinList

Specifies that delayValue refers to a falling transition on the
specified ports of the current design. If neither -rise nor -fall is
specified, rising and falling delays are assumed equal.

Currently, the synthesis tool does not differentiate between the
rising and falling edges for the data transition arcs on the
specified ports. The worst case path delay is used instead.
However, the -fall option is preserved and forward annotated to
the place-and-route tool.

Specifies that delayValue refers to the shortest path. If neither
-max nor -min is specified, maximum and minimum input delays
are assumed equal.

Note: The synthesis tool does not optimize for hold time
violations and only reports -min delay values in the

synl og/ t opLevel fpga mapper.srr_M n timing report section
of the log file. The -min delay values are forward annotated to the
place-and-route tool.

Specifies that delayValue refers to the longest path. If neither
-max nor -min is specified, maximum and minimum input delays
are assumed equal.

Note: The -max delay values are reported in the top-level log file
and are forward annotated to the place-and-route tool.

Specifies if delay information is to be added to the existing input
delay or if is to be overwritten. The -add_delay option enables you
to capture information about multiple paths leading to an input
port that are relative to different clocks or clock edges.

Disables the constraint.

Allows the command to accept a comment string. The tool
honors the annotation and preserves it with the object so that
the exact string is written out when the constraint is written
out. The comment remains intact through the synthesis,
place-and-route, and timing-analysis flows.

Specifies the path delay. The delayValue must be in units
consistent with the technology library used during optimization.
The delayValue represents the amount of time the signal is
available after a clock edge. This represents a combinational
path delay from the clock pin of a register.

Specifies a list of input port names in the current design to
which delayValue is assigned. If more than one object is
specified, the objects are enclosed in quotes (") or in braces ({}).
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Examples

Refer to the following examples.

Example 1
This example sets an input delay of 1.0 relative to the rising edge of clk.

set _input_delay 1.00 -clock clk [get_ports {dinl din2}]

Example 2
The following example sets an input delay of 1.0 relative to the rising edge of
clk for all inputs in the design.

set_input_delay 1.00 -clock clk [all _inputs]

Example 3

In this scenario, there are two paths to the input port dinl. The input delay for
the first path is relative to the rising edge of clk. For the second path, the
input delay is relative to the falling edge of clk. The -add_delay option indicates
that the new input delay information does not cause old information to be
removed.

set _input_delay 1.00 -clock clk [get_ports {dinil}]

set_input_delay 2.00 -clock clk [get_ports {dinl}] -add _del ay
-clock_fall
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set_max_delay

Specifies a maximum delay target for paths in the current design.

Syntax
The supported syntax for the set max_delay constraint is:

set_max_delay
[-from {objectList} |-rise_from riseFromClock | -fall_from fallFromClock]
[-through {objectList} [-through {objectList} ...] ]
[to {objectList} |-rise_to riseToClock | -fall_to fallToClock]
delayValue
[-disable]
[-comment commentString]

Arguments

-from Specifies the names of objects to use to find path start points.
The -from objectList includes:
e Clocks
e Registers
* Top-level input or bi-directional ports
e Black box outputs
« Sequential cell clock pins
When the specified object is a clock, all flip-flops, latches, and
primary inputs related to that clock are used as path start
points. All paths from these start points to the end points in the
-from objectList are constrained to delayValue. If a -to objectList is
not specified, all paths from the -from objectList are affected. If
you include more than one object, you must enclose the objects
in quotation marks (") or braces ({}).

-rise_from Specifies to use the rising edge of the source clock to find

riseFromClock path start points. Use only one of the -from, -rise_from, and
-fall_from options and specify a destination clock with one of
the -to, -rise_to, and -fall_to options.

-fall_from Specifies to use the falling edge of the source clock to find

fallFromClock path start points. Use only one of the -from, -rise_from, and
-fall_from options and specify a destination clock with one of
the -to, -rise_to, and -fall_to options.
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-through Specifies the intermediate points for the timing exception. The
-through objectList includes:

e Combinational nets

e Hierarchical ports

e Pins on instantiated cells
e Cell instances

By default, the through points are treated as an OR list. The
constraint is applied if the path crosses any points in objectList.
The max delay value applies only to paths that pass through
one of the points in the -through objectList. If more than one
object is included, the objects must be enclosed either in
quotation marks (") or in braces ({}). If you specify the -through
option multiple times, set_max_delay applies to the paths that
pass through a member of each objectList. If you use the -through
option in combination with the -from or -to options, set_max_delay
applies only if the -from or -to and the -through conditions are
satisfied.

-to Specifies the names of objects to use to find path end points.
The -to objectList includes:

Clocks

Registers

Top-level output or bi-directional ports

Black box inputs

< Sequential cell data input pins

If a specified object is a clock, all flip-flops, latches, and primary
outputs related to that clock are used as path end points. All
paths to the end points in the -to objectList are constrained to
delayValue. If a -from objectList is not specified, all paths to the

-to objectList are affected. If you include more than one object,
you must enclose the objects in quotation marks (") or braces

(-

-rise_to Specifies to use the rising edge of the source clock to find

riseToClock path end points. Use only one of the -to, -rise_to, and -fall_to
options and specify a source clock with one of the -from,
-rise_from, and -fall_from options.

-fall_to fallToClock Specifies to use the falling edge of the source clock to find
path end points. Use only one of the -to, -rise_to, and -fall_to
options and specify a source clock with one of the -from,
-rise_from, and -fall_from options.

-disable Disables the constraint.
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-comment
textString

delayValue

Examples

Allows the command to accept a comment string. The tool
honors the annotation and preserves it with the object so that
the exact string is written out when the constraint is written
out. The comment remains intact through the synthesis,
place-and-route, and timing-analysis flows.

Specifies the value of the desired maximum delay for paths
between start and end points. You must express delayValue in
the same units as the technology library used during
optimization. If a path start point is on a sequential device,
clock skew is included in the computed delay. If a path start
point has an input delay specified, that delay value is added to
the path delay. If a path end point is on a sequential device,
clock skew and library setup time are included in the computed
delay. If the end point has an output delay specified, that delay
is added into the path delay.

This example shows how to specify that all paths from cell templ to cell temp2
must be less than 4.0 units.

set_max_delay -from[get cells {tenpl}] -to [get _cells {tenp2}] 4
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set_min_delay

Specifies a minimum delay target for paths in the current design.

Syntax

set_min_delay
[-from {objectList} |-rise_from riseFromClock | -fall_from fallFromClock]
[-through {objectList} [-through {objectList} ...] ]
[-to {objectList} |-rise_to riseToClock | -fall_to fallToClock]
delayValue
[-disable]
[-comment commentString]

-from {objectList}
Specifies the names of objects to use to find path start points. The -from
objectList includes:

— Clocks

— Registers

— Top-level input or bidirectional ports
— Black box outputs

— Sequential cell clock pins

When the specified object is a clock, all flip-flops, latches, and primary
inputs related to that clock are used as path start points. All paths from
these start points to the end points in the -from objectList are constrained
to delayValue. If a -to objectList is not specified, all paths from the -from
objectList are affected. If you include more than one object, enclose the
objects in quotation marks (") or braces ({}).

-rise_from riseFromClock
Specifies to use the rising edge of the source clock to find path start
points. Use only one of the -from, -rise_from, and -fall_from options and
specify a destination clock with one of the -to, -rise_to, and -fall_to options.

-fall_from fallFromClock
Specifies to use the falling edge of the source clock to find path start
points. Use only one of the -from, -rise_from, and -fall_from options and
specify a destination clock with one of the -to, -rise_to, and -fall_to options.
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-through
Specifies the intermediate points for the timing exception. The -through
objectList includes:

— Combinational nets

— Hierarchical ports

— Pins on instantiated cells
— Cell instances

By default, the through points are treated as an OR list. The constraint
is applied if the path crosses any points in objectList. The minimum
delay value applies only to paths that pass through one of the points in
the -through objectList. If more than one object is included, the objects
must be enclosed either in quotation marks (") or in braces ({}). If you
specify the -through option multiple times, set_min_delay applies to the
paths that pass through a member of each objectList. When using the
-through option in combination with the -from or -to options, set_min_delay
applies only if the -from or -to and the -through conditions are satisfied.

Specifies the names of objects to use to find path end points. The -to
objectList includes:

— Clocks

— Registers

— Top-level input or bidirectional ports
— Black box outputs

If a specified object is a clock, all flip-flops, latches, and primary outputs
related to that clock are used as path end points. All paths to the end
points in the -to objectList are constrained to delayValue. If a -from objectList
is not specified, all paths to the -to objectList are affected. When including
more than one object, enclose the objects in quotation marks (") or
braces ({}).

-rise_to riseToClock
Specifies to use the rising edge of the source clock to find path end
points. Use only one of the -to, -rise_to, and -fall_to options and specify a
source clock with one of the -from, -rise_from, and -fall_from options.

Synplify Pro for Microchip Edition Command Reference © 2021 Synopsys, Inc.
June 2021 Synopsys Confidential Information 293



Constraint Commands Timing Constraints

-fall_to fallToClock
Specifies to use the falling edge of the source clock to find path end
points. Use only one of the -to, -rise_to, and -fall_to options and specify a
source clock with one of the -from, -rise_from, and -fall_from options.

delayValue

Specifies the value of the desired minimum delay for paths between start
and end points. If a path start point is on a sequential device, clock skew
is included in the computed delay. If a path start point has an input
delay specified, that delay value is added to the path delay. If a path end
point is on a sequential device, clock skew and library setup time are
included in the computed delay. If the end point has an output delay
specified, that delay is added into the path delay.

-disable
Disables the constraint.

-comment textString
Allows the command to accept a comment string. The tool honors the
annotation and preserves it with the object so that the exact string is
written out when the constraint is written out. The comment remains
intact through the synthesis, place-and-route, and timing-analysis
flows.

Examples

This example shows how to specify that all paths from cell templ to cell temp2
must be greater than 4.0 units.

set_mn_delay -from[get cells {tenpl}] -to [get cells {tenp2}] 4
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set_multicycle path

Modifies the single-cycle timing relationship of a constrained path.

Syntax

The supported syntax for the set multicycle_path constraint is:

set_multicycle_path
[-setup |-hold]
[-start [-end]
[-from {objectList} |-rise_from riseFromClock | -fall_from fallFromClock]
[through {objectList} [-through {objectList} ...] ]
[-to {objectList} |-rise_to riseToClock | -fall_to fallToClock]
pathMultiplier

[-disable]

[-comment commentString]

Arguments

-setup |-hold

-start | -end

Synplify Pro for Microchip Edition Command Reference
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The option -setup specifies the pathMultiplier to be used for the
setup (maximum delay) calculations.

The option -hold enables you to over-ride the default hold
multiplier—{pathMultiplier — 1}— that is forward annotated to the
vendor constraint file. If you use this option, you must specify
the hold value for each of the defined multicycle constraints.

If you do not provide -setup or -hold, the pathMultiplier is used
for setup.

Specifies if the multi-cycle information is relative to the period of
either the start clock or the end clock. These options are only
needed for multi-frequency designs; otherwise start and end are
equivalent. The start clock is the clock source related to the
register or primary input at the path start point. The end clock
is the clock source related to the register or primary output at
the path endpoint. The default is to move the setup check
relative to the end clock, and the hold check relative to the start
clock. A setup multiplier of 2 with -end moves the relation
forward one cycle of the end clock. A setup multiplier of 2 with
-start moves the relation back one cycle of the start clock. A hold
multiplier of 1 with -start moves the relation forward one cycle of
the start clock. A hold multiplier of 1 with -end moves the
relation back one cycle of the end clock. If you do not provide
-start or -end, -end is assumed.

© 2021 Synopsys, Inc.
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-from

-rise_from
riseFromClock

-fall_from
fallFromClock

-through
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Specifies the names of objects to use to find path start points.
The -from objectList includes:

e Clocks

* Registers

Top-level input or bi-directional ports
Black box outputs

Sequential cell clock pins

« Sequential cell data output pins

When the specified object is a clock, all flip-flops, latches, and
primary inputs related to that clock are used as path start
points. If a -to objectList is not specified, all paths from the -from
objectList are affected. If you include more than one object, you
must enclose the objects in quotation marks (") or braces ({}).

Specifies to use the rising edge of the source clock to find
path start points. Use only one of the -from, -rise_from, and
-fall_from options and specify a destination clock with one of
the -to, -rise_to, and -fall_to options.

Specifies to use the falling edge of the source clock to find
path start points. Use only one of the -from, -rise_from, and
-fall_from options and specify a destination clock with one of
the -to, -rise_to, and -fall_to options.

Specifies the intermediate points for the timing exception. The
-through objectList includes:

e Combinational nets

e Hierarchical ports

< Pins on instantiated cells
e Cell instances

The multi-cycle values apply only to paths that pass through
one of the points in the -through objectList. If more than one
object is included, the objects must be enclosed either in double
quotation marks (") or in braces ({}). If you specify the -through
option multiple times, set_multicycle_delay applies to the paths
that pass through a member of each objectList. If the -through
option is used in combination with the -from or -to options, the
multi-cycle values apply only if the -from or -to conditions and
the -through conditions are satisfied.
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-to Specifies the names of objects to use to find path end points.
The -to objectList includes:

* Clocks

* Registers

e Top-level output or bi-directional ports
e Black box inputs

* Sequential cell data input pins

If a specified object is a clock, all flip-flops, latches, and primary
outputs related to that clock are used as path end points. If a
-from objectList is not specified, all paths to the -to objectList are
affected. If you include more than one object, you must enclose
the objects in quotation marks (") or braces ({})..

-rise_to Specifies to use the rising edge of the source clock to find

riseToClock path end points. Use only one of the -to, -rise_to, and -fall_to
options and specify a source clock with one of the -from,
-rise_from, and -fall_from options.

-fall_to fallToClock Specifies to use the falling edge of the source clock to find
path end points. Use only one of the -to, -rise_to, and -fall_to
options and specify a source clock with one of the -from,
-rise_from, and -fall_from options.

pathMultiplier Specifies the number of cycles that the data path must have,
relative to the start point or end point clock, before data is
required at the end point.

-disable Disables the constraint.
-comment Allows the command to accept a comment string. The tool
textString honors the annotation and preserves it with the object so that

the exact string is written out when the constraint is written
out. The comment remains intact through the synthesis,
place-and-route, and timing-analysis flows.
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Examples

Refer to the following examples.

Example 1

All the paths from the sequential cell output pins and clock pins in module
gen_sub\[*\].u_sub with names matching out* (i.e. registers outl and out2 in
modules gen_sub\[0\].u_sub, gen_sub\[1\].u_sub, and gen_sub\[2\].u_sub) provide 2
timing cycles before the data is required at the end point.

set_multicycle path -from[get pins{gen sub\[*\]\.u sub.out*.*}] 2

Note: Only sequential clock pins are pins that can be used as valid
start points for a timing path. Note that hierarchical module pins
cannot be used as starting points for a timing path.

Example 2

All the paths from the sequential cells in module gen_sub\[*\].u_sub with names
matching out* (i.e. registers outl and out?2 in modules gen_sub\[0\].u_sub,
gen_sub\[1\].u_sub, and gen_sub\[2\].u_sub) support the timing cycle set to 2.

set_multicycle path -from[get cells {gen_sub\[*\]\.u sub.out*}] 2

Example 3

All paths from top-level input ports with names in* provide 2 timing cycles
before the data is required at the end point.

set_nulticycle path -from[get_ports {in*}] 2

Note: Only top-level ports are valid port based start points for timing
paths. Do not use the get ports command to reference
hierarchical module pins.

Example 4

All paths with end points clocked by clock clka provide 2 timing cycles before
the data is required at the end point.
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set_ multicycle path -to [get_clocks {clka}] 2
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set_output_delay

Sets output delay on pins or output ports relative to a clock signal.

Syntax

The supported syntax for the set output delay constraint is:

set_output_delay
[-clock clockName [-clock_fall]]

[-rise]|[-fall]

[-min]-max]
[-add_delay]

delayValue

{portPinList}

[-disable]

[-comment commentString]

Arguments

-clock clockName

-clock_fall

-rise

© 2021 Synopsys, Inc.
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Specifies the clock to which the specified delay is related. If
-clock_fall is used, -clock clockName must be specified. If -clock is
not specified, the delay is relative to time zero for combinational
designs. For sequential designs, the delay is considered relative
to a new clock with the period determined by considering the
sequential cells in the transitive fanout of each port.

Specifies that the delay is relative to the falling edge of the clock.
If -clock is specified, the default is the rising edge.

Specifies that delayValue refers to a rising transition on the
specified ports of the current design. If neither -rise nor -fall is
specified, rising and falling delays are assumed to be equal.

Currently, the synthesis tool does not differentiate between the
rising and falling edges for the data transition arcs on the
specified ports. The worst case path delay is used instead.
However, the -rise option is preserved and forward annotated to
the place-and-route tool.

Synplify Pro for Microchip Edition Command Reference
Synopsys Confidential Information June 2021



Timing Constraints Constraint Commands

-fall Specifies that delayValue refers to a falling transition on the
specified ports of the current design. If neither -rise nor -fall is
specified, rising and falling delays are assumed equal.

Currently, the synthesis tool does not differentiate between the
rising and falling edges for the data transition arcs on the
specified ports. The worst case path delay is used instead.
However, the -fall option is preserved and forward annotated to
the place-and-route tool.

-min Specifies that delayValue refers to the shortest path. If neither
-max nor -min is specified, maximum and minimum output
delays are assumed equal.

Note: The synthesis tool does not optimize for hold time
violations and only reports -min delay values in the

synl og/ t opLevel fpga mapper.srr_M n timing report section
of the log file. The -min delay values are forward annotated to the
place-and-route tool.

-max Specifies that delayValue refers to the longest path. If neither
-max nor -min is specified, maximum and minimum output
delays are assumed equal.

Note: The -max delay values are reported in the top-level log file
and are forward annotated to the place-and-route tool.

-add_delay Specifies whether to add delay information to the existing
output delay or to overwrite. The -add_delay option enables you
to capture information about multiple paths leading to an
output port that are relative to different clocks or clock edges.

-disable Disables the constraint.
-comment Allows the command to accept a comment string. The tool
textString honors the annotation and preserves it with the object so that

the exact string is written out when the constraint is written
out. The comment remains intact through the synthesis,
place-and-route, and timing-analysis flows.

delayValue Specifies the path delay. The delayValue must be in units
consistent with the technology library used during optimization.
The delayValue represents the amount of time that the signal is
required before a clock edge. For maximum output delay, this
usually represents a combinational path delay to a register plus
the library setup time of that register. For minimum output
delay, this value is usually the shortest path delay to a register
minus the library hold time
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portPinList A list of output port names in the current design to which
delayValue is assigned. If more than one object is specified, the
objects are enclosed in double quotation marks (") or in braces

(-

Examples

Refer to the following examples.

Example 1

This example sets an output delay of 1.00 relative to the rising edge of clk for
all the output ports in the design.

set_output _delay 1.00 -clock clk [all_out puts]

Example 2

The following example sets an output delay of 2.00 relative to the falling edge
of clk for the output port doutl. The -add delay option indicates that this delay
value is to be added to any existing output delays defined on this port.

set_output_delay 2.0 -clock clk [get_ports {doutl}] -add_del ay
-clock _fall
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set_reg_input_delay

Speeds up paths feeding a register by a given number of nanoseconds.

Syntax

set_reg_input_delay {registerName} [-route ns] [-disable] [-comment textString]

Arguments

registerName A single bit, an entire bus, or a slice of a bus.

-route Advanced user option that you use to tighten constraints during
resynthesis, when the place-and-route timing report shows the
timing goal is not met because of long paths to the register.

-comment Allows the command to accept a comment string. The tool honors the
annotation and preserves it with the object so that the exact string is
written out when the constraint is written out. The comment remains
intact through the synthesis, place-and-route, and timing-analysis
flows.

-disable Disables the constraint.

Description

The set_reg_input_delay timing constraint speeds up paths feeding a register by
a given number of nanoseconds. The Synopsys FPGA synthesis tool attempts
to meet the global clock frequency goals for a design as well as the individual
clock frequency goals (set with create_clock). Use this constraint to speed up
the paths feeding a register. For information about the equivalent SCOPE
spreadsheet interface, see Registers, on page 233.

Use this constraint instead of the legacy constraint, define_reg_input_delay.
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set_reg_output_delay

Speeds up paths coming from a register by a given number of nanoseconds.

Syntax

set_reg_output_delay {registerName} [-route ns] [-disable] [-comment textString]

Arguments

registerName A single bit, an entire bus, or a slice of a bus.

-route Advanced user option that you use to tighten constraints during
resynthesis, when the place-and-route timing report shows the
timing goal is not met because of long paths from the register.

-comment Allows the command to accept a comment string. The tool honors
the annotation and preserves it with the object so that the exact
string is written out when the constraint is written out. The
comment remains intact through the synthesis, place-and-route,
and timing-analysis flows.

-disable Disables the constraint.

Description

The set_reg_output_delay constraint speeds up paths coming from a register by
a given number of nanoseconds. The synthesis tool attempts to meet the
global clock frequency goals for a design as well as the individual clock
frequency goals (set with create_clock). Use this constraint to speed up the
paths coming from a register. For information about the equivalent SCOPE
spreadsheet interface, see Registers, on page 233.

Use this constraint instead of the legacy constraint, define_reg_output_delay.

Naming Rule Syntax Commands

The FPGA synthesis environment uses a set of naming conventions for design
objects in the RTL when your project contains constraint files. The following
naming rule commands are added to the constraint file to change the
expected default values. These commands must appear at the beginning of
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the constraint file before any other constraints. Similarly, when multiple
constraint files are included in the project, the naming rule commands must
be in the first constraint file read.

set_hierarchy_separator Command

The set_hierarchy_separator command redefines the hierarchy separator
character (the default separator character is the period in the FPGA synthesis
environment). For example, the following command changes the separator
character to a forward slash:

set _hi erarchy_separator {/}

Embedded Tcl commands, such as get _pins must be enclosed in brackets [ ]
for the software to execute the command. Also, the curly brackets {} are
required when object names include the escape (\) character or square
brackets. For example, the following syntax is honored by the tool:

set _hierarchy separator {/}

create_cl ock -name {cl k1} [get_pins

{pdp_c/ib _phy c/port_g\.1\.phy c/c7_g\.gtxe2 common_0 i/ GIREFCLK] 0] }]
-period {10}

set_rtl_ff names Command

The set_ril_ff names command controls the stripping of register suffixes in the
object strings of delay-path constraints (for example, set_false path, set_multicy-
cle_path). Generally, it is only necessary to change this value from its default
when constraints that target ASIC designs are being imported from the
Design Compiler (in the Design Compiler, inferred registers are given a _reg
suffix during the elaboration phase; constraints targeting these registers
must include this suffix). When importing constraints from the Design
Compiler, include the following command to change the value of this naming
rule to { reg} to automatically recognize the added suffix.

set_rtl_ff_names {_reg}
For example, using the above value allows the DC exception
set false_path -to [get _cells {register_bus reg[0]}]

to apply to the following object without having to manually modify the
constraint:

[get _cells {register bus[0]}]
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bus_naming_style Command

The bus_naming_style command redefines the format for identifying bits of a
bus (by default, individual bits of a bus are identified by the bus name
followed by the bus bit enclosed in square brackets). For example, the
following command changes the bus-bit identification from the default
busName[busBit] format to the busName_busBit format:

bus_nam ng_styl e {%_%l}

bus_dimension_separator_style Command

The bus_dimension_separator_style command redefines the format for identifying
multi-dimensional arrays (by default, multidimensional arrays such as row 2,
bit 3 of array ABC[n x m] are identified as ABC[2][3]). For example, the
following command changes the bus-dimension separator from individual
square bracket sets to an underscore:

bus_di nensi on_separator_style {_}

The resulting format for the above example is:
ABJ 2_3]

read_sdc Command

Reads in a script in Synopsys FPGA constraint format. The supported syntax
for the read_sdc constraint is:

read_sdc fileName
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Design Constraints

This section describes the constraint file syntax for the following non-timing
design constraints:

¢ define_compile_point, on page 308
¢ define_current_design, on page 309

¢ define_io_standard, on page 310
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define_compile_point

The define_compile_point command defines a compile point in a top-level
constraint file. You use one define_compile_point command for each compile
point you define. For the equivalent SCOPE spreadsheet interface, see
Compile Points, on page 239. (Compile points are only available for certain
technologies.)

This is the syntax:

define_compile_point [-disable ] {moduleName}
-type {soft|hard|locked|locked, partition} [-comment textString ]

-disable Disables a previous compile point definition.

-type Specifies the type of compile point. This can be soft, hard, locked, or
locked, partition. See Compile Point Types , on page 440 for more
information.

Refer to Guidelines for Entering and Editing Constraints, on page 136 for
details about the syntax and prefixes for naming objects.

Here is a syntax example:

define_conpile_point {v:work.prgmecntr} -type {l ocked}
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define_current_design

The define_current_design command specifies the module to which the
constraints that follow it apply. It must be the first command in a block-level
or compile-point constraint file. The specified module becomes the top level
for objects defined in this hierarchy and the constraints applied in the respec-
tive block-level or compile-point constraint file.

This is the syntax:
define_current_design {regionName | libraryName.moduleName}

Refer to Guidelines for Entering and Editing Constraints, on page 136 for
details about the syntax and prefixes for naming objects.

Here is an example:
define current_design {libl.prgmcntr}

Objects in all constraints that follow this command relate to prgm_cntr.
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define_io_standard

Specifies a standard 1/0 pad type to use for various vendor-specific families.
See 1I/0 Standards, on page 238 for details of the SCOPE equivalent.

define_io_standard [-disable] {p:portName} -delay_type input|output|bidir
syn_pad_type {IO_standard} [parameter {value}...]

In the above syntax:

portName
is the name of the input, output, or bidirectional port.

-delay_type
identifies the port direction which must be input, output, or bidir.

syn_pad_type
is the 170 pad type (I/0 standard) to be assigned to portName.

parameter
is one or more of the parameters defined in the following table. Note that
these parameters are device-family dependent.

Parameter Function

syn_io_termination The termination type; typical values are pullup and
pulldown.

syn_io_drive The output drive strength; values include low and high
or numerical values in mA.

syn_io_dv2 Switch to use a 2x impedance value (DV2).

syn_io_dci Switch for digitally-controlled impedance (DCI).

syn_io_slew The slew rate for single-ended output buffers; values

include slow and fast or low and high.

Examples:

define_io_standard {p: DATAL[7: 0]} -del ay_type input
syn_pad_t ype {LVOMOS 33} syn_io_slew {high}
syn_io_drive {12} syn_io_termnation {pul | down}

define_i o_standard {p:en} -delay_type input
syn_pad_t ype {LVOMOS 18} syn_io _dci {Dd}
syn_io_dv2 {Dv2}
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Silicon to Software

CHAPTER 5

User Interface Commands

The following describe the graphical user interface (GUI) commands available
from the menus:

File Menu, on page 312

Edit Menu, on page 317

View Menu, on page 331

Project Menu, on page 339
Implementation Options Command, on page 352
Run Menu, on page 388
Analysis Menu, on page 407
HDL Analyst Menu, on page 419
Options Menu, on page 431
Web Menu, on page 461

Help Menu, on page 462

For information about context-sensitive commands accessed from right-click
popup menus, see Chapter 6, GUI Popup Menu Commands.
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File Menu

Use the File menu for opening, creating, saving, and closing projects and files.
The following table describes the File menu commands.

Command

New

& Open

Close

Save

Save As

Save All

Print

Print Setup

Create Image

Build Project

[j Open Project
New Project

© 2021 Synopsys, Inc.

Description

Can create any of the following types of files: Text, Tcl Script,
VHDL, Verilog, P&R Options file, Design Constraints, Analysis
Design Constraints, or Project file. See New Command , on
page 313.

Opens a project or file.

Closes a project file.

Saves a project or a file.

Saves a project or a file to a specified name.
Saves all projects or files.

Prints a file. For more information about printing, see the
operating system documentation.

Specify print options.

This command is available in the following views:
 HDL Analyst Views
e FSM Viewer

A camera pointer ([z) appears. Drag a selection rectangle
around the region tor which you want to create an image, then
release the mouse button. You can also simply click in the
current view, then the Create Image dialog appears. See Create
Image Command , on page 314.

Creates a new project based on the file open in the Text Editor
(if active), or lets you choose files to add to a new project. See
Build Project Command , on page 316.

Opens a project. See Open Project Command , on page 317.

Creates a new project. If a project is already open, it prompts
you to save it before creating a new one. If you want to open
multiple projects, select Allow multiple projects to be opened in the
Project View dialog box. See Project View Options Command , on
page 436.

Synplify Pro for Microchip Edition Command Reference
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Command Description
Close Project Closes the current project.
Recent Projects Lists recently accessed projects. Choose a project listed in the

submenu to open it.

Recent files Lists the last files you recently opened as separate menu items.
(listed as separate Choose a file to open it.
menu items)

Exit Exits the session.

New Command

Select File->New to display the New dialog box, where you can select a file type
to be created (for example, Verilog, VHDL, text, Tcl script, P&R options,
design constraints, analysis design constraints, or project). For most file
types, a text editor window opens to allow you to define the file contents. You
must provide a file name. You can automatically add the new file to your
project by enabling the Add To Project checkbox before clicking OK.

Synplify Pro for Microchip Edition Command Reference © 2021 Synopsys, Inc.
June 2021 Synopsys Confidential Information 313



User Interface Commands

File Menu

-
T New

Fila Type:(Select a type)

Verilog File
VHOL File
Text File
Tcl Script

T = 1 i

B Constraint File (Scope)

T Project File (Project)

Add To Project

MNewr File Name:

File Location:
C:hsynplify_pro\tutorial,

Full Path:
C:\synplify_pro\tutorial,

Synopsys Design Constraints

By Analysis Design Constraints

iy

Cancel

Help

]

b

File Type

Verilog

VHDL

Text

Tcl Script

FPGA Design Constraints
Analysis Design Constraints

Project

Opens Window
Text Editor

Text Editor

Text Editor

Text Editor
SCOPE
SCOPE

None

Create Image Command

Select File->Create Image to create a capture image from any of the following

Views:

© 2021 Synopsys, Inc.
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Directory Name

Verilog

VHDL

Other

Tel Script

Constraint

Analysis Design Constraint

None

Extension
Y

.vhd

. Ixt

. tcl

. fdc

. adc

- Prj
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* HDL Analyst Views
* FSM Viewer

Drag the camera cursor to define the area for the image. When you release
the cursor, the Create Image dialog box appears. Use the dialog box to copy the
image, save the image to a file, or to print the image.

Copy To Clipboard

| Copy to Clipboard |

Save To File

[ C:\designs\Designs_Premier\design_version2.bmp ] E]
Add to Project
V | Save to File |
Print
| Print |
Options
Max Pixels (Save, Copy)
= (T ]
I

Caption
Design Version 2

Field/Option Description

Copy to Clipboard Copies the image to the clipboard so you can paste it into a
selected application (for example, a Microsoft Word file).
When you copy an image to the clipboard, a green check
mark appears in the Copy To Clipboard field.

Save to File Saves the image to the specified file. You can save the file
in a number of formats (platform dependent) including
bmp, jpg, png, ppm, tif, xbom, and xpm.

Add to Project Adds the saved image file to the Images folder in the Project
view. This option is enabled by default.
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Field/Option

Save to File button

Print

Options

Caption

Description

You must click this button to save an image to the
specified file. When you save the image, a green check
mark appears in the Save To File field.

Prints the image. When you print the image, a green check
mark appears in the Print field.

Allows you to select the resolution of the image saved to a
file or copied to the clipboard. Use the Max Pixels slider to
change the image resolution.

Allows you to enter a caption for a saved or copied image.
The overlay for the caption is at the top-left corner of the
image.

Build Project Command

Select File->Build Project to build a new project. This command behaves differ-
ently if an HDL file is open in the Text Editor.

* When an active Text Editor window with an HDL file is open, File->Build
Project creates a project with the same name as the open file.

¢ If no file is open,

File->Build Project prompts you to add files to the project

using the Select Files to Add to New Project dialog box. The name of the new
project is the name of the first HDL file added. See Add Source File
Command, on page 340.
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Open Project Command

Select File->Open Project to open an existing project or to create a new project.

Recent Projects

CA\HPMuinstance_based\top.prj

Chsynplify_pro\tutorial\tutorial.pr)
CA\synthesis\fifo\syn\fifo.prj
Chlibext\exampletop.prj
Cihtest\syn_lec\proj_1.prj
Cihtest\syn_pad_type\proj_1.pr
Chcompile_point_design‘tutorial.prj
Chtestisyn_diff_io\proj_1.prj
Chasyn_regsiproj_1.prj

oK | | Cancel
Field/Option Description
Existing Project Displays the Open Project dialog box for opening an existing
project.
New Project Creates a new project and places it in the Project view.

Edit Menu

You use the Edit menu to edit text files (such as HDL source files) in your
project. This includes cutting, copying, pasting, finding, and replacing text;
manipulating bookmarks; and commenting-out code lines. The Edit menu
commands available at any time depend on the active window or view
(Project, Text Editor, SCOPE spreadsheet, RTL, or Technology views).

The available Edit menu commands vary, depending on your current view.
The following table describes all of the Edit menu commands:
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Edit Menu

Command

Description

Basic Edit Menu Commands

Undo
ﬂ Redo
Cut

Copy
Paste

Delete

Find

Find Next

Find in Files

Cancels the last action.
Performs the action undone by Undo.

Removes the selected text and makes it available to
Paste.

Duplicates the selected text and makes it available to
Paste.

Pastes text that was cut (Cut) or copied (Copy).
Deletes the selected text.

Searches the file for text matching a given search
string; see Find Command (Text) , on page 320. In the
RTL view, opens the Object Query dialog box, which lets
you search your design for instances, symbols, nets,
and ports, by name; see Find Command (HDL Analyst) ,
on page 323. In the project view, searches files for text
strings; see Find Command (In Project) , on page 321.

Continues the search initiated by the last Find.

Performs a string search of the target files. See Find in
Files Command , on page 327.

Edit Menu Commands for the Text Editor

Select All

Replace

Goto

Toggle bookmark

Next bookmark

Previous bookmark
Delete all bookmarks

© 2021 Synopsys, Inc.
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Selects all text in the file.

Finds and replaces text. See Replace Command , on
page 329.

Goes to a specific line number. See Goto Command , on
page 330.

Toggles between inserting and removing a bookmark on
the line that contains the text cursor.

Takes you to the next bookmark.
Takes you to the previous bookmark.

Removes all bookmarks from the Text Editor window.
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Command Description

Advanced->Comment Code Inserts the appropriate comment prefix at the current
text cursor location.

Advanced-> Uncomment Removes comment prefix at the current text cursor
Code location.
Advanced->Uppercase Makes the selected string all upper case.
Advanced->Lowercase Makes the selected string all lower case.
Select->All Selects all text in the file (same as All).
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Find Command (Text)

Select Edit->Find to display the Find dialog box. In the SCOPE window, the FSM
Viewer, and the Text Editor window, the command has basic text-based
search capabilities. Some search features, like regular expressions and
line-number highlighting, are available only in the Text Editor. See Find
Command (In Project), on page 321, to search for files in the Project.

The HDL Analyst Find command is different; see Find Command (HDL
Analyst), on page 323 for details.

| Match yehole word only Direction Mark All

| Match case up
__| Reqular expression @ Down |  cancel

In Text Editor
In SCOPE Options
| Reverse
1_"| Wrap |
¥ | Match Case
Find Next || Cancel
Field/Option Description

Find What/Search for ~ Search string matching the text to find. In the text editor,
you can use the pull-down list to view and reuse search
strings used previously in the current session.

Match whole word only When enabled, matches the entire word rather than a

(text editor only) portion of the word.

Match Case When enabled, searching is case sensitive.

Regular expression When enabled, wildcard characters (* and ?) can be used in
(text editor only) the search string: ? matches any single character; * matches

any string of characters, including an empty string.
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Field/Option Description

Direction/Reverse

Changes search direction. In the text editor, buttons select
the search direction (Up or Down).

Find Next Initiates a search for the search string (see Find What/Search
for). In the text editor, searching starts again after reaching
the end (Down) or beginning (Up) of the file.

Wrap When enabled, searching starts again after reaching the end
(SCOPE only) or beginning (Reverse) of the spread sheet.

Mark All Highlights the line numbers of the text matching the search
(Text editor only) string and closes the Find dialog box.

Find Command (In Project)

Select Edit->Find to display the Find File dialog box. In the Project view, the
command has basic text-based search capabilities to locate files in the

project.

2

all ar part of the file name:

[ eight_bit_uc.v l

Loak in:

|P.II Projecks - |

Find options

[ Makch case
[] Search up
Exclude path

Find Mezxt | | Zancel
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Field/Option Description

All or part of the file ~ Search string matching the file to find. You can specify all or

name part of the file name.

Look in Search for files in all projects or limit the search to files only in
the specified project.

Match Case When enabled, searching is case sensitive.

Search up Searches in the up direction (search terminates when an end
of tree is reached in either direction).

Exclude path Excludes the path name during the search.

Find Next Initiates a search for the file name string.
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Find Command (HDL Analyst)

In the RTL or Technology view, use Edit->Find to display the Object Query
dialog box. For a detailed procedure about using this command, see Using
Find for Hierarchical and Restricted Searches, on page 318 of the User Guide.

E‘Eg;TODJECt’S_ [restaroes | Spmboks | Pk | Ports
Zaath
EEE T T ey
Linkighichted: 0 o =1 - Hgrlghtad: dafa
Objects i | Objects to find
rmatching filter ]d:eux aE in schematic
{search M7 {and select)
i M_Z802
candidates) W—i‘;j;‘m Al
Fatapodd] H
porks pad3] b |:|
Highlight Saarch [*7): Un-Highight Zalaction [*7]):
Filter string — 1= - .- “| gearch by
Mame Space
® Tach Wy T i
comers | K
candidates : ¥
[

The available Find menu commands vary, depending on your current view.
The following table describes all of the Find menu commands:

Tabbed panels for finding different kinds of objects. Choose a panel

consumption, searching for Instances is most efficient, and searching

Field/Option Description
Instances,
Symbols, for a given object type by clicking its tab. In terms of memory
Nets, Ports
for Nets is least efficient.
Search

Where to search: Entire Design, Current Level & Below, or Current

Level Only. See Using Find for Hierarchical and Restricted
Searches, on page 318 of the User Guide.
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Field/Option
UnHighlighted

Highlight
Search (*?)

->

<-

© 2021 Synopsys, Inc.
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Description

Names of all objects of the current panel type, in the level(s) chosen
to Search, that match the Highlight Search (*?) filter. This list is
populated by the Find 200 and Find All buttons.

To select an object as a candidate for highlighting, click its name in
this list. The complete name of the selected object appears near the
bottom of the dialog box. You can select part or all of this complete
name, then use the Ctrl-C keyboard shortcut to copy it for pasting.

You can select multiple objects by pressing the Ctrl or Shift key while
clicking; press Ctrl and click a selection to deselect it. The number of
objects selected, and the total number listed, are displayed above the
list, after the UnHighlighted: label: # selected of # total.

To confirm a selection for highlighting and move the selected objects
to the Highlighted list, click the -> button.

Determines which object names appear in the UnHighlighted area,
based on the case-sensitive filter string that you enter. For tips
about using this field, see Using Wildcards with the Find
Command, on page 321 of the User Guide.

The filter string can contain the following wildcard characters:
« * (asterisk) - matches any sequence of characters
« ? (question mark) - matches any single character

» . (period) - does not match any characters, but indicates a change
in hierarchical level.

Wildcards * and ? only match characters within the current
hierarchy level; a*b*, for example, will not cross levels to match
alpha.beta (where the period indicates a change in hierarchy).

If you must match a period character occurring in a name, use \.
(backslash period) in the filter string. The backslash prevents
interpreting the period as a wildcard.

The filter string is matched at each searched level of the hierarchy
(the Search levels are described above). Use filter strings that are as
specific as possible to limit the number of unwanted matches.
Unnecessarily extensive search can be costly in terms of memory
performance.

Moves the selected names from the UnHighlighted area to the
Highlighted area, and highlights their objects in the RTL and
Technology views.

Moves the selected names from the Highlighted area to the
UnHighlighted area, and unhighlights their objects in the RTL and
Technology views.
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Selection (*?)

Jump to
location

Name Space:

Tech View

Name Space:

Netlist

Synplify Pro for Microchip Edition Command Reference
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Field/Option Description

All -> Moves all names from the UnHighlighted to the Highlighted area, and
highlights their objects in the RTL and Technology views.

<- All Moves all names from the Highlighted to the UnHighlighted area, and
unhighlights their objects in the RTL and Technology views.

Highlighted Complementary and analogous to the UnHighlighted area. You select
object names here as candidates for moving to the UnHighlighted list.
(You move names to the UnHighlighted list by clicking the <- button
which unselects and unhighlights the corresponding objects.)
When you select a name in the Highlighted list, the view is changed to
show the (original, unfiltered) schematic sheet containing the object.

Un-Highlight ~ Complementary and analogous to the Highlight Search area: selects

names in the Highlighted area, based on the filter string you input
here.

When enabled, jumps to another sheet if necessary to show target
objects.

Searches for the specified name using the mapped (.srm) database.
For more information, see Using Find for Hierarchical and
Restricted Searches, on page 318 of the User Guide.

Searches for the specified name using the output netlist file. For
more information, see Using Find for Hierarchical and Restricted
Searches, on page 318 of the User Guide.
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Field/Option Description

Find 200 Adds up to 200 more objects that match the filter string to the
UnHighlighted list. This button becomes available after you enter a
Highlight Search (*?) filter string. This button does not find objects in
HDL Analyst views. It matches names of design objects against the
Highlight Search (*?) filter and provides the candidates listed in the
UnHighlighted list, from which you select the objects to find.

Using the Enter (Return) key when the cursor is in the Highlight
Search (*?) field is equivalent to clicking the Find 200 button.

Usage note:

Click Find 200 before Find All to prevent unwanted matches in case the
Highlight Search (*?) string is less selective than you expect.

Find All Places all objects that match the Highlight Search (*?) filter string in the
UnHighlighted list. This button does not find objects in HDL Analyst
views. It matches names of design objects against the Highlight
Search (*?) filter and provides the candidates listed in the
UnHighlighted list, from which you select the objects to find. (Enter a
filter string before clicking this button.) See Usage Note for Find 200,
above.

For more information on using the Object Query dialog box, see Using Find for
Hierarchical and Restricted Searches, on page 318 of the User Guide.
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Find in Files Command

The Find in Files command searches the defined target for the occurrence of a
specified search string. The list of files containing the string is reported in the
display area at the bottom of the dialog box. For information on using this
feature, see Searching Files, on page 102 of the User Guide.

Find what:
| bblack _inst

Find In:

Files Contained in Project: |C:\J—|PM‘port_cor1text‘l,top.prj

|:| Implementation Directory: |rev_1

|:| Directary: [

[] Result Window (s=arch only in results window below)

Include SubProject files
Include sub-folders for directory searches

File filter: e.g. srryv;vhd;a®. bt

[

Search Options

|| Match case || Match whole word || Use Regular Expressions

Find | I Close I

& matches found in 2 files, Total files searched: &

C:\HPM\port_context\bblock_inst_b1'bblock_inst_b1.pri{3): #— Project file C:\HPM\p
C:\HPMYport_context\bblock_inst_b1'bblock_inst_b1.prj(&): add_file -syn_context ™./t
C:\HPM\port_context\bblock_inst_b1'bblock_inst_b1.pri(2): add_file -fpoa_constraint
C:\HPMport_context\bblock_inst_b1'bblock_inst_b1.pri{10): add_file -fpga_constrain
C:\HPMport_context\top.pri(70): define_link i:b1 -name bblock_inst_b1jrev_1

C:\HPM\port_context\top.pri(75): project -insert ", fbblock_inst_b1/bblock_inst_b1.prj
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Field/Option Description

Find what Text string object of search.

Files Contained in Drop-down menu identifying the source project of the files to
Project be searched.

Implementation Drop-down menu restricting project search to a specific
Directory implementation or all implementations.

Directory Identifies directory for files to be searched.

Result Window Allows a secondary search string (Find what) to be applied to

the targets reported from the initial search.

Include sub-folders When checked, extends the search to sub-directories of the
for directory searches target directory.

File filter Excludes files from the search by filename extension.

Search Options Standard string search options; check to enable.

Find Initiates search.

Result Display List of files containing search string. Status line lists the
number of matches in each file and the number of files
searched.

© 2021 Synopsys, Inc. Synplify Pro for Microchip Edition Command Reference

328 Synopsys Confidential Information June 2021



Edit Menu

User Interface Commands

Replace Command

Use Edit->Replace to find and optionally replace text in the Text Editor.

Replace 2| x]
Find what: [rising_edge(CLK) ]"] | Find Mext I
Replace with: IFaIIing_edge(CLK) I -
[ Match whole word only Replace In
[ Match case () Selection
|:| Reqular expression (@ Whoale file
. | Zancel |
Feature Description
Find what Search string matching the text to find. You can use the
pull-down list to view and reuse search strings used
previously in the current session.
Replace with The text that replaces the found text. You can use the

Match whole word
only

Match case

Regular expression

Selection
Whole file
Find Next

Replace

Replace All

Synplify Pro for Microchip Edition Command Reference
June 2021

pull-down list to view and reuse replacement text used
previously in the current session.

Finds only occurrences of the exact string (strings longer than
the Find what string are not recognized).

When enabled, searching is case sensitive.

When enabled, wildcard characters (* and ?) can be used in
the search string: ? matches any single character; * matches
any string of characters, including the empty string.

Replace All replaces only the matched occurrence.
Replace All replaces all matching occurrences.
Initiates a search for the search string (see Find What).

Replaces the found text with the replacement text, and locates
the next match.

Replaces all text that matches the search string.

© 2021 Synopsys,
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Goto Command

Use Edit->Goto to go to a specified line number in the Text Editor.

B synplify [ 2]
Go ko line (1-108):

[} )

I Ok II Zancel I
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View Menu

Use the View menu to set the display and viewing options, choose toolbars,
and display result files. The commands in the View menu vary with the active
view. The following tables describe the View menu commands in various

views.

* View Menu Commands: All Views, on page 331

* View Menu

: Zoom Commands, on page 332

* View Menu: RTL and Technology Views Commands, on page 332

* View Menu

: FSM Viewer Commands, on page 333

View Menu Commands: All Views

Command

Font Size

Toolbars

Status Bar

Refresh
Output Windows

Tel Window

Description

Changes the font size in the Project Ul of the synthesis tools.
You can select one of the following options:

* Increase Font Size
* Decrease Font Size
* Reset Font Size (default size)

Displays the Toolbars dialog box, where you specify the
toolbars to display. See Toolbar Command , on page 334.

When enabled, displays context-sensitive information in the
lower-left corner of the main window as you move the mouse
pointer over design elements. This information includes
element identification.

Updates the Ul display of project files and folders.

Displays or removes the Tcl Script/Messages and Watch
windows simultaneously in the Project view. Refer to the Tcl
Window and Watch Window options for more information.

When enabled, displays the Tcl Script and Messages
windows. All commands you execute in the Project view
appear in the Tcl window. You can enter or paste Tcl
commands and scripts in the Tcl window. Check for notes,
warning, and errors in the Messages window.

Synplify Pro for Microchip Edition Command Reference © 2021 Synopsys, Inc.
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Command

Watch Window

View Log File

View Result File

Description

When enabled, displays selected information from the log
file in the Watch window.

Displays a log file report that includes compiler, mapper,
and timing information on your design. See View Log File
Command, on page 336.

Displays a detailed netlist report.

View Menu: Zoom Commands

Command
Zoom In

Zoom Out

Pan

Full View
Normal View

Description

Lets you Zoom in or out. When selected, a Z-shaped mouse
pointer ( z ) appears. Zoom in or out on the view by clicking or
dragging a box around (lassoing) the region. Clicking zooms in
or out on the center of the view; lassoing zooms in or out on
the lassoed region. Right-click to exit zooming mode.

In the SCOPE spreadsheet, selecting these commands
increases or decreases the view in small increments.

Lets you pan (scroll) a schematic or FSM view using the
mouse.
If your mouse has a wheel feature, use the wheel to pan up

and down. To pan left and right, use the Shift key with the
wheel.

Zooms the active view so that it shows the entire design.

Zooms the active view to normal size and centers it where you
click. If the view is already normal size, clicking centers the
view.

View Menu: RTL and Technology Views Commands

These commands are available when the RTL view or Technology view is
active. These commands are available in addition to the commands described
in View Menu Commands: All Views, on page 331 and View Menu: Zoom
Commands, on page 332.

© 2021 Synopsys, Inc.
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Command Description
Push/Pop Traverses design hierarchy using the push/pop mode - see
Hierarchy Exploring Design Hierarchy (Standard) , on page 308 of the

Previous Sheet
Next Sheet

View Sheets

Visual Properties

Back
Forward

Filter

User Guide.
Displays the previous sheet of a multiple-sheet schematic.
Displays the next sheet of a multiple-sheet schematic.

Displays the Goto Sheet dialog box where you can select a
sheet to display from a list of all sheets. See View Sheets
Command , on page 335.

Toggles the display of information for nets, instances, pins,
and ports in the HDL Analyst view.

To customize the information that displays, set the values
with Options->HDL Analyst Options->Visual Properties. See Visual
Properties Panel , on page 459.

Goes backward in the history of displayed sheets for the
current HDL Analyst view.

Goes forward in the history of displayed sheets for the current
HDL Analyst view.

Filters the RTL/Technology view to display only the selected
objects.

View Menu: FSM Viewer Commands

The following commands are available when the FSM viewer is active. These
commands are in addition to the common commands described in View Menu
Commands: All Views, on page 331 and View Menu: Zoom Commands, on

page 332.

Command
? Filter->Selected
Filter->By output
“2?] transitions

Filter->By input

Description

Hides all but the selected state(s).

Hides all but the selected state(s), their output transitions,
and the destination states of those transitions.

Hides all but the selected state(s), their input transitions,

transitions and the origin states of those transitions.
Synplify Pro for Microchip Edition Command Reference © 2021 Synopsys, Inc.
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Command Description

Filter->By any Hides all but the selected state(s), their input and output

transition transitions, and their predecessor and successor states.

Unfilter Restores a filtered FSM diagram so that all the states and
transitions are showing.

Cross Probing Enables cross probing between FSM nodes and RTL view
schematic.

Select All States Selects all the states.

FSM Table Toggles display of the transition table.

FSM Graph Toggles FSM state diagram on or off.

Annotate Transitions Toggles display of state transitions on or off on FSM state
diagram.

Selection Transcription

Tool Tips Toggles state diagram tool tips on or off.

FSM Properties Displays FSM Properties dialog box.

Unselect All Unselects all states and transitions.

Toolbar Command
Select View->Toolbars to display the Toolbars dialog box, where you can:
* Choose the toolbars to display

¢ Customize their appearance

© 2021 Synopsys, Inc. Synplify Pro for Microchip Edition Command Reference
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5 Customize Toolbars Ié
Toolbars
Project Show Tooltips
Analyst
Tools [ ] Large Buttons

Physical Analyst

Feature Description
Toolbars Lists the available toolbars. Select the toolbars that you want to
display.

Show Tooltips When selected, a descriptive tooltip appears whenever you position
the pointer over an icon.

Large Buttons When selected, large icons are used.

View Sheets Command

Select View->View Sheets to display the Goto Sheet dialog box and select a sheet
to display. The Goto Sheet dialog box is only available in an RTL or Technology
view, and only when a multiple-sheet design is present.
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P Goto Sheet 2] x|

| Sheet 1 |

Sheet 3

| QK ” Cancel |

To see if your design has multiple sheets, check the sheet count display at
the top of the schematic window.

View Log File Command

View->View Log File displays the log file report for your project. The log file is
available in either text (project_name.srr) or HTML (project_name_str.htm)
format. To enable or disable the HTML file format for the log file, select the
View log file in HTML option in the Options->Project View Options dialog box.

When opening the log file, a table of contents appears. Selecting an item from
the table of contents takes you to the corresponding HTML page. To go back,
right-click the HTML page and select Back from the menu.
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Report: example {rev_1} —
= Symthesis
Compiler Report
E- Pre-rapping Repart
- Mapper Report
Backannotation Report . |[fImplamencaticon: rev_1
Place and Route e giece o ..
Session Log (0839 28-Mov) (.., 5 mriizicE zoia

iler, wversion compdevb, Build 2820R; I
O in 94-bic mode
Copyright |[C} 1984-2012 Synopsya, Inc. This software &l

Synopays VHDL Compller, VerSlon oompdevi, Bulld 2E2Z0QR,
EH: @ | Bunning in &4-bit mode
Copyright [C} 1994-2012 Synopays, Inc. This softwWare ci

| Find |@K:t|:ﬁjc s mtd.whd (129 |

Setting time resclution to ::E
fF: = dma rogp . yhdil3) | Tep enticy ia ger co INS RCM. |7
Befrest | oD

You can use the search field to find an item in the table of contents. Enter all
or part of the header name in the search field, then click Find. The log file
displays the resulting section.

-

Report: example (rev_1)

El- Synthesis
Compiler Report
Pre-mapping Report
El-Mapper Report
Clock Conversion
Timing Report
Detailed Report for Clock: clock
Resource Utilization
Backannotation Report (08:48 28-...
Place and Route @

[Clock conversion ]

Find searches within collapsed tables. It expands the tables to show your
results.
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Report: physical_synthsys t|
Synthesis
Place and Rou
Place and Rou L
" Session Log (0| & Synthesis
- Compiler Report
Pre-mapping Re...
: " Clock Summ...
B Mapper Report ...
~Clock Conver.. ||
Timing Report
Detailed Rep...

- E-Detailed Rep...
D - Resource Util... E

clock | Find I
Refresh

‘ Report: physical_synthsy =

If the file changes while the search window is open, click the Refresh button to
update the table of contents.

S Synihesis
Compiler Report
< Pre-mapping Report
Clack Summary
2 Mapper Report
Clock Conversion
= Timing Report
Perfarmance Summary
Clock Relationships
Interface Information
2 Detailed Report for Clock: clock
Starting Points with Wiarst Slack
Ending Points with Warst Slack
‘Wiarst Path Infarmation
Resource Utilization -
Rarkannntatinn Renart MN7-48 30-Ort)

o

clock
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Project Menu

You use the Project menu to set implementation options, add or remove files
from a project, change project filenames, create new implementations, and
archive or copy the project. The Project menu commands change, depending
on the view you are in. For example, the HDL Analyst RTL and Technology
views only include a subset of the Project menu commands.

The following table describes the Project menu commands.

Command Description

Implementation Options Displays the Implementation Options dialog box, where you
set options for implementing your design. See
Implementation Options Command , on page 352.

Add Source File Displays the Select Files to Add to Project dialog box. See
Add Source File Command , on page 340.

Tcl equivalent: add_file -fileType filename

Remove Implementation Displays the Remove Implementation dialog box that allows
you to remove the selected implementation. See Remove
Implementation , on page 342.

Tcl equivalent: impl -remove implementationName

Remove File From Project Removes selected files from your project.
Tcl equivalent: project_file -remove filename

Change File Replaces the selected file in your project with another
that you choose. See Change File Command , on
page 343.

Tcl equivalent: project_file -name "originalFile" "newFile"

Set VHDL Library Displays the File Options dialog box, where you choose
the library (Library Name) for synthesizing VHDL files. The
default library is called work. See Set VHDL Library
Command , on page 343.

Add Implementation Creates a new implementation for a current design.
Each implementation pertains to the same design, but it
can have different options settings and/or constraints
for synthesis runs. See Add Implementation Command ,
on page 344).

Tcl equivalent: impl -add implementation_1 implementation
-type implementationType
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Project Menu

Command

New Ildentify
Implementation

Archive Project

Un-Archive Project

Copy Project

Description

Creates a new ldentify implementation for a current
design. To launch the Identify toolset, see the Identify
Instrumentor Command , on page 394 and Launch
Identify Debugger Command , on page 396.

Tcl equivalent: impl -add implementation_1 implementation

Archives a design project. Use this command to archive
a full or partial project, or to add files to or remove files
from an archived project. See Archive Project Command ,
on page 345 for a description of the utility wizard
options.

Loads an archived project file to the specified directory.
See Un-Archive Project Command , on page 346 for a
description of the utility wizard options.

Creates a copy of a full or partial design project. See
Copy Project Command , on page 349 for a description of
the utility wizard options.

Add Source File Command

Select Project->Add Source File to add files, such as HDL source files, to your
project. This selection displays the Select Files to Add to Project dialog box.

© 2021 Synopsys, Inc.
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Choose directol
o ry

21z
Lock ing Cycls W_pramieri|vatilog - 0 £ 0 o E @
§ My Conpueer| 2] dux
“| daba_wwoew
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i Select files to add
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| reg_file.w
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| state e
Specify file type
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oLl |
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il ki

Spmribogldata_mus o
i Add file |:= s
Files to be E'Em buttons [Rormerm 2]
Added | |t _ e
kgl Remove file
- buttons [ o
| cence

Feature Description

Look in The directory of the file to add. You can use the pull-down
directory list or the Up One Level button to choose the
directory.

File name The name of a file to add to the project. If you enter a name
using the keyboard, then you must include the file-type
extension.

Files of type The type (extension) of files to be added to the project.

Synplify Pro for Microchip Edition Command Reference
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Only files in the active directory that match the file type
selected from the drop-down menu are displayed in the list
of files. Use All Files to list all files in the directory.
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Feature Description

Files To Add To Project The files to add to the project. You add files to this list with
the <-Add and <-Add All buttons. You remove files from this
list with the Remove -> and Remove All -> buttons.

For information about adding files to custom folders, see
Creating Custom Folders , on page 70.

Tcl equivalent: add_file -type filename

Use relative paths When you add files to the project, you can specify either to
use the relative path or full path names for the files.

Add files to Folders When you add files to the project, you can specify whether
or not to automatically add the files to folders. See the
Folder Options described below.

Folder Options When you add files to folders, you can specify the folder
name as either the:

e Operating System (OS) folder name
e Parent path name from a list provided in the display

Remove Implementation

Displays the Remove Implementation dialog box that allows you to remove the
selected implementation. You can select any of the following:

* Remove implementation only - Removes the implementation from the project
only.

* Remove impl. and delete directory - Removes the implementation from the
project and deletes the directory on the disk.

* No - Do not remove the implementation.

Choose the appropriate option shown in the dialog box below.

> Remove Implementation x}

|0| Do you wish to remove the selected implementations?

|Rem0ve implementation onlyl |Rem0ve impl. and delete directory| | No
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Change File Command

Select Project->Change File to replace a file in the project files list with another
of the same type. This displays the Source File dialog box, where you specify
the replacement file. You must first select the file to replace, in the Project

view, before you can use this command.

— J T TS i R By e g

D:\Drezignz_Atuborialseight_bk_uc'sewv_1

=¥ eight_bit_uc [projec)
& ] constrant
=44 wenlog

g aluv WERILOG)

g clk_div.v VERILOG]
g data_muxv [VERILOG]
eg in v W 0
- & ms_rom v WVERILOG]

[T T T 11

Select a File in the Project View

Source File

Select Project->Change File and Choose a Replacement File

Lack jn: | ‘2 prep

= « @k B

=] prept.v &) peepT.v
EI prepd. s 1‘] prepdy
] prepl ] prepdv
=] prepd.v
e tprepS.v

] prep.v

Fie name: IuepE.\.'

Fies of wpe:  [\eriiog Files [* v vmal

Set VHDL Library Command

Select Project->Set VHDL Library to display the File Options dialog box, where you
view VHDL file properties and specify the VHDL library name. See File
Options Popup Menu Command, on page 479. This is the same dialog box as
that displayed by right-clicking a VHDL filename in the Project view and

choosing File Options.

Synplify Pro for Microchip Edition Command Reference
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Add Implementation Command

Select Project->Add Implementation to create a new implementation for the
selected project. This selection displays the Implementation Options dialog box,
where you define the implementation options for the project - see Implementa-
tion Options Command, on page 352. This is the same dialog box as that
displayed by Project->Implementation Options, except that there is no list of Imple-
mentations to the right of the tabbed panels.

© 2021 Synopsys, Inc. Synplify Pro for Microchip Edition Command Reference
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Archive Project Command

Use the Project->Archive Project command to store files for a design project into

a single archive file in Synopsys Proprietary Format (.sar). You can archive an
entire project or selected files from the project.

The Archive Project command displays the Synopsys Archive Utility wizard
consisting of either two (all files archived) or three (custom file selection) tabs.

T GympkbyPro Andns Uty - |Conshctnnial usarm pg

— r X
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Prejact Path and Fllerare  Co'owstiinanlfutesal pry
R Dirmelory il ulrial [ Ghanga..
DS Inanon Fie oW AVILL ) o |
ATE Se

® Create s Nully seli-~contsired copy [Flie 140 Slze: 107 M)
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e ahive e wiin 3 special Tocal Dipe fercme”
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Thie purpoes of bhis bype of archive i@ for s i dffeent nebwok swircrmenl. ELy., caslomens can archive deir prosect in Lhis mode and serd it 1o
Syropay for debugoing

st = I )

Option Description
Project Path and Filename Path and filename of the .prj file.
Root Directory Top-level directory that contains the project files.

Destination Directory Pathname of the directory to store the archive .sar file.
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Option Description

Archive Style The type of archive:

« Create a fully self-contained copy - all project files are
archived; includes project input files and result files.
< If the project contains more than one implementation:
- All Implementation includes all implementations in the

project.
- Active Implementation includes only the active
implementation.
* Customized file list - only project files that you select are
included in the archive.

« Local copy for internal network - only project input files are
archived, no result files will be included.

Create Project using If you select the Customized file list option in the wizard,
you can choose one the following options on the second
tab:

* Source Files - Includes all design files in the archive.
You cannot enable the SRS option if this option is
enabled.

* SRS - Includes all .srs files (RTL schematics) in the
archive. You cannot enable the Source Files option
when this option is enabled.

Add Extra Files If you select the Customized file list option in the wizard,

you can use this button on the second tab to add
additional files to the archive.

For step-by-step details on how to use the archive utility, see Archive Project
Command, on page 345.

Un-Archive Project Command

Use the Project->Un-Archive Project command to extract the files from an
archived design project.

This command displays a Synplify Un-Archive Utility wizard.
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Option Description
Archive Filename Path and filename of the .prj file.
Project Name Top-level directory that contains the project files.
Destination Directory Pathname of the directory to store the archive .sar file.
Original File Reference/ Displays the files in the archive that will be extracted.

Resolved File Reference  you can exclude files from the .sar by unchecking the file
in the Original File Reference list. Any unchecked files are
commented out in the .prj file.

If there are unresolved reference files in the .sar file, you
must fix (Resolve button) or uncheck them. Or, if there
are files that you want to change when project files are
extracted, use the Change button and select files, as
appropriate. See Resolve File Reference, next for more
details.
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For step-by-step details on how to use the un-archive utility, see Un-Archive
Project Command, on page 346.

Resolve File Reference

When you use the Un-Archive Utility wizard to extract a project, if there are
unresolved file references, use the Resolve button next to the file to point to a
new file location. You can also optionally replace project files in the destina-
tion directory by clicking the Change button next to the file you want to
replace. The Change and Resolve buttons bring up the following dialog box:

< Synplify Pro Un-Archive Utili

File Reference
Filename [prepz_z.vhd

Original Directory [_cummon_r‘tl_prep

l
l
Replace directory with | EI

Final Filename [ l

Replace | |Rep|ace gnresolved” Replace All

Option Description
Filename Specifies the path and name of the file you want to
change or resolve.
Original Directory Specifies the location of the project at the time it was
archived.
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Option

Replace directory with
Final Filename

Replace buttons

Description

Specifies the new location of the project files you want to
use to replace files.

Specifies the path name of the directory and the file
name of the replace file.

* Replace - replaces only the file specified in the Filename
field when the project is extracted.

* Replace Unresolved - replaces any unresolved files in the
project, with files of the same name from the Replace
directory.

« Replace All - replaces all files in the archived project
with files of the same name from the Replace directory.

« To undo any replace-file references, clear the Replace
directory with field, then click Replace. This causes the
utility to point back to the Original Directory and
filenames.

Copy Project Command

Use the Project->Copy Project command to create a copy of a design project. You
can copy an entire project or selected files from the project.

The Copy Project command displays the Synopsys Copy Utility wizard consisting of
either two (all files copied) or three (custom file selection) tabs.

Synplify Pro for Microchip Edition Command Reference
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Option

Description

Project Path and Filename Path and filename of the .prj file.

Root Directory

Top-level directory that contains the project files.

Destination Directory

Pathname of the directory to store the archive .sar file.
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Option Description

Copy Style The type of archive:

» Create a fully self-contained copy - all project files are
archived; includes project input files and result files.

 If the project contains more than one implementation:
- All Implementation includes all implementations in the
project.
- Active Implementation includes only the active
implementation.

< Customized file list - only project files that you select are
included in the archive.

< Local copy for internal network - only project input files are
archived, no result files will be included.

Create Project using If you select the Customized file list option in the wizard,
you can choose one the following options on the second
tab:

» Source Files - Includes all design files in the archive.
You cannot enable the SRS option if this option is
enabled.

e SRS - Includes all .srs files (RTL schematics) in the
archive. You cannot enable the Source Files option if
this option is enabled.

Add Extra Files If you select the Customized file list option in the wizard,
you can use this button on the second tab to add
additional files to the archive.

For step-by-step details on how to use the copy utility, see Copy Project
Command, on page 349.
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Implementation Options Command

Implementation Options Command

You use the Implementation Options dialog box to define the implementation
options for the current project. You can access this dialog box from
Project->Implementation Options, by clicking the button in the Project view, or by
clicking the text in the Project view that lists the current technology options.

Technology: Part: Package: Speel
\Micrachip ~ PolarFire ~| | PASM300 ~| | FBGAB96 ~| |sTD
Device Mapping Options
|Dpti0n |Val|.|e
Fanout Guide 10000
Disable /O Insertion [
Update Compile Point Timing Data |
Annctated Properties for Analyst
Operating Conditions COMTC
Max Mumber of Critical Paths in SDF 4000
Conservative Register Optimization |
Automatic Read/Write Check Insertion for RAM [
Resolve Mixed Drivers [

Click on an option for description

This section describes the following:

* Device Panel, on page 353. For device-specific details of the options,
refer to the appropriate vendor chapter.

¢ Options Panel, on page 355

¢ Constraints Panel, on page 357

* Implementation Results Panel, on page 359

* Timing Report Panel, on page 361

¢ High Reliability Panel, on page 363

© 2021 Synopsys, Inc.
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¢ VHDL Panel, on page 364
* Verilog Panel, on page 369
* Place and Route Panel, on page 386

* Place and Route Panel, on page 386

Device Panel

You use the Device panel to set mapping options for the selected technology.

Technology “endor

Device
Technology: / Part Package: Speed:

\Micriochip ~ SmartFusion  ~| |A2F200M3F ~| |PQFP20i ~| |STD -

Device Mapping Options

—— Option | value |

Fanout Guide 24
Disable /O Insertion [
Update Compile Point Timing Data |
FPromote Global Buffer Threshold 50

Device Operating Conditions COMWC

hg‘;'t::grf Annotated Properties for Analyst
Max Number of Critical Paths in SDF 4000
Conservative Register Optimization |

Automatic Read/Write Check Insertion for RaM  |[_]

Resolve Mixed Drivers [

Click on an option for description ad— _ Option
Dezcription
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The mapping options vary, depending on the technology. See Setting Device
Options, on page 78 in the User Guide for a procedure, and the relevant
vendor sections in this reference manual for technology-specific descriptions
of the options.

The table below lists the following category of options. Not all options are
available for all tools and technologies.

Option Description
Technology Specify the device technology you want to synthesize. You can also
Vendor select the part, package, and speed grade to use.

For more information, see the appropriate vendor appendix in the
Reference manual.

Device The device mapping options vary depending on the device

Mapping technology you select.

Options For more information, see the appropriate vendor appendix in the
Reference manual.

Option Click on a device mapping option to display its description in this

Description field. Refer to the relevant vendor sections for technology-specific

descriptions of the options.
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Options Panel

You use the Options panel of the Implementation Options dialog box to define
general options for synthesis optimization. See Setting Optimization Options,
on page 81 of the User Guide for details.

Options Options

Optimization Switches Optimization Switches

[| Automatic Compile Point o N

Continue on Ermor [ Automatic Compile Point

FSM Compiler Continue on Error

["] FSM Explorer Validate MIF Files

Resource Sharing FSM Compiler

Pipelining [ ] FSM Explorer

[ | Retiming Resource Sharing

Distributed Compilation Pipelining

[] Distributed Synthesis [] Retiming

(O Incremental Distributed Synthesis Distributed Compilation

Option Description Option Description

Click on an option for a description. Click on an option for a description.
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The following table lists the options alphabetically. Not all options are avail-
able for all technologies.

Option

Auto Compile
Point

Continue on
Error

Enable 64-bit
Synthesis

FSM Compiler

© 2021 Synopsys, Inc.
356

Description

Enables the automatic compile point flow, which can analyze a
design and identify modules that can automatically be defined as
compile points and mapped in parallel using multiprocessing.

See The Automatic Compile Point Flow , on page 456 in the User
Guide.

Tcl equivalent: set_option -automatic_compile_point 0|1
When enabled for Synplify Pro synthesis, it only affects

compile-point synthesis, allowing the operation to continue and
synthesize other compile points.

See Using Continue on Error , on page 219 in the User Guide.
Tcl equivalent: set_option -continue_on_error 0|1

Enables/disables the 64-bit mapping switch. When enabled, this
switch allows you to run client programs in 64-bit mode, if available
on your system.

This option is supported on the Windows and Linux platforms.
Tcl equivalent: set_option -enable64bit 0|1

Determines whether the FSM Compiler is run. See Running the
FSM Compiler , on page 425 in the User Guide.

Tcl equivalent: set_option -symbolic_fsm_compiler 0|1

Synplify Pro for Microchip Edition Command Reference
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Option
FSM Explorer

Resource
Sharing

Retiming

Description

Determines whether the FSM Explorer is run. See Running the FSM
Explorer , on page 429 in the User Guide.

Tcl equivalent: set_option -use_fsm_explorer 0|1

Determines whether you optimize area by sharing resources. When
enabled, this optimization technique runs during the compilation
stage of synthesis.

Even if it is disabled, the mapper can still flatten the netlist and
re-optimize adders, multipliers as needed to improve timing,
because this setting does not affect the mapper. See Sharing
Resources , on page 422 for information for how to use this option
in the User Guide.

Enabling this option generates the resource sharing report in the
log file (see Resource Usage Report , on page 160).

Tcl equivalent: set_option -resource_sharing 0|1

Determines whether the tool moves storage devices across
computational elements to improve timing performance in
sequential circuits. Note that the tool might retime registers
associated with RAMs, DSPs, and generated clocks, regardless of
the Retiming setting.

See Retiming, on page 406 in the User Guide.
Tcl equivalent: set_option -retiming 0|1

Constraints Panel

You use the Constraints panel of the Implementation Options dialog box to specify
target frequency and timing constraint files for design synthesis. Depending
on the synthesis tool you are using and the device you specify, the types of
constraint files you can apply for the implementation may vary. See the table
below for a complete list of option types you can apply.

See Specifying Global Frequency and Constraint Files, on page 83, in the User
Guide for details.
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Constraints [:E

Frequency (MHz)

e |200.0000 = Auto Constrain (Optimize to obtain maximum frequency)

[ ] Use Clock Period for Unconstrained 10

Constraint Files

Check files to apply to this implementation.

FPGA Constraints (FOC) = SDC | Identify (IDC)

C:iswitutorialhtutorial _3.fdc
zclick to add file ..

Option Description

Frequency Sets the default global frequency. You can either set the
global frequency here or in the Project view. To override the
default you set here, set individual clock constraints from the
SCOPE interface.

Tcl equivalent: set_option -frequency frequency

Auto Constrain When enabled and no clocks are defined, the software
automatically constrains the design to achieve the best
possible timing. It does this by reducing periods of each
individual clock and the timing of any timed 1/0 paths in
successive steps. See Using Auto Constraints , on page 376 in
the User Guide for information about using this option.

You can also set this option in the Project view.
Tcl equivalent: set_option -frequency auto
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Option

Use clock period for
unconstrained 10

Constraint Files
FDC

Constraint Files
SDC

Identify (IDC)

Description

Determines whether default constraints are used for 1/0
ports that do not have user-defined constraints.

When disabled, only set_input_delay or set_output_delay
constraints are considered during synthesis or
forward-annotated after synthesis.

When enabled, the software considers any explicit
set_input_delay or set_output_delay constraints. In addition, for
all ports without explicit constraints, it uses constraints
based on the clock period of the attached registers. Both the
explicit and implicit constraints are used for synthesis and
forward-annotation. The default is off (disabled) for new
designs.

Tcl equivalent: set_option -auto_constrain_io 0|1

Specifies which timing constraints (FDC) files to use for the
implementation. Select the check box to choose a file.

For block-level files in the compile-point flows, the Module
column shows the name of the module or compile point.

Specifies which timing constraints (SDC) files to use for the
implementation. Select the check box to choose a file.

For block-level files in the compile-point flows, the Module
column shows the name of the module or compile point.

Specifies the instrumentation design constraints (IDC) files
that add compiler pragmas in these files to the design RTL for
the instrumented signals and break points. Enable the check
box to select a file.

Implementation Results Panel

You use the Implementation Results panel to specify the implementation name
(default: rev_1), the results directory, and the name and format of the top-level
output netlist file (Result File). You can also specify output constraint and
netlist files. See Specifying Result Options, on page 85 of the User Guide for

details.

The results directory is a subdirectory of the project file directory. Clicking
the Browse button brings up the Select Run Directory dialog box to allow you to
browse for the results directory. You can change the location of the results
directory, but its name must be identical to the implementation name.
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Select optional output file check boxes to generate the corresponding Verilog
netlist, VHDL netlist, or vendor constraint files.

Tinplementadon Pecults
Implementation | i iome

name .

Results Reeuke Diecloy:
directory — (el oo soeie 1

Result Fiesiks File Name
. - & .
filename gttt e, edf

Result ,,r

format
.- i -\\\
Optional [ Opdonal Cutput Fles

output files™ | L vii= Mapoed verikg hetis:
1 Witz Mapoed WHOL Metlst

\
o | wurice Wendor Constraink Fie o
— 5
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Option
Implementation
Name

Results Directory
Result Base Name

Result Format

Write Mapped Verilog
Netlist

Write Mapped VHDL
Netlist

Write Vendor
Constraint File

Description

Displays implementation name, directory path for results,
and the base name for the result files.

Tcl equivalent: set_option -result_file pathtoResultFile

Select the output that corresponds to the technology you are
using. See the Appendices of the Reference manual for a
vendor-specific in the User Guidelist of netlist formats.

Tcl equivalent: set_option -result_format format

Generates mapped Verilog or VHDL netlist files.
Tcl equivalent: set_option -write_verilog 0|1
Tcl equivalent: set_option -write_vhdl 0|1

Generates a vendor-specific constraint file for forward
annotation.

Tcl equivalent: set_option -write_apr_constrain 0|1

Timing Report Panel

Use the Timing Report panel (Implementation Options dialog box) to set criteria for
the (default) output timing report. Specify the number of critical paths and
the number of start and end points to appear in the timing report. See Speci-
fying Timing Report Output, on page 87 in the User Guide for details. For a

description of the report, see Timing Reports, on page 162.
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Timing Report

Mumber of Critical Paths: [ ]

Mumber of Start/End Points: [ l

Description

Configure the timing report by specifying the number of paths to indude in the "Starting/Ending Points
with worst slack™ and "Worst Paths”™ report sections.

Option Description
Number of Critical Set the number of critical paths for the software to report.
Paths Tcl equivalent: set_option -num_critical_paths numberOfPaths

Number of Start/End  Specify the number of start and end points to see reported in
Points the critical path sections.

Tcl equivalent: set_option -num_startend_points numberOfPoints

See also:

* Timing Reports, on page 162, for more information on the default timing
report, which is affected by the Timing Report panel settings.

* Analysis Menu, on page 407, information on creating additional custom
timing reports for certain device technologies.
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High Reliability Panel

Use the High Reliability panel (Implementation Options dialog box) to implement safe
logic for the design. For more information about high reliability support, see
Chapter 15, Handling High-Reliability Designs.

High Reliability
High Reliability
Disable Verification Mode to set High Reliability options
[7] Preserve and Decode Unreachable States - (FSM, Counters, Sequential Logic)
[] FSM Error Comection Using Hamming Distance 3
[] FSM SEC-DED Using Hamming Distance 3
[] FSM SEC-DED and Recovery Using Hamming Distance 3
[] Gate Level Netlist TMR
[ FsM High Effort (may improve FSM extraction, but increase runtime)
["] Report and Preserve CDC paths
Option Description
Preserve and Decode When enabled, this option turns off sequential
Unreachable States (FSM, optimizations on all counters, FSMs, and sequential

Counters, Sequential Logic) logic, to increase the reliability of the circuit.

If you do not want to implement this globally, use the
syn_safe_case directive (syn_safe_case , on page 227)
on individual FSMs.

Tcl equivalent: set_option -safe_case 0|1

Report and Preserve CDC Enables or disables CDC reporting. The option is ON,
paths by default.

Tcl equivalent: set_option -report_preserve_cdc 1/0
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VHDL Panel

You use the VHDL panel in the Implementation Options dialog box to specify
var